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Chapter

Introduction to Python Scripts

The Scripting Facility for IBM® SPSS® Statistics provides the ability to create Python® scripts
that operate on the SPSS Statistics user interface, manipulate output objects, and run command
syntax. This feature requires the IBM® SPSS® Statistics - Integration Plug-in for Python,
installed with IBM® SPSS® Statistics - Essentials for Python.

A companion interface is available for creating Python programs that enable you to control the
flow of command syntax jobs, read and write data, and create custom procedures. For information,
see the topic for the Python Integration Package for IBM SPSS Statistics, under Integration
Plug-in for Python in the Help system.

Scope

You can run Python scripts directly from within SPSS Statistics, from within Python programs, or
from an external Python process, such as a Python IDE or the Python interpreter.

Python Script Run from SPSS Statistics. You can run a Python script from Utilities>Run Script
or from the Python script editor which is launched when opening a Python file (.py) from
File>Open>Script. Scripts run from the Python editor that is launched from SPSS Statistics
operate on the SPSS Statistics client that launched the editor. This allows you to debug your
Python code from a Python editor.

Python Script Run from an External Python Process. You can run a Python script from any external
Python process, such as a Python IDE that is not launched from SPSS Statistics, or the Python
interpreter. The script will attempt to connect to an existing SPSS Statistics client. If more than
one client is found, a connection is made to the most recently launched one. If an existing client is
not found, the Python script starts up a new instance of the SPSS Statistics client. By default, the
Data Editor and Viewer are invisible for the new client. You can choose to make them visible or
work in invisible mode with datasets and output documents.

B Mac. To run a Python script from an external Python process on Mac, launch the
Programmability External Python Process application, installed with Essentials for Python
and located in the directory where SPSS Statistics is installed. The application launches
IDLE (the default IDE provided with Python) and sets environment variables necessary
for driving SPSS Statistics.

Python Script Run from Python Program. You can run a Python script from a Python program by
importing the Python module containing the script and calling the function in the module that
implements the script. You can also call Python script methods directly from within a Python
program. For more information, see the topic Running Python Scripts from Python Programs on

p. 6.

m  This feature is not available when running a Python program from an external Python process
or when running a Python program from the SPSS Statistics Batch Facility (available with
SPSS Statistics Server).

© Copyright IBM Corporation 1989, 2012. 1
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B When running Python scripting code from a Python program in distributed mode, you may
need to configure your firewall to allow access from the remote server to which you are
connected.

Limitations

m  The interfaces exposed by the spss module (the module used for Python programs) cannot
be used in a Python script.

m Calling methods in the SpssClient module with keyword arguments—in other words,
keyword = value—is not supported.

Help

General information on the Scripting Facility for SPSS Statistics and additional information on
Python scripts is available from Core System>Scripting Facility in the Help system.

Working with Multiple Versions of IBM SPSS Statistics

Multiple versions of the IBM® SPSS® Statistics - Integration Plug-in for Python can be used
on the same machine, each associated with a major version of IBM® SPSS® Statistics, such as
20 or 21.

Running Python Scripts from Within IBM SPSS Statistics

By default, Python scripts run from within the last installed version of SPSS Statistics will
automatically use the appropriate version of the plug-in. To run Python scripts from within a
different version of SPSS Statistics, use the SpssClient.SetDefault]JCVersion method to set the
default to a different version (the setting persists across sessions). You can then run Python scripts
from within the other version. If you are attempting to change the default version from 16.0 to
17.0, additional configuration is required; please see the Notes below.

Running Python Scripts from an External Python Process

When running Python scripts from a separate Python process, such as the Python interpreter or a
Python IDE, the plug-in will drive the version of SPSS Statistics that matches the default plug-in
version specified for that version of Python. Unless you change it, the default plug-in version

for a given version of Python (such as Python 2.7) is the last one installed. You can view the
default version using the SpssClient.GetDefaultJCVersion method and you can change the default
version using the SpssClient.SetDefaultJCVersion method. The setting persists across sessions. If
you are attempting to change the default version from 16.0 to 17.0, additional configuration is
required; please see the Notes below.
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Notes

To change the default version from 16.0 to 17.0, you will need to manually modify the file
SpssClient.pth located in the Python 2.5 site-packages directory. Change the order of entries in the
file so that the first line is SpssClient170. You should also ensure that the first line in spss.pth
(also located in site-packages) is spss170.

®  Windows. The site-packages directory is located in the Lib directory under the Python 2.5
installation directory—for example, C:\Python25\Lib\site-packages.

® Mac 0S X 10.4 (Tiger). The site-packages directory is located at
/Library/Frameworks/Python.framework/Versions/2.5/lib/python2.5/site-packages.

m  Mac 0S X 105 (Leopard). The site-packages directory is located at
/Library/Python/2.5/site-packages.

®  Linux and UNIX Server. The site-packages directory is located in the
/lib/python2.5/ directory under the Python 2.5 installation directory—for
example, /usr/local/python25/lib/python2.5/site-packages.

Class Hierarchy for Scripting Facility

The following diagram shows the hierarchy of classes available to Python scripts.
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SpssClient
DataDocsList SpssD|ala Doc SpssDataul
SyntaxDocsList SpssSyntaxDoc SpssSyntaxUl MenuTableList
l |
OutputDocsList SpssOutputDoc SpssMenultem
OutputltemList SpssOutputltern
SpssOutputUl — SpssPivotTable SpssDataCells
—SpssHeaderltem — SpssFootnotes
— SpssChartltem — SpsslLabels
—— SpssServerConfList SpssServerConf
— SpssTextltem —{SpssLayerLabels
— SpssTitleltem L SpssPivotMgr
SpssScriptContext

Getting Started with Python Scripts

The basic structure of a Python script is:

import SpssClient
SpssClient.StartClient ()
<Python language statements>
SpssClient.StopClient ()

SpssLogltem

SpssModellitem

B The import SpssClient statement imports the Python module containing the IBM®
SPSS® Statistics classes and methods available in the Python scripting interface.

SpssDimension
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B SpssClient.StartClient () provides a connection to the associated SPSS Statistics
client, enabling the script to retrieve information from the client and to perform operations on
objects managed by the client, such as pivot tables. Whether the script connects to an existing
client or starts up a new client depends on how the script was invoked. For more information,
see the topic Introduction to Python Scripts on p. 1.

B SpssClient.StopClient () terminates the connection to the SPSS Statistics client and
should be called at the completion of each Python script.

Note: If you’re running a Python script from an external Python process that starts up a new
client, call SpssClient.Exit () before SpssClient.StopClient ().

Example

This script accesses the designated output document and sets each of the pivot tables as selected.

import SpssClient
SpssClient.StartClient ()

OutputDoc = SpssClient.GetDesignatedOutputDoc ()
OutputItems = OutputDoc.GetOutputItems ()

for index in range (OutputItems.Size()):
OutputItem = OutputlItems.GetItemAt (index)
if OutputItem.GetType() == SpssClient.OutputItemType.PIVOT:
OutputItem.SetSelected (True)
SpssClient.StopClient ()

Target for Standard output

The Python print statement writes output to Python’s standard output. When you run a Python
script from Utilities>Run Script, Python’s standard output is directed to a log item in the SPSS
Statistics Viewer.

Getting Started with Autoscripts in Python

Autoscripts are scripts that run automatically when triggered by the creation of specific pieces
of output from selected procedures and typically require a reference to the object that triggered
the script. They may also require a reference to the associated output document and possibly
the index of the output item in the output document. These values are obtained from the
SpssScriptContext object, as shown in this example of an autoscript that transposes the
rows and columns of a pivot table.

import SpssClient
SpssClient.StartClient ()

SpssScriptContext = SpssClient.GetScriptContext ()
SpssOutputItem = SpssScriptContext.GetOutputItem()
SpssPivotTable = SpssOutputItem.GetSpecificType ()
SpssPivotMgr = SpssPivotTable.PivotManager ()
SpssPivotMgr.TransposeRowsWithColumns ()

SpssClient.StopClient ()
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B SpssClient.GetScriptContext returns an SpssScriptContext object that provides
values for use by the autoscript.

B The GetOutputItem method of the SpssScriptContext object returns the output item
that triggered the current autoscript—in this example, the pivot table whose rows and columns
are to be transposed.

Although not used in this example, the GetOutputDoc method of the SpssScriptContext
object returns the associated output document, and the GetOutput ItemIndex method returns
the index (in the associated output document) of the output item that triggered the autoscript.

General information on autoscripts is available from Core System>Scripting Facility in the Help
system.

Detecting When a Script is Run as an Autoscript

Using the GetScriptContext method, you can detect when a script is being run as an
autoscript. This allows you to code a script so that it functions in either context (autoscript or
not). This trivial script illustrates the approach.

import SpssClient
SpssClient.StartClient ()

SpssScriptContext = SpssClient.GetScriptContext ()

if SpssScriptContext == None:
print "I'm not an autoscript"
else:

print "I'm an autoscript"

SpssClient.StopClient ()

®  When a script is not run as an autoscript, the GetScriptContext method will return a
value of None.

B Given the 1f-else logic in this example, you would include your autoscript-specific code
in the else clause. Any code that is not to be run in the context of an autoscript would be
included in the if clause. Of course you can also include code that is to be run in either
context.

Running Python Scripts from Python Programs

You can run Python scripts from Python programs and you can call Python script methods
from within a Python program. This allows you to write Python programs that operate on user
interface and output objects.

m  This feature is only available when running a Python program from the IBM® SPSS®
Statistics client—within a BEGIN PROGRAM-END PROGRAM block in command syntax or
within an extension command. It is not available when running a Python program from an
external Python process.

®  When running Python scripting code from a Python program in distributed mode, you may
need to configure your firewall to allow access from the remote server to which you are
connected.
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Example: Calling a Python Script from a Python Program

This example shows a Python program that creates a custom pivot table and calls a Python script
to make the column labels of the table bold.

BEGIN PROGRAM.

import spss, MakeColsBold

spss.StartProcedure ("Demo")

table = spss.BasePivotTable ("Sample Table", "OMS subtype")

table.SimplePivotTable (rowlabels = ["1","2"],
collabels = ["A","B"],
cells = ["1A","lB","2A","2B"])

spss.EndProcedure ()
MakeColsBold.Run ("Sample Table")
END PROGRAM.

m Python programs use the interface exposed by the Python spss module, so the first line of
the program contains an import statement for that module. The Python script is assumed
to be contained in a Python module named MakeColsBold, so the import statement also
includes that module.

B  The code from spss.StartProcedure to spss.EndProcedure creates a pivot table
titled “Sample Table”.

B MakeColsBold.Run("Sample Table") calls the Run function in the MakeColsBold
module and passes the value “Sample Table” as the argument. The Run function implements
the Python script to make the column labels of the specified table bold.

The content of the MakeColsBold module is as follows:

import SpssClient

def Run(tableName) :
SpssClient.StartClient ()
OutputDoc = SpssClient.GetDesignatedOutputDoc ()
OutputItems = OutputDoc.GetOutputlItems ()
for index in range (OutputItems.Size()) :
OutputItem = OutputItems.GetItemAt (index)
if OutputItem.GetType() == SpssClient.OutputltemType.PIVOT \
and OutputItem.GetDescription() == tableName:
PivotTable = OutputItem.GetSpecificType ()
ColumnLabels = PivotTable.ColumnLabelArray ()
for 1 in range (ColumnLabels.GetNumColumns ()) :
ColumnLabels.SelectLabelAt (1,1)

PivotTable.SetTextStyle (SpssClient.SpssTextStyleTypes.SpssTSBold)
SpssClient.StopClient ()

B The import SpssClient statement is needed to access the classes and methods available
in the Python scripting interface.

®  The module contains a single function named Run, which implements the script. It takes a
single argument that specifies the name of the table to modify. There is nothing special about
the name Run and the module is not limited to a single function. You can create a module that
contains many functions, each of which implements a different script.

B  The Run function calls SpssClient.StartClient () to provide a connection to the
associated SPSS Statistics client and SpssClient.StopClient () to terminate the
connection at the completion of the script.
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Example: Calling Python Scripting Methods Directly from a Python Program

This example shows a Python program that creates a custom pivot table and makes direct calls to
Python scripting methods to make the title of the table italic.

BEGIN PROGRAM.

import spss, SpssClient

spss.StartProcedure ("Demo")

table = spss.BasePivotTable ("Sample Table", "OMS subtype")
table.SimplePivotTable (cells = ["A","B","C","D"])
spss.EndProcedure ()

SpssClient.StartClient ()

OutputDoc = SpssClient.GetDesignatedOutputDoc ()

OutputItems = OutputDoc.GetOutputItems ()

OutputItem = OutputItems.GetItemAt (OutputItems.Size()-1)

PivotTable = OutputItem.GetSpecificType ()

PivotTable.SelectTitle ()

PivotTable.SetTextStyle (SpssClient.SpssTextStyleTypes.SpssTSItalic)
SpssClient.StopClient ()

END PROGRAM.

B The import spss, SpssClient statement provides access to the classes and methods
available for Python programs (spss) as well as those for Python scripts (SpssClient).

B The code from spss.StartProcedure to spss.EndProcedure is the Python program
code that creates the pivot table.

B The code from SpssClient.StartClient () to SpssClient.StopClient () is the
Python script code that makes the title italic.
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The SpssClient class is the top level class for the IBM® SPSS® Statistics Python scripting
interface. From an SpssClient object you can:

B Access the current data, syntax, or output document.

Open and access a saved data, syntax, or output document.

Create and access a new data, syntax, or output document.

Obtain a list of all open data, syntax, or output documents.

Run command syntax.

Get and set options available from Edit>Options in the user interface.
Get and set export options for exporting output.

Get values pertinent to an autoscript, such as the output item that triggered the autoscript.

Obtain information about configured instances of SPSS Statistics Server and configure new
instances.

The spssClient object is always available to a script, but you must call
SpssClient.StartClient to establish a connection to the SPSS Statistics client before you
can use any of the other methods in the class. For more information, see the topic Getting Started
with Python Scripts in Chapter 1 on p. 4.

CreateNewServer Method

Creates a new server configuration and returns an SpssServerConf object. To add this server
to the list of configured servers, use the Add method in the SpssServerConfList class. You
can obtain an instance of SpssServerConfList from the GetConfiguredServers method
in the SpssClient class.

Syntax

SpssServerConf=SpssClient.CreateNewServer (serverName, port,desc)

Parameters

serverName The machine name or IP address of the IBM®
SPSS® Statistics Server machine

port Port number for SPSS Statistics Server

desc Textual description of the server

© Copyright IBM Corporation 1989, 2012. 9
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Exit Method

Terminates the instance of the IBM® SPSS® Statistics client associated with the current script.
This method is intended for use when running a script from an external Python process (such as
a Python IDE or the Python interpreter), and will terminate the instance of the SPSS Statistics
client associated with the script. The method has no effect when called from a script that is run
from within the SPSS Statistics client, either through Utilities>Run Script or from a Python IDE
launched from File>Open>Script or File>New>Script.

Syntax

SpssClient .Exit ()

GetActiveDataDoc Method

Returns the active dataset as an SpssDataDoc object.

Syntax

SpssDataDoc=SpssClient.GetActiveDataDoc ()

GetConfiguredServers Method

Returns the list of configured servers as an SpssServerConfList object. The list consists of
SpssServerConf objects for each of the configured servers, including the local computer.

Syntax

SpssServerConflList=SpssClient.GetConfiguredServers ()

GetCurrentDirectory Method

Returns the current working directory of the IBM® SPSS® Statistics client.

Syntax

SpssClient.GetCurrentDirectory ()

GetCurrentServer Method

Returns an SpssServerConf object representing the current server (may be an instance of
IBM® SPSS® Statistics Server or the local computer).

Syntax

SpssServerConf=SpssClient.GetCurrentServer ()
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GetDataDocuments Method

Returns the list of open datasets as a DataDocsList object. Each item in the list is an
SpssDataDoc object.

Syntax

DataDocsList=SpssClient.GetDataDocuments ()

GetDefaultJCVersion Method

Returns a string specifying the default version of the IBM® SPSS® Statistics - Integration Plug-in
for Python used for Python scripts—for example, "SpssClient170" for version 17.0. This
method is useful when working with multiple versions of the plug-in on a given machine (see
Note below). You can change the default using the SetDefault]JCVersion method.

Syntax

SpssClient.GetDefaultdCVersion ()

Note: The methods for managing multiple versions of the plug-in

(SpssClient .GetDefaultJCVersion, and SpssClient.SetDefaultJCVersion) operate
within a given Python version, not across Python versions. For example, if you are driving IBM®
SPSS® Statistics from a Python IDE installed for Python 2.7 then you can view and control the
versions of the plug-in installed for Python 2.7.

For more information, see the topic Working with Multiple Versions of IBM SPSS Statistics
in Chapter 1 on p. 2.

GetDefaultServer Method

Returns an SpssServerConf object representing the default server (may be an instance of IBM®
SPSS® Statistics Server or the local computer).

Syntax

SpssServerConf=SpssClient.GetDefaultServer ()

GetDesignatedOutputDoc Method

Returns an SpssOutputDoc object representing the designated output document.

m If you have more than one open output document, output is routed to the designated one.

Syntax

SpssOutputDoc=SpssClient.GetDesignatedOutputDoc ()
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GetDesignatedSyntaxDoc Method

Returns an SpssSyntaxDoc object representing the designated syntax document.

m If you have more than one open syntax document, command syntax is pasted into the
designated one.

Syntax

SpssSyntaxDoc=SpssClient.GetDesignatedSyntaxDoc ()

GetExportOption Method

Returns the value of the specified export option, as a string.

Syntax

SpssClient.GetExportOption (option)

Parameters

The value of option is the identifier SpssClient . ExportOptions, followed by a period (.) and

the name of the option—for example, SpssClient . ExportOptions.GraphExportType. See
Export Options for the available list of options.

GetLocale Method

Returns a string specifying the current locale. The locale consists of the language, country and
char set information.

Syntax

SpssClient.GetLocale ()

GetLocalServer Method

Returns an SpssServerConf object representing the local computer.

Syntax

SpssServerConf=SpssClient.GetLocalServer ()

GetOutputDocuments Method

Returns the list of open output documents as an OutputDocsList object. Each item in the list is an
SpssOutputDoc object.
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Syntax

OutputDocsList=SpssClient.GetOutputDocuments ()

GetPreference Method

Returns the value of the specified preference option, as a string.

Syntax
SpssClient.GetPreference (option)

The value of option is the identifier SpssClient.PreferenceOptions,
followed by a period (.) and the name of the option—for example,
SpssClient.PreferenceOptions.VariableListDisplay. See Preference
Options for the available list of options.

GetScriptContext Method

Returns an SpssScriptContext object that allows you to determine the context in which a script is
being run—as an autoscript, or not.

®  When the script is being run as an autoscript, the returned SpssScriptContext object
provides access to the output item that triggered the autoscript as well as the associated
output document.

B When the script is not being run as an autoscript, GetScriptContext returns None.

Syntax

SpssScriptContext=SpssClient.GetScriptContext ()

GetSPSSOptions Method

Returns a string which is a concatenation of three-letter abbreviations for each of the licensed
options. You can determine if a specified option is available from the IsOptionAvailable method.

Syntax

options=SpssClient.GetSPSSOptions ()

The options and associated three-letter abbreviations are as follows:

Bas Base

Pro Regression

Adv Advanced Statistics
Cyt Exact Test

Cat Categories
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Mva Missing Values
Con Conjoint
Msa Custom Tables
Csp Complex Samples
Tre Decision Trees
Vid Data Preparation
Trd Forecasting
Pes Statistics Adaptor
Neu Neural Networks
Rfm RFM

GetSPSSPath Method

Returns a string specifying the path to the IBM® SPSS® Statistics installation directory.

Syntax

path=SpssClient.GetSPSSPath()
GetSPSSVersion Method

Returns a string specifying the IBM® SPSS® Statistics version.

Syntax

version=SpssClient.GetSPSSVersion/()

GetSyntaxDocuments Method

Returns the list of open syntax documents as a SyntaxDocsList object. Each item in the list is an
SpssSyntaxDoc object.

Syntax

SyntaxDocsList=SpssClient.GetSyntaxDocuments ()
GetUIAlerts Method
Returns the current setting of UI alerts for the client. The result is Boolean.

Syntax

SpssClient.GetUIAlerts ()
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Returns
True Alerts are displayed in the Ul
False UI alerts are suppressed

IsDataDocinUse Method

Indicates whether a specified data file is in use by another instance of IBM® SPSS® Statistics.
The result is Boolean. The argument is a string specifying the path to the data file. Note: This
method is not supported on Mac and Linux.

Syntax

SpssClient.IsDataDocInUse (fileName)

On Windows, it is recommended to use raw strings for file paths, or replace backslashes with
forward slashes (SPSS Statistics accepts a forward slash for any backslash in a file specification).
Raw strings are specified by prefacing the string with r, as in r’c:\examples\mydata.sav’. In

raw mode, Python treats all backslashes in the string as the backslash character and not as the
start of an escape sequence.

IsDistributedMode

Indicates whether the scripting process is being run in distributed mode. The result is Boolean.

Syntax

SpssClient.IsDistributedMode ()

IsOptionAvailable Method

Checks if the IBM® SPSS® Statistics client is licensed for a specified optional component. The
result is Boolean. You can obtain a list of all available options from the GetSPSSOptions method.

Syntax

SpssClient.IsOptionAvailable (1icOption)

Parameters

The parameter /icOption specifies the option. The available values are:

SpssClient.LicenseOption.BASE Base
SpssClient.LicenseOption.PRO_STATS Regression
SpssClient.LicenseOption. ADVANCED_STATS Advanced Statistics
SpssClient.LicenseOption.CYTEL Exact Test
SpssClient.LicenseOption. MARKET RESEARCH Categories
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SpssClient.LicenseOption.MISSING_VALUES

Missing Values

SpssClient.LicenseOption. CONJOINT

Conjoint

SpssClient.LicenseOption.CUSTOM_TABLES

Custom Tables

SpssClient.LicenseOption. COMPLEX SAMPLE

Complex Samples

SpssClient.LicenseOption. TREEVIEW

Decision Trees

SpssClient.LicenseOption. VALIDATEDATA

Data Preparation

SpssClient.LicenseOption. TRENDS

Forecasting

SpssClient.LicenseOption.PES

Statistics Adaptor

SpssClient.LicenseOption. NEURAL NETWORK

Neural Networks

SpssClient.LicenseOption.RFM

RFM

Returns
True The option is available.
False The option is not available or the license for the

option has expired.

LogToViewer Method

Writes the specified content to the designated output document as a log item. The content is
appended to the last log item in the output document.

Syntax

SpssClient.LogToViewer (content)

Parameters

| content

A string

NewDataDoc Method

Creates a new dataset and makes it the active dataset. The method returns an SpssDataDoc object

associated with the new dataset.

Syntax

SpssDataDoc=SpssClient .NewDataDoc ()

NewOutputDoc Method

Creates a new output document and makes it the designated output document. The method returns

an SpssOutputDoc object associated with the new output document.
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Syntax

SpssOutputDoc=SpssClient .NewOutputDoc ()

NewSyntaxDoc Method

Creates a new syntax document and makes it the designated syntax document. The method returns
an SpssSyntaxDoc object associated with the new syntax document.

Syntax

SpssSyntaxDoc=SpssClient .NewSyntaxDoc ()

OpenDataDoc Method

Opens the specified data document and makes it the active dataset. The method returns an
SpssDataDoc object.

®  This method is not available when called from a Python program in distributed mode (Python
programs make use of the interface exposed by the Python spss module).

Syntax

SpssDataDoc=SpssClient.OpenDataDoc (fileName, password=None)

Parameters

fileName The path and file name of the data document, as
a string.

password A string specifying the password required to open

the file. Only applies to encrypted data files.
The password can be specified as encrypted or
unencrypted. Encrypted passwords are created
when pasting command syntax, for an encrypted
file, from the Save Data As dialog.

On Windows, it is recommended to use raw strings for file paths, or replace backslashes
with forward slashes (IBM® SPSS® Statistics accepts a forward slash for any backslash
in a file specification). Raw strings are specified by prefacing the string with r, as in
r’c:\examples\mydata.sav’. In raw mode, Python treats all backslashes in the string as the
backslash character and not as the start of an escape sequence.

OpenOutputDoc Method

Opens the specified output document and makes it the designated output document. The method
returns an SpssOutputDoc object. By default, the associated Viewer window is invisible. Use the
SetVisible method from the SpssOutputUI class to make the Viewer window visible. You get an
SpssOutputUI object using the GetOutputUI method of the SpssOutputDoc object.
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Syntax

SpssOutputDoc=SpssClient.OpenOutputDoc (fileName, password=None)

Parameters

fileName The path and file name of the output document, as
a string.

password A string specifying the password required to open

the file. Only applies to encrypted output files.

The password can be specified as encrypted or
unencrypted. Encrypted passwords are created when
pasting command syntax, for an encrypted file, from
the Save Output As dialog.

On Windows, it is recommended to use raw strings for file paths, or replace backslashes
with forward slashes (IBM® SPSS® Statistics accepts a forward slash for any backslash
in a file specification). Raw strings are specified by prefacing the string with r, as in
r’c:\examples\mydata.sav’. In raw mode, Python treats all backslashes in the string as the
backslash character and not as the start of an escape sequence.

OpenSyntaxDoc Method

Opens the specified syntax document and makes it the designated syntax document. The
method returns an SpssSyntaxDoc object. By default, the associated Syntax Editor window
is invisible. Use the SetVisible method from the SpssSyntaxUTI class to make the Syntax
Editor window visible. You get an SpssSyntaxUI object using the GetSyntaxUI method of the
SpssSyntaxDoc object.

Syntax

SpssSyntaxDoc=SpssClient.OpenSyntaxDoc (fileName)

Parameters

fileName The path and file name of the syntax document, as
a string.

On Windows, it is recommended to use raw strings for file paths, or replace backslashes
with forward slashes (IBM® SPSS® Statistics accepts a forward slash for any backslash
in a file specification). Raw strings are specified by prefacing the string with r, as in
r’c:\examples\mydata.sav’. In raw mode, Python treats all backslashes in the string as the
backslash character and not as the start of an escape sequence.

RunSyntax Method

Executes a set of syntax commands.
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B The submitted commands are executed synchronously with any other submitted command
syntax.

®  This method cannot be called within a script that is run from the SCRIPT command. It is also
not available when called from a Python program in distributed mode (Python programs make
use of the interface exposed by the Python spss module).

Syntax

SpssClient.RunSyntax (syntaxCommands)

Parameters

syntaxCommands A string specifying command syntax. If the string is
empty, no error is returned and the script continues.
Commands must end in a period (command
terminator).

Example

SpssClient.RunSyntax ("GET FILE='/examples/data/Employee data.sav'.")

To specify multiple commands, separate each command by the escape sequence for a linefeed,
"\n", or enclose the set of commands in a triple-quoted string, as in:

SpssClient.RunSyntax (r"""
GET FILE='/examples/data/Employee data.sav'.
SORT CASES BY gender.
SPLIT FILE
LAYERED BY gender.
DESCRIPTIVES
VARIABLES=salary salbegin jobtime prevexp
/STATISTICS=MEAN STDDEV MIN MAX.
SPLIT FILE OFF.

nn u)

m  The triple double quotes enclose a block of command syntax that is submitted for processing,
retaining the line breaks. You can use either triple single quotes or triple double quotes, but
you must use the same type (single or double) on both sides of the command syntax block.

®  Notice that the triple-quoted expression is prefixed with the letter r. The r prefix to a string
specifies Python’s raw mode. In raw mode, Python treats all backslashes in the string as the
backslash character and not as the start of an escape sequence.

SaveServers Method

Saves the set of configured servers so that new server configurations added during the current
session will persist across sessions.

Syntax

SpssClient.SaveServers ()
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ScriptParameter Method

Retrieves a parameter passed to the script when calling the script from a SCRIPT command within
command syntax. Only a single parameter can be passed and it must be a quoted string.

Syntax

SpssClient.ScriptParameter (0)

SetCurrentDirectory Method

Sets the current working directory of the IBM® SPSS® Statistics client to a specified value.

Syntax

SpssClient.SetCurrentDirectory (newDir)

Parameters

newDir The absolute path to the new working directory, as
a string.

On Windows, it is recommended to use raw strings for file paths, or replace backslashes with
forward slashes (SPSS Statistics accepts a forward slash for any backslash in a file specification).
Raw strings are specified by prefacing the string with r, as in r’c:\examples\mydata.sav’. In

raw mode, Python treats all backslashes in the string as the backslash character and not as the
start of an escape sequence.

SetDefaultJCVersion Method

Sets the default version of the IBM® SPSS® Statistics - Integration Plug-in for Python used for
Python scripts. This method is useful when working with multiple versions of the plug-in on a
given machine (see Note below). The value of the argument is a quoted string or an integer
specifying a plug-in version—for example, "SpssClient160" or 160 for version 16.0. You
can view the default using the GetDefaultJCVersion method.

B SetDefaultJCVersion also sets the default version of the Integration Plug-in for Python
used for Python programs (Python code that utilizes the spss module).

Syntax

SpssClient.SetDefaultdCVersion (version)

Note: The methods for managing multiple versions of the plug-in
(SpssClient.GetDefaultJCVersion, and SpssClient.SetDefaultJCVersion) operate
within a given Python version, not across Python versions. For example, if you are driving IBM®
SPSS® Statistics from a Python IDE installed for Python 2.7 then you can view and control the
versions of the plug-in installed for Python 2.7.
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For more information, see the topic Working with Multiple Versions of IBM SPSS Statistics
in Chapter 1 on p. 2.

SetExportOption Method
Sets the value of the specified export option to the value provided.

Syntax

SpssClient.SetExportOption (option, value)

Parameters

| value | A string |

For a list of the available export options and associated settings, see Appendix B on p. 202. The
value of option is the identifier SpssClient . ExportOptions, followed by a period (.) and the
name of the option—for example, SpssClient . ExportOptions.GraphExportType.

SetPreference Method
Sets the value of the specified preference option to the value provided.

Syntax

SpssClient.SetPreference (option,value)

Parameters

| value | A string |

For a list of the available preference options and settings, see Appendix D on p. 205. The value of
option is the identifier SpssClient . PreferenceOptions, followed by a period (.) and the name
of the option—for example, SpssClient.PreferenceOptions.VariableListDisplay.

SetUlAlerts Method
Specifies the setting of Ul alerts for the IBM® SPSS® Statistics client.

Syntax

SpssClient.SetUIAlerts (showUIAlerts)
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Parameters

showUTIAlerts True if alerts are to be displayed in the UI and False
if Ul alerts are to be suppressed.

If False is specified, any alerts triggered by script operations are propagated to the script as an
exception.

StartClient Method

Establishes a connection to the IBM® SPSS® Statistics client and is required for every Python
script.

m  [f the script is run from an external Python process (such as a Python IDE or the Python
interpreter), an attempt is made to connect to an existing SPSS Statistics client. If more than
one client is found, a connection is made to the most recently launched one. If an existing
client is not found, a new and invisible instance of the SPSS Statistics client is started and
a connection to it is established.

B SpssClient.StopClient () should be called at the completion of the script. To ensure
that StopClient () is called, it is recommended to include the call in the finally clause
of a try statement—for example, by including the body of the script in a try statement.
If the script is being run from an external Python process that starts up a new client, call
SpssClient.Exit () before SpssClient.StopClient ().

Syntax

SpssClient.StartClient ()

StopClient Method

Terminates the connection to the IBM® SPSS® Statistics client. This method should be called at
the completion of each Python script. To ensure that StopClient () is called, it is recommended
to include the call in the £inally clause of a try statement—for example, by including the
body of the script in a try statement.

Syntax

SpssClient.StopClient ()

__heartBeat Method

The heartBeat method is a utility function for use with thread-aware debuggers that pause
all threads at a breakpoint. If you are using such a debugger, then you will need to disable the
SpssClient heartbeat function (which is enabled by default) during debugging; otherwise the
scripting session may terminate at a breakpoint due to a failed heartbeat.
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Syntax

To set the heartbeat status, use:
SpssClient. heartBeat (status)
To get the heartbeat status, use:

SpssClient. heartBeat ()

SpssClient Class

Parameters

status True to enable the heartbeat function, False to
disable the heartbeat function.

Returns

True The heartbeat function is enabled.

False

The heartbeat function is disabled.
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SpssDataDoc Class

The SpssDataDoc class represents an open dataset.

Example: Obtaining the Active Dataset

import SpssClient
SpssClient.StartClient ()
ActiveDataDoc = SpssClient.GetActiveDataDoc ()

m  The variable ActiveDataDoc is an SpssDataDoc object for the active dataset.

Example: Obtaining the First Opened Dataset

import SpssClient

SpssClient.StartClient ()

DataDocsList SpssClient.GetDataDocuments ()
FirstDataDoc DataDocsList.GetItemAt (0)

B SpssClient.GetDataDocuments () returns a DataDocsList object, which provides
access to all open datasets.

B The GetItemAt method from the DataDocsList class is used to get the dataset with index
0 (the first opened dataset) from the list of open datasets. The variable FirstDataDoc is an
SpssDataDoc object for this dataset.

CloseDocument Method

Closes the dataset. If the dataset is the last open dataset then the instance of the IBM® SPSS®
Statistics client associated with the current script is terminated.

Syntax

SpssDataDoc.CloseDocument ()

GetCaseCount Method

Returns the number of cases in the dataset.

Syntax

SpssDataDoc .GetCaseCount ()

© Copyright IBM Corporation 1989, 2012. 24
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GetDatasetName Method

Returns the dataset name. If the dataset is unnamed, an empty string is returned.

Syntax

SpssDataDoc.GetDatasetName ()

GetDataUl Method

Returns an SpssDataUI object representing the Data Editor window of the associated dataset, if
one exists.

Syntax

SpssDataUI=SpssDataDoc.GetDatalUI ()

GetDocumentPath Method

Returns the path and file name of the data file associated with this dataset object, or the empty
string if the dataset is not associated with a file.

Syntax

SpssDataDoc .GetDocumentPath ()

Note: If you reopen a data file that is currently open, the GetDocumentPath method will
return the empty string when called on the SpssDataDoc object associated with the reopened
instance of the file.

GetMenuTable Method

Returns a MenuTableList object containing the list of available menu items for the data document.

Syntax

MenuTableList = SpssDataDoc.GetMenuTable ()

GetVariableCount Method

Returns the number of variables in the associated dataset.

Syntax

SpssDataDoc.GetVariableCount ()
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IsActiveDataDoc Method

Indicates if this dataset is the active one. The result is Boolean—T7True if the dataset is the active
one, False otherwise.

Syntax

SpssDataDoc.IsActiveDataDoc ()

IsEqualTo Method

Indicates if this dataset object is the same object as a specified dataset object. The result is
Boolean—True if the two objects are identical, False otherwise.

Syntax

SpssDataDoc.IsEqualTo (dataDoc)

Parameters

| dataDoc An SpssDataDoc object

IsModified Method

Indicates whether the dataset has been modified. The result is Boolean—True if the dataset
has been modified, False otherwise.

Syntax

SpssDataDoc.IsModified()

IsPromptToSave Method

Indicates if the ‘prompt to save’ flag is set for this dataset object. The result is Boolean—True if
the ‘prompt to save’ flag has been set, False otherwise.

Syntax

SpssDataDoc.IsPromptToSave ()

SaveAs Method

Saves the dataset to the specified file.
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Syntax

SpssDataDoc.SaveAs (fileName, password=None)

Parameters
fileName The path and file name of the data file, as a string.
password An optional string specifying the password that will

be required to open the file. Only applies if you
want to encrypt the data file. Passwords are limited
to 10 characters and are case-sensitive. All spaces,
including leading and trailing spaces, are retained.

Note: The save operation is carried out asynchronously, which means that execution continues
without waiting for the save operation to complete. If you require subsequent access to the saved
file using the Python open function, you can attempt to open the file from a try block within a
while loop, continuing to loop until the open operation succeeds.

Creating strong passwords
m  Use eight or more characters.
® Include numbers, symbols and even punctuation in your password.

B Avoid sequences of numbers or characters, such as "123" and "abc", and avoid repetition,
such as "11laaa".

B Do not create passwords that use personal information such as birthdays or nicknames.

m Periodically change the password.

Warning: Passwords cannot be recovered if they are lost. If the password is lost the file cannot
be opened.

Note: Encrypted files cannot be opened in versions of IBM® SPSS® Statistics prior to version 21.

SetAsActiveDataDoc Method

Sets this dataset as the active one.

Syntax

SpssDataDoc.SetAsActiveDataDoc ()

SetDatasetName Method

Sets the dataset name. The argument is a string.

Syntax

SpssDataDoc.SetDatasetName (name)
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SetModified Method

Sets the modified status of the dataset.

Syntax

SpssDataDoc.SetModified (modified)

Parameters

| modified True to set the status to modified, False otherwise.

SetPromptToSave Method

Sets the ‘prompt to save’ flag for this dataset object.

Syntax

SpssDataDoc.SetPromptToSave (promptToSave)

Parameters

| promptToSave True to set the prompt to save flag, False otherwise.

DataDocslist Class

The DataDocsList class provides access to the list of open datasets. You obtain a
DataDocsList object from the GetDataDocuments method of the SpssClient class.

A DataDocsList object is not an iterable Python object. In order to iterate over the items in the
list, use a for loop, as in:

for index in range (DataDocsList.Size()) :

For an example that uses the DataDocsList class, see the examples for the SpssDataDoc class.

GetltemAt Method

Returns an SpssDataDoc object representing the dataset with the specified index. The index
corresponds to the order in which the datasets were opened, with the first opened document
having an index of 0.

Syntax

SpssDataDoc=DataDocsList.GetItemAt (index)
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Size Method

Returns the number of open datasets.

Syntax

DataDocsList.Size ()

SpssDataUl Class

The SpssDataUI class represents the Data Editor window associated with an open dataset. You
obtain an SpssDataUI object from the GetDataUI method of an SpssDataDoc object.

Example: Get the SpssDataUl Object Associated with the Active Dataset

import SpssClient

SpssClient.StartClient ()

ActiveDataDoc = SpssClient.GetActiveDataDoc ()
DataUI = ActiveDataDoc.GetDatalUI ()

m  The variable DataUl is an SpssDataUI object for the Data Editor window associated with
the active dataset.

GetHeight Method

Returns the height of the associated Data Editor window in units of pixels.

Syntax

SpssDataUI.GetHeight ()

GetLeft Method

Returns the horizontal screen position of the associated Data Editor window’s upper left corner.
The result is in units of pixels.

Syntax

SpssDataUI.GetLeft ()

GetShowGridLines Method

Return the setting for showing grid lines in the associated Data Editor window. The result is
Boolean—True if grid lines are visible, False otherwise.

Syntax

SpssDataUI.GetShowGridLines ()
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GetShowValueLabels Method

Return the setting for displaying value labels in the associated Data Editor window. The result is
Boolean—True if value labels are displayed, False otherwise.

Syntax

SpssDataUI.GetShowValuelLabels ()

GetTitleText Method

Returns the title bar text of the associated Data Editor window.

Syntax

SpssDataUl.GetTitleText ()

GetTop Method

Returns the vertical screen position of the associated Data Editor window’s upper left corner. The
result is in units of pixels.

Syntax

SpssDataUI.GetTop ()

GetVisible Method

Indicates if the associated Data Editor window is visible. The result is Boolean—T7rue if the
Data Editor window is visible, False otherwise.

Syntax

SpssDataUIl.GetVisible ()

GetWidth Method

Returns the width of the associated Data Editor window in units of pixels.

Syntax

SpssDataUI.GetWidth ()

GetWindowState Method

Returns the state of the associated Data Editor window.
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Syntax

SpssDataUI.GetWindowState ()

Returns

SpssClient.SpssWindowStates.SpssMinimized Minimized

SpssClient.SpssWindowStates.SpssMaximized Maximized

SpssClient.SpssWindowStates.SpssNormal Normal
InvokeDialog Method

Invokes a dialog and returns the syntax generated from that dialog, if any.

Syntax

syntax = SpssDataUI.InvokeDialog(menultemPath,desktopParent)

Parameters

menultemPath Menu or menu item with path of the dialog to
invoke. See below for detailed description.

desktopParent True specifies that the dialog is parented off the
desktop. False specifies that the dialog is parented
off an IBM® SPSS® Statistics window.

Note: For release 19.0.0.2 and higher, the bSync parameter (available in previous releases) is
deprecated. The InvokeDialog method always runs synchronously, meaning that the scripting
process waits until the dialog has been dismissed. Older scripts containing the bSync parameter
will continue to function in release 19.0.0.2 and higher, but the value of the parameter will be
ignored.

Specifying The Menu Item Path

The value of the menultemPath parameter is a string specifying the menu path to the desired
dialog—for example “analyze>survival>life tables”. The greater-than sign (>) is used to separate
a menu, its submenus and the menu item. The menu string must correspond exactly to the text on
the menus, submenus, and menu items, and is language specific.

PrintDataDoc Method
Prints the document.

Syntax

SpssDataUI.PrintDataDoc ()
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SetHeight Method

Sets the height of the associated Data Editor window.

Syntax

SpssDataUI.SetHeight (height)

Parameters

| height An integer representing the height in pixels.

SetlLeft Method

Sets the horizontal screen position of the associated Data Editor window’s upper left corner.

Syntax

SpssDataUI.SetLeft (leftPosition)

Parameters

| leftPosition An integer representing the position in pixels.

SetShowGridLines Method

Specify the setting for showing grid lines in the associated Data Editor window.

Syntax

SpssDataUI.SetShowGridLines (isGridLines)

Parameters

isGridLines True if grid lines are to be displayed, False
otherwise.

SetShowValuelabels Method

Specify the setting for displaying value labels in the Data Editor window.

Syntax

SpssDataUI.SetShowValuelabels (isValuelLabels)
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Parameters
isValueLabels True if value labels are to be displayed, False
otherwise.
SetTop Method

Sets the vertical screen position of the associated Data Editor window’s upper left corner.

Syntax

SpssDataUI.SetTop (topPosition)

Parameters

| topPosition An integer representing the position in pixels.

SetVisible Method

Sets the visibility of the associated Data Editor window.

Syntax

SpssDataUIl.SetVisible (isVisible)

Parameters
isVisible True to set the Data Editor window as visible, False
otherwise.
SetWidth Method

Sets the width of the associated Data Editor window.

Syntax

SpssDataUI.SetWidth (width)

Parameters

| width An integer representing the width in pixels.

SetWindowState Method

Set the state of the associated Data Editor window.
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Syntax

SpssDataUI.SetWindowState (newState)

Parameters

Set the value of newState to one of the following:

SpssClient.SpssWindowStates.SpssMinimized Minimized

SpssClient.SpssWindowStates.SpssMaximized Maximized

SpssClient.SpssWindowStates.SpssNormal Normal
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SpssOutputDoc Class

The SpssOutputDoc class represents an open output document.

Example: Obtaining the Designated Output Document

import SpssClient
SpssClient.StartClient ()
DesignatedOutputDoc = SpssClient.GetDesignatedOutputDoc ()

m  The variable DesignatedOutputDoc is an SpssOutputDoc object for the designated output
document.

Example: Obtaining the First Opened Output Document

import SpssClient

SpssClient.StartClient ()

OutputDocsList = SpssClient.GetOutputDocuments ()
FirstOutputDoc = OutputDocsList.GetItemAt (0)

B SpssClient.GetOutputDocuments () returns an OutputDocsList object, which
provides access to all open output documents.

B The GetItemAt method from the OutputDocsList class is used to get the output document
with index O (the first opened output document) from the list of open output documents. The
variable FirstOutputDoc is an SpssOutputDoc object for this output document.

Example: Create a New Output Document and Set it as the Designated One

import SpssClient
SpssClient.StartClient ()

NewOutputDoc = SpssClient.NewOutputDoc ()
NewOutputDoc.SetAsDesignatedOutputDoc ()

®  The variable NewOQutputDoc is an SpssOutputDoc object for the new output document.

Accessing Output Items in an Output Document

You access individual output items, within an output document, from an OutputItemList
object. You obtain an OutputItemList object from the GetOutputitems method of the
SpssoOutputDoc class. For more information, see the topic SpssOutputltem Class in Chapter 6
onp. 73.

© Copyright IBM Corporation 1989, 2012. 35
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ClearSelection Method

Deselects all selected output items or pivot table elements.

Syntax

SpssOutputDoc.ClearSelection ()

CloseDocument Method

Closes the output document.

Syntax

SpssOutputDoc.CloseDocument ()

Copy Method

Copies selected items to the clipboard. Use this method with caution because it overwrites
clipboard content. To improve performance when copying large pivot tables, consider using
the CopySpecial method.

To select individual items, use the SetSelected method. You can also select all items of a given
type, such as all tables using the SelectAllTables method.

Syntax

SpssOutputDoc. Copy ()

CopySpecial Method

Copies selected items to the clipboard in a set of specified formats. Use this method with caution
because it overwrites clipboard content. This method is especially useful when copying large
pivot tables since you can limit the output to just the formats you need. In that regard, the Copy
method generates output in all available formats.

To select individual items, use the SetSelected method. You can also select all items of a given
type, such as all tables using the SelectAllTables method.

Syntax
SpssOutputDoc.CopySpecial (formats)

The value of formats is a list or tuple of one or more of the following format identifiers.

Format Identifier Description

SpssClient.CopySpecialFormat. Text plain text
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SpssClient.CopySpecialFormat.Rtf

rich text format

SpssClient.CopySpecialFormat.Image

image

SpssClient.CopySpecialFormat. Emf

Windows enhanced metafile

SpssClient.CopySpecialFormat.Biff

excel worksheet in biff5 format

m  The image format is a java raster image and is handled differently by different applications.

m  The Windows enhanced metafile (emf) format is only supported when selecting a single

output item to copy to the clipboard.

The list of available formats for each output type is given in the following table.

Type

Formats

SpssClient.OutputltemType. CHART

rich text, image or emf

SpssClient.OutputltemType.LOG

plain text, rich text or biff

SpssClient.OutputltemType. MODEL

image or emf

SpssClient.OutputltemType.NOTE

plain text, rich text, image, emf or biff

SpssClient.OutputltemType. PAGETITLE

plain text, rich text or biff

SpssClient.OutputltemType. PIVOT

plain text, rich text, image, emf or biff

SpssClient.OutputltemType. TEXT

plain text, rich text or biff

SpssClient.OutputltemType. TITLE

plain text, rich text or biff

SpssClient.OutputltemType. TREEMODEL

rich text or image

SpssClient.OutputltemType. WARNING

plain text, rich text, image, emf or biff

m [f a specified format is not supported for a selected item then the format is ignored for that
item. For example, you select a Log item and a Chart item and specify the plain text and
image formats. The clipboard contains the Log item in plain text format and the Chart item as

an image.

Example

The following copies a pivot table to the clipboard in rich text format only.

SpssOutputDoc.CopySpecial ( [SpssClient.CopySpecialFormat.Rtf])

CreateHeaderltem Method

Returns an SpssOutputItem object for a new header item. To insert the header item into the
output document, use the InsertChildItem method in the SpssHeaderItem class.

Syntax

SpssOutputItem=SpssOutputDoc.CreateHeaderItem(label)
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Parameters

label A string specifying the label for the header item.
The value can be specified as plain text, HTML, or
rich text format. For HTML, embed markup in a
<htmI></htmI> block. For rich text format, specify
the string as a raw string to avoid unintentional
escape sequences.

CreatelmageChartltem Method

Returns an SpssOutputItem object for a new chart item associated with an external image. This
allows you to insert an external image of type png, jpg, or gif into an output document. To insert
the chart item into the output document, use the InsertChildItem method in the SpssHeaderItem
class.

Syntax

SpssOutputItem=SpssOutputDoc.CreateImageChartItem(fileName, label)

Parameters
fileName Full path to the image file.
label A string specifying the label for the chart item.

The value can be specified as plain text, HTML, or
rich text format. For HTML, embed markup in a
<htmI></htmI> block. For rich text format, specify
the string as a raw string to avoid unintentional
escape sequences.

On Windows, it is recommended to use raw strings for file paths, or replace backslashes
with forward slashes (IBM® SPSS® Statistics accepts a forward slash for any backslash
in a file specification). Raw strings are specified by prefacing the string with r, as in
r’c:\examples\mydata.sav’. In raw mode, Python treats all backslashes in the string as the
backslash character and not as the start of an escape sequence.

CreateTextltem Method

Returns an SpssOutputItem object for a new text item. To insert the text item into the output
document, use the InsertChildItem method in the SpssHeaderItem class.

Syntax

SpssOutputItem=SpssOutputDoc.CreateTextItem(content)
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content

A string specifying the content of the text item.
The value can be specified as plain text, HTML, or
rich text format. For HTML, embed markup in a
<htmI></htmI> block. For rich text format, specify
the string as a raw string to avoid unintentional
escape sequences.

CreateTitleltem Method

Returns an SpssOutputItem object for a new title item. To insert the title item into the output
document, use the InsertChildItem method in the SpssHeaderItem class.

Syntax

SpssOutputItem=SpssOutputDoc.CreateTitleItem(title, pageBreak)

Parameters

title

A string specifying the title. The value can be
specified as plain text, HTML, or rich text format.
For HTML, embed markup in a <htmI></html>
block. For rich text format, specify the string as a
raw string to avoid unintentional escape sequences.

pageBreak

True if this title item is to be a page title item, False
otherwise.

Cut Method

Removes the selected data or text and places them on the clipboard. Use this method with caution

because it overwrites clipboard content.

Syntax

SpssOutputDoc. Cut ()
Delete Method

Deletes the selected items.

Syntax

SpssOutputDoc.Delete ()

Demote Method

Demotes selected output items down one level within the hierarchy of the output tree.



40

Chapter 4
B You cannot demote an item that is at the deepest level in the output tree and you cannot
demote an item if there are unselected items at the same level immediately preceding it in
the output tree.
If the item has children, the children are also demoted.
You cannot demote the root item.
Syntax
SpssOutputDoc.Demote ()
You can promote items up one level with the Promote method.
ExportCharts Method

Exports charts from this output document.

Syntax

SpssOutputDoc.ExportCharts (subSet, filePrefix, format)

Parameters

subSet Specifies whether all charts, all visible charts, or all
selected charts are exported. See available choices
below.

filePrefix Full path and file name prefix for the files containing
the exported charts. Each chart is exported to a
separate file.

format Specifies the export format. See available choices
below.

On Windows, it is recommended to use raw strings for file paths, or replace backslashes
with forward slashes (IBM® SPSS® Statistics accepts a forward slash for any backslash
in a file specification). Raw strings are specified by prefacing the string with r, as in
r’c:\examples\mydata.sav’. In raw mode, Python treats all backslashes in the string as the
backslash character and not as the start of an escape sequence.

Set the value of subSet to one of the following:

SpssClient.SpssExportSubset.SpssSelected

All selected charts

SpssClient.SpssExportSubset.SpssVisible

All visible charts

SpssClient.SpssExportSubset.SpssAll

All charts

Set the value of format to one of the following:

SpssClient.ChartExportFormat.bmp

Windows bitmap

SpssClient.ChartExportFormat.emf

Enhanced metafile

SpssClient.ChartExportFormat.eps

Enhanced postscript
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SpssClient.ChartExportFormat.jpg JPG file

SpssClient.ChartExportFormat.png PNG file

SpssClient.ChartExportFormat.tiff Tagged image file
ExportDocument Method

Exports items from this output document.

m [f the items to be exported include charts, then they are exported in the last selected graphics
format. The graph export type can be set from the SetExportOption method in the
SpssClient class.

m  Use the SetOutputOptions method to set export options for export to Word, Excel, or
PowerPoint.

Syntax

SpssOutputDoc . ExportDocument (subSet, fileName, format)

Parameters

subSet Specifies whether all items, all visible items, or all
selected items are exported. See available choices
below.

fileName Full path and file name for the file containing the
exported items.

format Specifies the export format. See available choices
below.

On Windows, it is recommended to use raw strings for file paths, or replace backslashes
with forward slashes (IBM® SPSS® Statistics accepts a forward slash for any backslash
in a file specification). Raw strings are specified by prefacing the string with r, as in
r’c:\examples\mydata.sav’. In raw mode, Python treats all backslashes in the string as the
backslash character and not as the start of an escape sequence.

Set the value of subSet to one of the following:

SpssClient.SpssExportSubset.SpssSelected All selected items
SpssClient.SpssExportSubset.SpssVisible All visible items
SpssClient.SpssExportSubset.SpssAll All items

Set the value of format to one of the following:

SpssClient.DocExportFormat.SpssFormatHtml Html
SpssClient.DocExportFormat.SpssFormatDoc Word
SpssClient.DocExportFormat.SpssFormatXls Excel
SpssClient.DocExportFormat.SpssFormatText Text
SpssClient.DocExportFormat.SpssFormatPdf PDF
SpssClient.DocExportFormat.SpssFormatPpt PowerPoint
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GetCurrentitem Method

Returns an SpssOutputItem object for the current output item—as indicated by a red arrow
next to the item in the outline pane.

Syntax

SpssOutputItem=SpssOutputDoc.GetCurrentItem ()

GetDocumentPath Method

Returns the path and file name of the output file associated with this output document object, or
the empty string if the output document is not associated with a file.

Syntax

SpssOutputDoc.GetDocumentPath ()

GetFooterText Method

Returns the footer text for printed pages. The value is returned as plain text.

Syntax

SpssOutputDoc.GetFooterText ()

GetHeaderText Method

Returns the header text for printed pages. The value is returned as plain text.

Syntax

SpssOutputDoc.GetHeaderText ()

GetMenuTable Method

Returns a MenuTableList object containing the list of available menu items for the output
document.

Syntax

MenuTablelList = SpssOutputDoc.GetMenuTable ()
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GetOutputltems Method

Returns a list of items in the output document as an OutputItemList object. Each item in the
list is an SpssOutputItem object.

Syntax

OutputItemList=SpssOutputDoc.GetOutputItems ()

GetOutputOptions Method

Returns the value of the specified export option for this output document, as a string.

Syntax

SpssOutputDoc.GetOutputOptions (option)

Parameters

The available values for the option parameter are (specify the value without quotes):

SpssClient.DocExportOption.ExcelSheetNames. Specifies the name of the sheet to which items will
be exported. This option only applies when exporting to Excel.

SpssClient.DocExportOption.ExcelStartingCell. Specifies the starting cell for exporting to
Excel. Applies when SpssClient.DocExportOption.ExcellLocationOptions is set
to “OverwriteAtCellRef”.

SpssClient.DocExportOption.ExcelOperationOptions. Specifies whether a new workbook is created,
a new worksheet is created, or an existing worksheet is modified. This option only applies
when exporting to Excel.

m  “CreateWorkbook”. A new workbook is created. If the specified file exists, it is overwritten.

m  “CreateWorksheet”. A new worksheet is created within the specified workbook. The name of
the sheet is given by the setting of SpssClient .DocExportOption.ExcelSheetNames.
If a worksheet with the specified name already exists, that worksheet is overwritten. If the
specified file does not exist, a new file is created with a worksheet with the specified name.

m  “ModifyWorksheet”. Modifies the contents of an existing worksheet. The name of the sheet is
given by the setting of SpssClient .DocExportOption.ExcelSheetNames. Export of
charts, model views, and tree diagrams is not supported with “ModifyWorksheet”.

SpssClient.DocExportOption.ExcelLocationOptions. Specifies how items will be added to a
worksheet. This option only applies when exporting to Excel.

m  “AddColumns”. Specifies that items will be added after the last column, starting in the first row,
without modifying any existing contents.
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m  “AddRows”. Specifies that items will be added after the last row, starting in the first column,
without modifying any existing contents.

m  “OverwriteAtCellRef”. Specifies that items will be written to the location specified in
SpssClient .DocExportOption.ExcelStartingCell. Any existing content in the area
where the exported items are added will be overwritten.

SpssClient.DocExportOption.WideTablesOptions. Specifies the treatment of pivot tables that are too
wide for the document width (the specified page width minus the left and right margins). This
option only applies when exporting to Word or PowerPoint.

m  “WT_Wrap”. Specifies that tables are divided into sections that will fit within the defined
document width. Row labels are repeated for each section of the table. If the row labels are
too wide for the defined document width, the table is exported without wrapping and will
appear truncated in the document.

m  “WT_Shrink”. Specifies that font size and column width are reduced so that tables fit within
the document width.

m  “WT_Extend”. Specifies that tables that are too wide for the document width will appear
truncated. All of the table content, however, is retained so expanding the document width will
display additional table content.

The following options apply when exporting to Word or PowerPoint.

SpssClient.DocExportOption.ItemsPageHeight. A character representation
of a positive number representing the page height, in units specified by
SpssClient .DocExportOption. ItemsMeasurementUnits

SpssClient.DocExportOption.ItemsPageWidth. A character representation
of a positive number representing the page width, in units specified by
SpssClient .DocExportOption. ItemsMeasurementUnits

SpssClient.DocExportOption.ItemsTopMargin. A character representation of
a positive number representing the top margin, in units specified by
SpssClient.DocExportOption.ItemsMeasurementUnits

SpssClient.DocExportOption.ltemsBottomMargin. A character representation
of a positive number representing the bottom margin, in units specified by
SpssClient.DocExportOption.ItemsMeasurementUnits.

SpssClient.DocExportOption.ItemsRightMargin. A character representation
of a positive number representing the right margin, in units specified by
SpssClient.DocExportOption.ItemsMeasurementUnits.

SpssClient.DocExportOption.ItemsLeftMargin. A character representation
of a positive number representing the left margin, in units specified by
SpssClient .DocExportOption. ItemsMeasurementUnits

SpssClient.DocExportOption.ItemsMeasurementUnits. The units for specifying
page dimensions and margins: “IExportOptions.MeasurementUnits.Inches”,
“IExportOptions.MeasurementUnits.Millimeters”,
“IExportOptions.MeasurementUnits.Centimeters”, and
“IExportOptions.MeasurementUnits.PrintPoints™ (1/72 inch).
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GetOutputUI Method

Returns an SpssOutputUI object representing the Viewer window associated with the output
document, if one exists.

Syntax

SpssOutputUI=SpssOutputDoc.GetOutputUI ()

GetPrintOptions Method

Returns the value of the specified print option, as a string.
Syntax

SpssOutputDoc.GetPrintOptions (printOption)
Parameters

The available settings for printOption are:

SpssClient.PrintOptions.LeftMargin Left margin
SpssClient.PrintOptions. TopMargin Top margin
SpssClient.PrintOptions.RightMargin Right margin
SpssClient.PrintOptions.BottomMargin Bottom margin
SpssClient.PrintOptions.Orientation Orientation (portrait or landscape)
SpssClient.PrintOptions.StartingPageNumber Starting page number
SpssClient.PrintOptions.SpaceBetweenltems Space between items
SpssClient.PrintOptions.PrintedChartSize Printed chart size (as is, full page, half
page, or quarter page)

®  All margin settings and Space Between Items are in units of points (1/72 inch).
®  For Orientation, 1 corresponds to Portrait and 2 corresponds to Landscape.

®  For Printed Chart Size, 0 corresponds to As Is, 1 to Full Page, 2 to Half Page, and 3 to
Quarter Page.

InsertTable Method
Inserts an empty pivot table after the item designated as the current item. The inserted table is

populated with default row, column and layer labels, and becomes the current item. Note: You can
use the SetCurrentltem method to designate an item as the current item.

Syntax

index=SpssOutputDoc.InsertTable (heading,nrows,ncolumns,nlayers)
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Parameters

heading A string specifying the heading for this table in the
outline pane of the Viewer.

nrows An integer specifying the number of rows in the
table. Specifying zero will result in a table with
one row.

ncolumns An integer specifying the number of columns in the
table. Specifying zero will result in a table with one
column.

nlayers An integer specifying the number of layers in the
table.

Return Value

index The index of the new table item. The index

corresponds to the order of the items in the output
document, starting with 0 for the root item.

Example

This example inserts a pivot table with four rows, three columns and no layers. The table is
inserted after the root item.

import SpssClient

SpssClient.StartClient ()

OutputDoc = SpssClient.GetDesignatedOutputDoc ()
OutputItems = OutputDoc.GetOutputItems ()

OutputItem = OutputItems.GetItemAt (0)
OutputItem.SetCurrentItem()

index = OutputDoc.InsertTable ("Sample table",4,3,0)

IsDesignatedOutputDoc Method

Indicates if this output document is the designated one. The result is Boolean—7rue if the output
document is the designated one, False otherwise.

m If you have more than one open output document, output is routed to the designated one.

Syntax

SpssOutputDoc. IsDesignatedOutputDoc ()

IsEqualTo Method

Indicates if this output document object is the same object as a specified output document object.
The result is Boolean—True if the two objects are identical, False otherwise.

Syntax

SpssOutputDoc.IsEqualTo (outputDoc)
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Parameters

| outputDoc An SpssOutputDoc object

IsModified Method

Indicates whether the output document has been modified. The result is Boolean—True if the
output document has been modified, False otherwise.

Syntax

SpssOutputDoc.IsModified ()

IsPromptToSave Method

Indicates if the ‘prompt to save’ flag is set for this output document object. The result is
Boolean—True if the ‘prompt to save’ flag has been set, False otherwise.

Syntax

SpssOutputDoc.IsPromptToSave ()

Paste Method

Pastes the clipboard content after the current item.

Syntax

SpssOutputDoc.Paste ()

PasteBefore Method

Pastes the clipboard content before the current item.

Syntax

SpssOutputDoc.PasteBefore ()

PrintRange Method

Sets the print range for the output document.

Syntax

SpssOutputDoc.PrintRange (range)
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Parameters

range An integer specifying the print range: 0 for all

expanded output, 1 for all selected items.

You can specify print options using the SetPrintOptions method. You print an output document
using the PrintOutputDoc method from the SpssOutputUI class.

Promote Method

Promotes selected output items up one level within the hierarchy of the output tree.

B You cannot promote an item to the root level and you cannot promote an item if there are

unselected items at the same level immediately following it in the output tree.

If the item has children, the children are also promoted.

Syntax

SpssOutputDoc.Promote ()

You can demote items down one level with the Demote method.

SaveAs Method

Saves the output document to the specified file.

Syntax

SpssOutputDoc. SaveAs (fileName, password=None)

Parameters
fileName The path and file name of the output file, as a string.
password An optional string specifying the password that will

be required to open the file. Only applies if you want
to encrypt the output file. Passwords are limited to
10 characters and are case-sensitive. All spaces,
including leading and trailing spaces, are retained.

Creating strong passwords

Use eight or more characters.
Include numbers, symbols and even punctuation in your password.

Avoid sequences of numbers or characters, such as "123" and "abc", and avoid repetition,
such as "111aaa".

Do not create passwords that use personal information such as birthdays or nicknames.

Periodically change the password.
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Warning: Passwords cannot be recovered if they are lost. If the password is lost the file cannot
be opened.

Note: Encrypted files cannot be opened in versions of IBM® SPSS® Statistics prior to version 21.

SelectAll Method

Selects all items in the output document.

Syntax

SpssOutputDoc.SelectAll ()

SelectAlICharts Method

Selects all chart items in the output document. This includes standard charts, graphboard charts,
and R graphics.

Syntax

SpssOutputDoc.SelectAllCharts ()

SelectAllLogs Method

Selects all log items in the output document.

Syntax

SpssOutputDoc.SelectAllLogs ()

SelectAlIModels Method

Selects all Model Viewer items in the output document.

Syntax

SpssOutputDoc.SelectAllModels ()

SelectAlINotes Method

Selects all notes items in the output document.

Syntax

SpssOutputDoc.SelectAllNotes ()
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SelectAlINotesEx Method

Note: This method is deprecated for release 20 and higher. Please use the SelectAllNotes Method
instead.

Selects all notes items in the output document.

Syntax

SpssOutputDoc.SelectAllNotesEx ()

SelectAllOther Method
Selects all non-IBM® SPSS® Statistics items in the output document.
Syntax

SpssOutputDoc.SelectAllOther ()

SelectAllTables Method

Selects all pivot tables in the output document.

Syntax

SpssOutputDoc.SelectAllTables ()

SelectAllTablesEx Method

Note: This method is deprecated for release 20 and higher. Please use the SelectAllTables
Method instead.

Selects all pivot tables in the output document.
Syntax

SpssOutputDoc.SelectAllTablesEx ()

SelectAllText Method
Selects all text items in the output document.
Syntax

SpssOutputDoc.SelectAllText ()
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SelectAllTitles Method
Selects all title items in the output document.
Syntax

SpssOutputDoc.SelectAllTitles ()

SelectAllWarnings Method
Selects all warnings in the output document.
Syntax

SpssOutputDoc.SelectAllWarnings ()

SelectAlIWarningsEx Method

Note: This method is deprecated for release 20 and higher. Please use the SelectAllWarnings
Method instead.

Selects all warnings in the output document.
Syntax

SpssOutputDoc.SelectAllWarningsEx ()

SelectlastOutput Method
Selects all items generated by the last executed procedure.
Syntax

SpssOutputDoc.SelectLastOutput ()

SetAsDesignatedOutputDoc Method

Sets this output document as the designated output document.

m  [f you have more than one open output document, output is routed to the designated one.
Syntax

SpssOutputDoc. SetAsDesignatedOutputDoc ()
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SetFooterText Method

Sets the footer text for printed pages. The value can be specified as plain text, HTML, or rich text
format. For HTML, embed markup in a <htmI></htmI> block. For rich text format, specify the
string as a raw string to avoid unintentional escape sequences.

Syntax

SpssOutputDoc.SetFooterText (text)

SetHeaderText Method

Sets the header text for printed pages. The value can be specified as plain text, HTML, or rich text
format. For HTML, embed markup in a <htmI></htmI> block. For rich text format, specify the
string as a raw string to avoid unintentional escape sequences.

Syntax

SpssOutputDoc.SetHeaderText (text)

SetModified Method

Sets the modified status of the output document.

Syntax

SpssOutputDoc.SetModified (modified)

Parameters

| modified True to set the status to modified, False otherwise.

SetOutputOptions Method

Sets export options for this output document. These options apply when exporting with the
ExportDocument method from the SpssOutputDoc class as well as the ExportToDocument
method from the SpssOutputItem class.

Syntax

SpssOutputDoc.SetOutputOptions (option, setting)
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Parameters

The available values for the option parameter as well as the allowed values of the associated
setting are (specify the name of the option without quotes):

SpssClient.DocExportOption.ExcelSheetNames. The setting is a string specifying the name of the
sheet to which items will be exported. Sheet names cannot exceed 31 characters and cannot
contain forward or back slashes, square brackets, question marks, or asterisks. If the specified
worksheet doesn’t exist in the Excel file, a new worksheet with that name will be created. This
option only applies when exporting to Excel. The default worksheet is “Sheet1”.

SpssClient.DocExportOption.ExcelStartingCell. The setting is a string specifying the starting cell, as
in “B3”. Applies when SpssClient .DocExportOption.ExcelLocationOptions is set to
“OverwriteAtCellRef”. Only applies when exporting to Excel. The default starting cell is Al.

SpssClient.DocExportOption.ExcelOperationOptions. The setting is a string specifying whether a
new workbook is created, a new worksheet is created, or an existing worksheet is modified. This
option only applies when exporting to Excel.

m  “CreateWorkbook”. A new workbook is created. This is the default. If the specified file exists,
it is overwritten.

m  “CreateWorksheet”. A new worksheet is created within the specified workbook. The name of
the sheet is given by the setting of SpssClient .DocExportOption.ExcelSheetNames.
If a worksheet with the specified name already exists, that worksheet is overwritten. If the
specified file does not exist, a new file is created with a worksheet with the specified name.

m  “ModifyWorksheet”. Modifies the contents of an existing worksheet. The name of the
sheet is given by the setting of SpssClient .DocExportOption.ExcelSheetNames.
Use SpssClient.DocExportOption.ExcelLocationOptions and
SpssClient.DocExportOption.ExcelStartingCell to specify location in the sheet.
Export of charts, model views, and tree diagrams is not supported with “ModifyWorksheet”.

SpssClient.DocExportOption.ExcelLocationOptions. A string specifying how items will be added to
a worksheet. This option only applies when exporting to Excel.

m  “AddColumns”. Specifies that items will be added after the last column, starting in the first row,
without modifying any existing contents. This is the default.

m  “AddRows”. Specifies that items will be added after the last row, starting in the first column,
without modifying any existing contents.

m  “OverwriteAtCellRef”. Specifies that items will be written to the location specified in
SpssClient.DocExportOption.ExcelStartingCell. Any existing content in the area
where the exported items are added will be overwritten.

SpssClient.DocExportOption.WideTablesOptions. A string specifying the treatment of pivot tables
that are too wide for the document width (the specified page width minus the left and right
margins). This option only applies when exporting to Word or PowerPoint.

m  “WT_Wrap”. Specifies that tables are divided into sections that will fit within the defined
document width. This is the default. Row labels are repeated for each section of the table.
If the row labels are too wide for the defined document width, the table is exported without
wrapping and will appear truncated in the document.



54

Chapter 4

m  “WT_Shrink”. Specifies that font size and column width are reduced so that tables fit within
the document width.

m  “WT_Extend”. Specifies that tables that are too wide for the document width will appear
truncated. All of the table content, however, is retained so expanding the document width will
display additional table content.

The following options apply when exporting to Word or PowerPoint.

SpssClient.DocExportOption.ItemsPageHeight. A character representation
of a positive number representing the page height, in units specified by
SpssClient .DocExportOption. ItemsMeasurementUnits

SpssClient.DocExportOption.ItemsPageWidth. A character representation
of a positive number representing the page width, in units specified by
SpssClient .DocExportOption.ItemsMeasurementUnits.

SpssClient.DocExportOption.ItemsTopMargin. A character representation of
a positive number representing the top margin, in units specified by
SpssClient.DocExportOption.ItemsMeasurementUnits.

SpssClient.DocExportOption.ltemsBottomMargin. A character representation
of a positive number representing the bottom margin, in units specified by
SpssClient.DocExportOption.ItemsMeasurementUnits

SpssClient.DocExportOption.ItemsRightMargin. A character representation
of a positive number representing the right margin, in units specified by
SpssClient .DocExportOption.ItemsMeasurementUnits

SpssClient.DocExportOption.ItemsLeftMargin. A character representation
of a positive number representing the left margin, in units specified by
SpssClient .DocExportOption.ItemsMeasurementUnits.

SpssClient.DocExportOption.ItemsMeasurementUnits. A string

specifying the units for page dimensions and margins:
“IExportOptions.MeasurementUnits.Inches”, “IExportOptions.MeasurementUnits.Millimeters”,
“IExportOptions.MeasurementUnits.Centimeters”, and
“IExportOptions.MeasurementUnits.PrintPoints” (1/72 inch). The default is
“IExportOptions.MeasurementUnits.Inches”.

Example

This example assumes that OutputDoc is an SpssOutputDoc object and exports all pivot tables
to an existing Excel worksheet beginning at a specified location.

OutputDoc = SpssClient.GetDesignatedOutputDoc ()
OutputDoc.SetOutputOptions (SpssClient .DocExportOption.ExcelSheetNames, "mysheet")
OutputDoc.SetOutputOptions (SpssClient .DocExportOption.ExcelStartingCell, "B6")
OutputDoc.SetOutputOptions (SpssClient .DocExportOption.ExcellLocationOptions,
"OverwriteAtCellRef")
OutputDoc.SetOutputOptions (SpssClient .DocExportOption.ExcelOperationOptions,
"ModifyWorksheet")
OutputItems = OutputDoc.GetOutputItems ()
for index in range (OutputItems.Size()) :
OutputItem = OutputItems.GetItemAt (index)
if OutputItem.GetType() == SpssClient.OutputItemType.PIVOT:
OutputItem.SetSelected (True)
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OutputDoc . ExportDocument (SpssClient.SpssExportSubset.SpssSelected,
" /output /myexport.xls",
SpssClient .DocExportFormat.SpssFormatXls)

SetPrintOptions Method

Sets the value of the specified print option.

Syntax

SpssOutputDoc.SetPrintOptions (printOption, value)

Parameters

The available settings for printOption are:

SpssClient.PrintOptions.LeftMargin Left margin
SpssClient.PrintOptions. TopMargin Top margin
SpssClient.PrintOptions.RightMargin Right margin
SpssClient.PrintOptions.BottomMargin Bottom margin
SpssClient.PrintOptions.Orientation Orientation (portrait or landscape)
SpssClient.PrintOptions.StartingPageNumber Starting page number
SpssClient.PrintOptions.SpaceBetweenltems Space between items
SpssClient.PrintOptions.PrintedChartSize Printed chart size (as is, full page, half
page, or quarter page)

The parameter value is a string. Following are the available settings:
®  All margin settings and Space Between Items are in units of points (1/72 inch).
m  For Orientation, 1 corresponds to Portrait and 2 corresponds to Landscape.

®  For Printed Chart Size, 0 corresponds to As Is, 1 to Full Page, 2 to Half Page, and 3 to
Quarter Page.

You can specify the print range using the PrintRange method. You print an output document using
the PrintOutputDoc method from the SpssOutputUI class.

SetPromptToSave Method

Sets the ‘prompt to save’ flag for this output document object.

Syntax

SpssOutputDoc.SetPromptToSave (promptToSave)

Parameters

promptToSave True to set the prompt to save flag, False otherwise.




56

Chapter 4

OutputDocslist Class

The outputDocsList class provides access to the list of open output documents. You obtain an
OutputDocsList object from the GetOutputDocuments method of the SpssClient class.

An OutputDocsList object is not an iterable Python object. In order to iterate over the items in
the list, use a for loop, as in:

for index in range (OutputDocsList.Size()):

For an example that uses the OutputDocsList class, see the examples for the SpssOutputDoc
class.

GetltemAt Method

Returns an SpssOutputDoc object representing the output document with the specified index.
The index corresponds to the order in which the output documents were opened, with the first
opened document having an index of 0.

Syntax

SpssOutputDoc=0OutputDocsList.GetItemAt (index)

Size Method

Returns the number of open output documents.

Syntax

OutputDocsList.Size ()

OutputitemlList Class

The outputItemList class provides access to the list of items in an open output document. You
obtain an OutputItemList object from the GetOutputltems method of an SpssOutputDoc
object.

An OutputItemList object is not an iterable Python object. In order to iterate over the items in
the list, use a for loop, as in:

for index in range (OutputItemList.Size()):

For an example that uses the OutputItemList class, see the example for the SpssOutputltem
class.
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GetltemAt Method

Returns an SpssOutputItem object corresponding to the output item with the specified index.
The index corresponds to the order of the items in the output document, starting with 0 for the
root item.

Syntax

SpssOutputItem=OutputItemList.GetItemAt (index)

Size Method

Returns the number of items in the associated output document.

Syntax

OutputItemList.Size()

SpssOutputUl Class

The SpssOutputUI class represents the Viewer window associated with an open output
document. You obtain an SpssOutputUI object from the GetOutputUI method of an
SpssOutputDoc object.

Example: Get the SpssOutputUl Object Associated with the Designated Output Document

import SpssClient

SpssClient.StartClient ()

DesignatedOutputDoc = SpssClient.GetDesignatedOutputDoc ()
OutputUI = DesignatedOutputDoc.GetOutputUI ()

B The variable OutputUI is an SpssOutputUI object for the Viewer window associated with
the designated output document.

GetHeight Method

Returns the height of the associated Viewer window in units of pixels.

Syntax

SpssOutputUI.GetHeight ()

GetLeft Method

Returns the horizontal screen position of the associated Viewer window’s upper left corner. The
result is in units of pixels.
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Syntax

SpssOutputUI.GetLeft ()

GetSplitterPosition Method

Returns the position of the splitter bar in the associated Viewer window. The result is in units of
pixels. The splitter bar determines how large the outline area is.

Syntax

SpssOutputUI.GetSplitterPosition ()

GetTitleText Method

Returns the title bar text of the associated Viewer window.

Syntax

SpssOutputUI.GetTitleText ()

GetTop Method

Returns the vertical screen position of the associated Viewer window’s upper left corner. The
result is in units of pixels.

Syntax

SpssOutputUI.GetTop ()

GetVisible Method

Indicates if the associated Viewer window is visible. The result is Boolean—T7rue if the Viewer
window 1is visible, False otherwise.

Syntax

SpssOutputUI.GetVisible ()

GetWidth Method

Returns the width of the associated Viewer window in units of pixels.

Syntax

SpssOutputUI.GetWidth ()
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GetWindowState Method

Returns the state of the associated Viewer window.

Syntax

SpssOutputUI.GetWindowState ()

Returns

SpssClient.SpssWindowStates.SpssMinimized Minimized

SpssClient.SpssWindowStates.SpssMaximized Maximized

SpssClient.SpssWindowStates.SpssNormal Normal
InvokeDialog Method

Invokes a dialog and returns the syntax generated from that dialog, if any.

Syntax

syntax = SpssOutputUI.InvokeDialog(menultemPath,desktopParent)

Parameters

menultemPath Menu or menu item with path of the dialog to
invoke. See below for detailed description.

desktopParent True specifies that the dialog is parented off the

desktop. False specifies that the dialog is parented
off an IBM® SPSS® Statistics window.

Note: For release 19.0.0.2 and higher, the bSync parameter (available in previous releases) is
deprecated. The InvokeDialog method always runs synchronously, meaning that the scripting
process waits until the dialog has been dismissed. Older scripts containing the bSync parameter
will continue to function in release 19.0.0.2 and higher, but the value of the parameter will be
ignored.

Specifying The Menu Item Path

The value of the menultemPath parameter is a string specifying the menu path to the desired
dialog—for example “analyze>survival>life tables”. The greater-than sign (>) is used to separate
a menu, its submenus and the menu item. The menu string must correspond exactly to the text on
the menus, submenus, and menu items, and is language specific.

PrintOutputDoc Method

Prints the document.
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Syntax
SpssOutputUI.PrintOutputDoc ()

You can specify the print range using the PrintRange method. You can specify print options
using the SetPrintOptions method.

SetHeight Method

Sets the height of the associated Viewer window.

Syntax

SpssOutputUI.SetHeight (height)

Parameters

| height An integer representing the height in pixels.

SetlLeft Method

Sets the horizontal screen position of the associated Viewer window’s upper left corner.

Syntax

SpssOutputUI.SetLeft (leftPosition)

Parameters

| leftPosition An integer representing the position in pixels.

SetSplitterPosition Method

Sets the position of the splitter bar in the associated Viewer window. The splitter bar determines
how large the outline area is.

Syntax

SpssOutputUI.SetSplitterPosition (position)

Parameters

position An integer representing the position in pixels.
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SetTop Method

Sets the vertical screen position of the associated Viewer window’s upper left corner.

Syntax

SpssOutputUI.SetTop (topPosition)

Parameters

| topPosition An integer representing the position in pixels.

SetVisible Method

Sets the visibility of the associated Viewer window.

Syntax

SpssOutputUI.SetVisible (isVisible)

Parameters

isVisible True to set the Viewer window as visible, False
otherwise.

SetWidth Method

Sets the width of the associated Viewer window.

Syntax

SpssOutputUI.SetWidth (width)

Parameters

| width An integer representing the width in pixels.

SetWindowState Method

Sets the state of the associated Viewer window.

Syntax

SpssOutputUI.SetWindowState (newState)
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Parameters

Set the value of newState to one of the following:

SpssClient.SpssWindowStates.SpssMinimized Minimized
SpssClient.SpssWindowStates.SpssMaximized Maximized
SpssClient.SpssWindowStates.SpssNormal Normal
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Syntax Documents and Syntax Editor
Windows

SpssSyntaxDoc Class

The SpssSyntaxDoc class represents an open syntax document.

Example: Obtaining the Designated Syntax Document

import SpssClient
SpssClient.StartClient ()
DesignatedSyntaxDoc = SpssClient.GetDesignatedSyntaxDoc ()

m  The variable DesignatedSyntaxDoc is an SpssSyntaxDoc object for the designated syntax
document.
Example: Obtaining the First Opened Syntax Document

import SpssClient

SpssClient.StartClient ()

SyntaxDocsList = SpssClient.GetSyntaxDocuments ()
FirstSyntaxDoc = SyntaxDocsList.GetItemAt (0)

B SpssClient.GetSyntaxDocuments () returns a SyntaxDocsList object, which
provides access to all open syntax documents.

B The GetItemAt method from the SyntaxDocsList class is used to get the syntax document
with index O (the first opened syntax document) from the list of open syntax documents. The
variable FirstSyntaxDoc is an SpssSyntaxDoc object for this syntax document.

Example: Create a New Syntax Document and Set it as the Designated One

import SpssClient
SpssClient.StartClient ()

NewSyntaxDoc = SpssClient.NewSyntaxDoc ()
NewSyntaxDoc.SetAsDesignatedSyntaxDoc ()

B The variable NewSyntaxDoc is an SpssSyntaxDoc object for the new syntax document.

CloseDocument Method

Closes the syntax document.

Syntax

SpssSyntaxDoc.CloseDocument ()
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GetDocumentPath Method

Returns the path and file name of the syntax file associated with this syntax document object, or
the empty string if the syntax document is not associated with a file.

Syntax

SpssSyntaxDoc.GetDocumentPath ()

GetMenuTable Method

Returns a MenuTableList object containing the list of available menu items for the syntax
document.

Syntax

MenuTableList = SpssSyntaxDoc.GetMenuTable ()

GetSyntax Method
Returns the syntax contained in the associated syntax document, as a unicode string.

Syntax

SpssSyntaxDoc.GetSyntax ()

GetSyntaxUIl Method

Returns an SpssSyntaxUI object representing the syntax window associated with the syntax
document.

Syntax

SpssSyntaxUI=SpssSyntaxDoc.GetSyntaxUI ()

IsDesignatedSyntaxDoc Method

Indicates if this syntax document is the designated one. The result is Boolean—T7rue if the syntax
document is the designated one, False otherwise.

m [f you have more than one open syntax document, command syntax is pasted into the
designated one.

Syntax

SpssSyntaxDoc.IsDesignatedSyntaxDoc ()
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IsEqualTo Method

Indicates if this syntax document object is the same object as a specified syntax document object.
The result is Boolean—True if the two objects are identical, False otherwise.

Syntax

SpssSyntaxDoc.IsEqualTo (syntaxDoc)

Parameters

| syntaxDoc An SpssSyntaxDoc object

IsModified Method

Indicates whether the syntax document has been modified. The result is Boolean—True if the
syntax document has been modified, False otherwise.

Syntax

SpssSyntaxDoc.IsModified ()

IsPromptToSave Method

Indicates if the ‘prompt to save’ flag is set for this syntax document object. The result is
Boolean—True if the ‘prompt to save’ flag has been set, False otherwise.

Syntax

SpssSyntaxDoc.IsPromptToSave ()

RunSyntax Method

Runs all of the syntax in the associated syntax document.

®  The submitted commands are executed synchronously with any other submitted command
syntax.

®  This method cannot be called within a script that is run from the SCRIPT command. It is also
not available when called from a Python program in distributed mode (Python programs make
use of the interface exposed by the Python spss module).

Syntax

SpssSyntaxDoc.RunSyntax ()
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SaveAs Method

Saves the syntax document to the specified file.

Syntax

SpssSyntaxDoc.SaveAs (fileName)

SetAsDesignatedSyntaxDoc Method

Sets this syntax document as the designated syntax document.

m [f you have more than one open syntax document, command syntax is pasted into the
designated one.

Syntax

SpssSyntaxDoc.SetAsDesignatedSyntaxDoc ()

SetModified Method

Sets the modified status of the syntax document.

Syntax

SpssSyntaxDoc.SetModified (modified)

Parameters

| modified True to set the status to modified, False otherwise.

SetPromptToSave Method

Sets the ‘prompt to save’ flag for this syntax document object.

Syntax

SpssSyntaxDoc.SetPromptToSave (promptToSave)

Parameters

| promptToSave True to set the prompt to save flag, False otherwise.

SetSyntax Method

Specifies the content of the associated syntax document and replaces any existing content.
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Syntax

SpssSyntaxDoc.SetSyntax (syntax)

Parameters

syntax A string specifying the syntax. You can include line
breaks using the escape sequence “\n”, and you can
use a triple-quoted string as shown in the example.

Example

SpssSyntaxDoc.SetSyntax (r"""DESCRIPTIVES
VARIABLES=salary salbegin jobtime prevexp
/STATISTICS=MEAN STDDEV MIN MAX.""")

m  Using a triple-quoted string—as in this example—allows you to specify a block of syntax
commands on multiple lines. You can use either triple single quotes or triple double quotes,
but you must use the same type (single or double) on both sides of the specified string.

®  Notice that the triple-quoted expression is prefixed with the letter r. The r prefix to a string
specifies Python’s raw mode. In raw mode, Python treats all backslashes in the string as the
backslash character and not as the start of an escape sequence.

SyntaxDocslList Class

The SyntaxDocsList class provides access to the list of open syntax documents. You obtain a
SyntaxDocsList object from the GetSyntaxDocuments method of the SpssClient class.

A syntaxDocsList object is not an iterable Python object. In order to iterate over the items in
the list, use a for loop, as in:

for index in range (SyntaxDocsList.Size()):

For an example that uses the SyntaxDocsList class, see the examples for the SpssSyntaxDoc
class.

GetltemAt Method

Returns an SpssSyntaxDoc object representing the syntax document with the specified index.
The index corresponds to the order in which the syntax documents were opened, with the first
opened document having an index of 0.

Syntax

SpssSyntaxDoc=SyntaxDocsList.GetItemAt (index)

Size Method

Returns the number of open syntax documents.
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Syntax

SyntaxDocsList.Size ()

SpssSyntaxUl Class
The SpssSyntaxUTI class represents the Syntax Editor window associated with an open

syntax document. You obtain an SpssSyntaxUI object from the GetSyntaxUI method of an
SpssSyntaxDoc object.

Example: Get the SpssSyntaxUl Object Associated with the Designated Syntax Document

import SpssClient

SpssClient.StartClient ()

DesignatedSyntaxDoc = SpssClient.GetDesignatedSyntaxDoc ()
SyntaxUI = DesignatedSyntaxDoc.GetSyntaxUI ()

®  The variable SyntaxUl is an SpssSyntaxUI object for the Syntax Editor window associated
with the designated syntax document.

GetHeight Method

Returns the height of the associated Syntax Editor window in units of pixels.

Syntax

SpssSyntaxUI.GetHeight ()

GetLeft Method

Returns the horizontal screen position of the associated Syntax Editor window’s upper left corner.
The result is in units of pixels.

Syntax

SpssSyntaxUI.GetLeft ()

GetTitleText Method

Returns the title bar text of the associated Syntax Editor window.

Syntax

SpssSyntaxUI.GetTitleText ()
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GetTop Method

Returns the vertical screen position of the associated Syntax Editor window’s upper left corner.
The result is in units of pixels.

Syntax

SpssSyntaxUI.GetTop ()

GetVisible Method

Indicates if the associated Syntax Editor window is visible. The result is Boolean—True if the
Syntax Editor window is visible, False otherwise.

Syntax

SpssSyntaxUI.GetVisible ()

GetWidth Method

Returns the width of the associated Syntax Editor window in units of pixels.

Syntax

SpssSyntaxUI.GetWidth ()

GetWindowState Method

Returns the state of the associated Syntax Editor window.

Syntax

SpssSyntaxUI.GetWindowState ()

Returns

SpssClient.SpssWindowStates.SpssMinimized Minimized

SpssClient.SpssWindowStates.SpssMaximized Maximized

SpssClient.SpssWindowStates.SpssNormal Normal
InvokeDialog Method

Invokes a dialog and returns the syntax generated from that dialog, if any.
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Syntax

syntax = SpssSyntaxUI.InvokeDialog(menultemPath, desktopParent)

Parameters

menultemPath Menu or menu item with path of the dialog to
invoke. See below for detailed description.

desktopParent True specifies that the dialog is parented off the

desktop. False specifies that the dialog is parented
off an IBM® SPSS® Statistics window.

Note: For release 19.0.0.2 and higher, the bSync parameter (available in previous releases) is
deprecated. The InvokeDialog method always runs synchronously, meaning that the scripting
process waits until the dialog has been dismissed. Older scripts containing the bSync parameter
will continue to function in release 19.0.0.2 and higher, but the value of the parameter will be
ignored.

Specifying The Menu Item Path

The value of the menultemPath parameter is a string specifying the menu path to the desired
dialog—for example “analyze>survival>life tables”. The greater-than sign (>) is used to separate
a menu, its submenus and the menu item. The menu string must correspond exactly to the text on
the menus, submenus, and menu items, and is language specific.

PrintSyntaxDoc Method

Prints the document.

Syntax

SpssSyntaxUI.PrintSyntaxDoc ()

SetHeight Method

Sets the height of the associated Syntax Editor window.

Syntax

SpssSyntaxUI.SetHeight (height)

Parameters

height An integer representing the height in pixels.
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Setleft Method

Sets the horizontal screen position of the associated Syntax Editor window’s upper left corner.

Syntax

SpssSyntaxUI.SetLeft (leftPosition)

Parameters

| leftPosition An integer representing the position in pixels.

SetTop Method

Sets the vertical screen position of the associated Syntax Editor window’s upper left corner.

Syntax

SpssSyntaxUI.SetTop (topPosition)

Parameters

| topPosition An integer representing the position in pixels.

SetVisible Method

Sets the visibility of the associated Syntax Editor window.

Syntax

SpssSyntaxUI.SetVisible (isVisible)

Parameters
isVisible True to set the Syntax Editor window as visible,
False otherwise.
SetWidth Method

Sets the width of the associated Syntax Editor window.

Syntax

SpssSyntaxUI.SetWidth (width)
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Parameters

| width An integer representing the width in pixels.

SetWindowState Method

Set the state of the associated Syntax Editor window.
Syntax
SpssSyntaxUI.SetWindowState (newState)

Parameters

Set the value of newState to one of the following:

SpssClient.SpssWindowStates.SpssMinimized Minimized

SpssClient.SpssWindowStates.SpssMaximized Maximized

SpssClient.SpssWindowStates.SpssNormal Normal
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SpssOutputitem Class

The SpssOutputItem class represents any item in an output document. You get an
SpssOutputItem object from an OutputItemList object.

Example: Exporting the First Pivot Table to HTML

import SpssClient
SpssClient.StartClient ()

OutputDoc = SpssClient.GetDesignatedOutputDoc ()
OutputItemList = OutputDoc.GetOutputItems ()

for index in range (OutputItemList.Size()):
OutputItem = OutputItemList.GetItemAt (index)
if OutputItem.GetType() == SpssClient.OutputItemType.PIVOT:
OutputItem.ExportToDocument ("/myfiles/mypivot™",
SpssClient.DocExportFormat.SpssFormatHtml)
break
SpssClient.StopClient ()

B SpssClient.GetDesignatedOutputDoc () gets an SpssOutputDoc object for the
designated output document. In this example, the variable OutputDoc is an SpssOutputDoc
object.

B The GetOutputItems method of an SpssOutputDoc object returns an OutputItemList
object. In this example, the variable OutputltemList is an Output ItemList object.

m  The for loop iterates through all of the objects in the OutputItemList object—one object
for each item in the output document. On each iteration of the loop, the variable Outputitem
is an SpssOutputItem object.

B The GetType method from the SpssOutputItem class returns the type of the output item.
Pivot tables have an output item type of SpssClient.OutputItemType.PIVOT.

B You export the pivot table using the Export ToDocument method from the SpssOutputItem
class.

m The break statement terminates the loop if a pivot table is found.

ConvertToStdTable Method

This method is obsolete for release 20 and higher. Note: Lightweight tables created in IBM®
SPSS® Statistics release 19 automatically have full support for pivoting and editing in release
20 or later.

ExportToDocument Method

Exports this output item in the specified document format.
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®  This method cannot be used for exporting chart items. To export a chart item, use the
ExportToImage method.
m  See SetOutputOptions for options available when exporting to Word, Excel, or PowerPoint.
Syntax
SpssOutputItem.ExportToDocument (fileName, format)
Parameters
Set the value of format to one of the following:
SpssClient.DocExportFormat.SpssFormatHtml Html
SpssClient.DocExportFormat.SpssFormatDoc Word
SpssClient.DocExportFormat.SpssFormatXls Excel
SpssClient.DocExportFormat.SpssFormatText Text
SpssClient.DocExportFormat.SpssFormatPdf PDF
SpssClient.DocExportFormat.SpssFormatPpt PowerPoint
ExportTolmage Method
Exports this output item in the specified image format.
®  This method can only be used for exporting charts, trees, and Model Viewer items. To export
other item types, use the ExportToDocument method.
®  When used for a Model Viewer item, the method exports the view displayed in the Viewer.
You can export all views using the ExportAllViews Method.
Syntax
SpssOutputItem.ExportToImage (fileName, format)
Parameters
Set the value of format to one of the following:
SpssClient.ChartExportFormat.bmp Windows bitmap
SpssClient.ChartExportFormat.emf Enhanced metafile
SpssClient.ChartExportFormat.eps Enhanced postscript
SpssClient.ChartExportFormat.jpg JPG file
SpssClient.ChartExportFormat.png PNG file
SpssClient.ChartExportFormat.tiff Tagged image file
GetAlignment Method

Returns the alignment for this output item.
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Syntax

SpssOutputItem.GetAlignment ()

Returns
SpssClient.OutputltemAlignment.Left Left
SpssClient.OutputltemAlignment.Center Center
SpssClient.OutputltemAlignment.Right Right

When testing for a particular alignment type with the return value from GetAlignment, you can
also use the following integer type codes: 0 (Left), 1 (Center), 2 (Right). For example:

if SpssOutputItem.GetAlignment () == 0:

GetDescription Method

Returns the name of this output item as it appears in the outline pane of the Viewer.

Syntax

SpssOutputItem.GetDescription ()

GetHeight Method

Returns the height of this output item in units of points (1/72 inch).

®  This method is not available for header items or root items.

Syntax

SpssOutputItem.GetHeight ()

GetPageBreak Method

Indicates whether a page break is set before this item. The result is Boolean—True if the page
break is set, False otherwise.

Syntax

SpssOutputItem.GetPageBreak ()

GetParentitem Method

Returns an SpssOutputItem object representing the parent item of this output item.
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Syntax

SpssOutputItem.GetParentItem()

GetProcedureName Method

Returns the name of the IBM® SPSS® Statistics procedure that generated this output item. The
value is the OMS command identifier associated with the procedure.

Syntax

SpssOutputItem.GetProcedureName ()

GetSpecificType Method
Returns an object of a specific output type, such as a pivot table or header item. You will need to
call this method before using methods specific to that type of output item. For example, before
you can use the methods available for a pivot table, you must call Get SpecificType on the

associated SpssOutputItem object. The set of output types is listed in the description of the
GetType method.

Syntax
object=SpssOutputItem.GetSpecificType ()

For an example of using the Get SpecificType method, see SpssPivotTable Class.

GetSubType Method

Returns the OMS (Output Management System) sub type identifier, if any, of this output item.

Syntax

SpssOutputItem.GetSubType ()

GetTreeLevel Method

Returns the level of this item within the hierarchy of the output tree. For instance, the root item
is at level 0, and header items beneath the root are at level 1.

Syntax

SpssOutputItem.GetTreelLevel ()
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GetType Method

Returns the type associated with this output item.

Syntax

SpssOutputItem.GetType ()

Returns

Type Type Code
SpssClient.Outputltem Type. UNKNOWN
SpssClient.OutputltemType. CHART
SpssClient.OutputltemType. HEAD
SpssClient.OutputltemType.LOG
SpssClient.OutputltemType. NOTE
SpssClient.OutputltemType. PIVOT
SpssClient.OutputltemType.ROOT
SpssClient.OutputltemType. TEXT
SpssClient.Outputltem Type. WARNING
SpssClient.OutputltemType. TITLE
SpssClient.OutputltemType. PAGETITLE 1
SpssClient.OutputltemType. TREEMODEL 13
SpssClient.OutputltemType. GENERIC 14
SpssClient.OutputltemType. MODEL 15
SpssClient.OutputltemType. LIGHTNOTE 18
SpssClient.OutputltemType. LIGHTPIVOT 19
SpssClient.OutputltemType. LIGHTWARNING 20
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When testing for a particular output type with the return value from GetType, you can use the
integer type code or the textual specification of the type. For an example of using the Get Type
method, see SpssPivotTable Class.

Notes

m  Standard charts, graphboard charts, and R graphics all have the type
SpssClient.OutputItemType.CHART. To distinguish between these chart types, use the
SPSSSubtype method on the associated SpssChartItem object.

m  Objects of type SpssClient. OutputltemType.ROOT (the root object in an output document) or
SpssClient. Outputltem Type. HEAD are SpssHeaderItem objects.

B Objects of type SpssClient. OutputltemType. TREEMODEL are SpssChartItem objects.

B The object types SpssClient.Outputltem Type. LIGHTNOTE,
SpssClient. Outputltem Type. LIGHTPIVOT, and SpssClient. Outputltem Type. LIGHTWARNING
are obsolete for release 20 and higher. Lightweight Notes items, lightweight Pivot
Table items, and lightweight Warnings items created in release 19 will have the output
types SpssClient. OutputltemType. NOTE, SpssClient. OutputltemType.PIVOT and
SpssClient. Outputltem Type. WARNING respectively when accessed in release 20 or higher.
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GetTypeString Method
Returns the type string of this output item. The returned value is not translated.

Syntax

SpssOutputItem.GetTypeString ()

Returns

Chart

Log

Notes

Table

Text
Warning
Title
PageTitle
TreeDiagram
Model

Notes

m  Standard charts, graphboard charts, and R graphics all have the type string ‘Chart’. To
distinguish between these chart types, use the SPSSSubtype method on the associated
SpssChartItem object.

B Lightweight Notes items, lightweight Pivot Table items, and lightweight Warnings items
created in release 19 will have the type strings Notes, Table, and Warning respectively when
accessed in release 20 or higher.

GetWidth Method

Returns the width of this output item in units of points (1/72 inch).

m  This method is not available for header items or root items.

Syntax

SpssOutputItem.GetWidth ()

GetXML Method

Returns the XML representation for an SpssChartItem or SpssModelItem, as a Unicode
string.

Syntax

SpssOutputItem.GetXML ()
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You can set the XML for a chart item using the SetXML method from the SpssChartItem
class. You can set the XML for a Model Viewer item using the SetXML method from the
SpssModelItem class.

IsCurrentltem Method

Indicates if this output item is the current item—as indicated by a red arrow next to the item in the
outline pane. The result is Boolean—True if the item is the current item, False otherwise.

Syntax

SpssOutputItem.IsCurrentItem()

IsEditable Method

Indicates whether this output item can be edited. The result is Boolean—T7rue if the item can
be edited, False otherwise.

Syntax

SpssOutputItem.IsEditable ()

IsEqualTo Method

Indicates if this output item object is the same object as a specified output item object. The result
is Boolean—True if the two objects are identical, False otherwise.

Syntax

SpssOutputItem.IsEqualTo (outputItem)

Parameters

| outputltem An SpssOutputItem object

IsSelected Method

Indicates whether the current output item is selected. The result is Boolean—T7rue if the item is
currently selected, False otherwise. Use the SetSelected method to select an item.

Syntax

SpssOutputItem.IsSelected ()
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IsVisible Method

Indicates if this output item is visible. The result is Boolean—True if the item is visible, False
if it is hidden.

Syntax

SpssOutputItem.IsVisible ()

SetAlignment Method

Sets the alignment for this output item.
Syntax
SpssOutputItem.SetAlignment (alignment)

Parameters

Set the value of alignment to one of the following:

SpssClient.OutputltemAlignment.Left Left

SpssClient.OutputltemAlignment.Center Center

SpssClient.OutputltemAlignment.Right Right

SetCurrentltem Method
Sets the item as the current item—as indicated by a red arrow next to the item in the outline pane.

Syntax

SpssOutputItem.SetCurrentItem()

SetDescription Method
Sets the name of this output item. This is the name that is displayed in the outline pane of the
Viewer. The value can be specified as plain text, HTML, or rich text format. For HTML, embed

markup in a <htmI></htmI> block. For rich text format, specify the string as a raw string to
avoid unintentional escape sequences.

Syntax

SpssOutputItem.SetDescription (desc)
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SetHeight Method

Sets the height of this output item in units of points (1/72 inch).

®  This method is not available for pivot tables, header items, or the root item.

Syntax

SpssOutputItem. SetHeight (height)

SetPageBreak Method

Sets or clears a page break before this item.

Syntax

SpssOutputItem.SetPageBreak (pageBreak)

Parameters

| pageBreak True to set a page break, False to clear a page break.

SetProcedureName Method

Sets the procedure name associated with this output item. The argument is a string and is not
translated.

Syntax

SpssOutputItem.SetProcedureName (procName)

SetSelected Method

Specifies whether the current output item is set as selected. You can use the IsSelected method to
determine if a given item is already selected.

Syntax

SpssOutputItem.SetSelected(selected)

Parameters

selected True to set this item as selected, False to set it as
not selected.
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SetSubType Method

Sets the OMS (Output Management System) sub-type identifier of this output item.

Syntax

SpssOutputItem.SetSubType (subType)

Parameters

| subType A string

SetTreelevel Method

Sets the level of this item within the hierarchy of the output tree. For instance, the root item is at
level 0, and header items beneath the root are at level 1.

Syntax

SpssOutputItem.SetTreeLevel (level)

Parameters

| level An integer

SetVisible Method

Specifies whether this output item is visible.

Syntax

SpssOutputItem.SetVisible (visible)

Parameters
visible True to set the item as visible, False to set it as
hidden.
SetWidth Method

Sets the width of this output item in units of points (1/72 inch).

®  This method is not available for pivot tables, header items, or the root item.

Syntax

SpssOutputItem.SetWidth (width)
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SpssChartltem Class

The SpssChartItem class represents a chart item in an output document. You get an
SpssChartItem object from the collection of output items in an output document.

Example: Getting Chart Items

import SpssClient
SpssClient.StartClient ()

OutputDoc = SpssClient.GetDesignatedOutputDoc ()
OutputItems = OutputDoc.GetOutputItems ()

for index in range (OutputItems.Size()):
OutputItem = OutputItems.GetItemAt (index)
if OutputItem.GetType () == SpssClient.OutputItemType.CHART:
ChartItem = OutputItem.GetSpecificType ()

Chart items have an output item type of SpssClient.OutputItemType.CHART.

Once an output item has been identified as a chart item, you get an SpssChartItem object
by calling the Get SpecificType method on the output item object. In this example,
Chartltem is an SpssChartItem object.

SetXML Method

Sets the chart XML from a UTF-8 (Unicode Transformation Format, 8 bit) string.

Syntax
SpssChartItem.SetXML (xml)

You can get the XML for a chart item using the GetXML method from the SpssOutputItem
class. You can also use chart XML (OXML) created by the 0MS command as the source for
SetXML. To do so, extract the visualization element from the OXML, decode the resulting
string to “UTF-8” (e.g., with the Python decode string method), and use the decoded string as
the argument to SetXML.

SPSSSubtype Method

Returns a string specifying the type of chart.

Syntax

SpssChartItem.SPSSSubtype ()

Returns

CHART Standard chart
GRAPHBOARD Graphboard chart
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IMAGE R graphic

TREEMODEL Tree model

SpssModelltem Class

The SpssModelItem class represents a Model Viewer item in an output document. You get an
SpssModelItem object from the collection of output items in an output document.

Example: Getting Model Viewer Items

import SpssClient
SpssClient.StartClient ()

OutputDoc = SpssClient.GetDesignatedOutputDoc ()
OutputItems = OutputDoc.GetOutputItems ()

for index in range (OutputItems.Size()):
OutputItem = OutputItems.GetItemAt (index)
if OutputItem.GetType () == SpssClient.OutputItemType.MODEL:
ModelItem = OutputItem.GetSpecificType ()

B Model Viewer items have an output item type of SpssClient.OutputItemType .MODEL.

B Once an output item has been identified as a Model Viewer item, you get an SpssModelItem
object by calling the GetSpecificType method on the output item object. In this example,
Modelltem is an SpssModelItem object.

ExportAllViews Method

Exports all views of this Model Viewer item in the specified image format.

Syntax

SpssModelItem.ExportAllViews (filePrefix, format)

Parameters

The argument filePrefix is the full path and file name prefix for the files containing the exported
views. Each view is exported to a separate file.

On Windows, it is recommended to use raw strings for file paths, or replace backslashes
with forward slashes (IBM® SPSS® Statistics accepts a forward slash for any backslash
in a file specification). Raw strings are specified by prefacing the string with r, as in
r’c:\examples\mydata.sav’. In raw mode, Python treats all backslashes in the string as the
backslash character and not as the start of an escape sequence.

Set the value of format to one of the following:

SpssClient.ChartExportFormat.bmp Windows bitmap
SpssClient.ChartExportFormat.emf Enhanced metafile
SpssClient.ChartExportFormat.eps Enhanced postscript
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SpssClient.ChartExportFormat.jpg JPG file
SpssClient.ChartExportFormat.png PNG file
SpssClient.ChartExportFormat.tiff Tagged image file

You can export the view displayed in the Viewer using the ExportTolmage Method.

SetXML Method

Sets the XML for the Model Viewer item from a UTF-8 (Unicode Transformation Format, 8
bit) string.

Syntax
SpssModelItem.SetXML (xml)

You can get the XML for a Model Viewer item using the GetXML method from the
SpssOutputItem class. You can also use model XML (OXML) created by the oMS command
as the source for SetXML.

SpssHeaderltem Class

The SpssHeaderItem class represents a header item in an output document. You get an
SpssHeaderItem object from the collection of output items in an output document.

Example: Getting Header Items

import SpssClient
SpssClient.StartClient ()

OutputDoc = SpssClient.GetDesignatedOutputDoc ()
OutputItems = OutputDoc.GetOutputItems ()

for index in range (OutputItems.Size()):
OutputItem = OutputlItems.GetItemAt (index)
if OutputItem.GetType () == SpssClient.OutputItemType.HEAD:
HeaderItem = OutputItem.GetSpecificType()
m  Header items have an output item type of SpssClient.OutputItemType .HEAD.

B Once an output item has been identified as a header item, you get an SpssHeaderItem
object by calling the GetSpecificType method on the output item object. In this example,
Headerltem is an SpssHeaderItem object.

Note: The root item is an SpssHeaderItem object.

GetChildCount Method

Returns the child item count for this header item.
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Syntax

SpssHeaderItem.GetChildCount ()

GetChildltem Method

Returns an SpssOutputItem object for the child item at the specified index. Index values
start from O.

Syntax

SpssOutputItem=SpssHeaderItem.GetChildItem (index)

InsertChildltem Method

Inserts a child item—at the specified index—under the current header item in the associated output
document. Index values start from 0 and are relative to the current header item.

m  Use this method to insert header items, text items, and title items created with the
CreateHeaderItem, CreateTextItem, and CreateTitleItem methods from the
SpssOutputDoc class.

Syntax

SpssHeaderItem.InsertChildItem(item, index)

Parameters
item An SpssOutputItem object
index The index position of the new child item in the

header item’s child list. Index values start from 0.
To append an item to the end of the child list, use
an index value equal to the current child count.

Example: Appending a new header item containing a child text item

This example appends a new header item under the root item. A text item is added under the
new header item.
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import SpssClient

SpssClient.StartClient ()

doc = SpssClient.GetDesignatedOutputDoc ()

itemlist = doc.GetOutputItems ()

# Get the root header item

root = itemlist.GetItemAt (0) .GetSpecificType ()

# Create a new header item

newHeader = doc.CreateHeaderItem("New header")

# Append the new header to the root item
root.InsertChildItem (newHeader, root.GetChildCount ())
# Get the new header item

newHeaderItem = root.GetChildItem(root.GetChildCount ()-1) .GetSpecificType ()
# Create a new text item

newText = doc.CreateTextItem("New text")

# Append the new text item to the new header item
newHeaderItem.InsertChildItem (newText, 0)
SpssClient.StopClient ()

Example: Inserting a text item under an existing header item

This example inserts a text item at index position 1, under a header item identified by the
description string “Demo”.

import SpssClient
SpssClient.StartClient ()
doc = SpssClient.GetDesignatedOutputDoc ()
OutputItems = doc.GetOutputItems ()
for index in range (OutputItems.Size()):
OutputItem = OutputItems.GetItemAt (index)
if OutputlItem.GetType () == SpssClient.OutputItemType.HEAD \
and OutputItem.GetDescription() == "Demo":
HeaderItem = OutputItem.GetSpecificType ()
newText = doc.CreateTextItem("My inserted text")
HeaderItem.InsertChildItem (newText,1)
SpssClient.StopClient ()

IsExpanded Method

Indicates whether the associated header item is expanded. The result is Boolean—T7rue if the
header item is expanded, False otherwise.

Syntax

SpssHeaderItem. IsExpanded ()

RemoveChildltem Method

Removes the child item at the specified index. Index values start from 0.

Syntax

SpssHeaderItem.RemoveChildItem (index)



88

Chapter 6

SetExpanded Method

Sets whether the associated header item is expanded.

Syntax

SpssHeaderItem. SetExpanded (expand)

Parameters

| expand True to expand the item, False to collapse the item.

SpssLogltem Class

The SpssLogItem class represents a log item in an output document. You get an SpssLogItem
object from the collection of output items in an output document.

Example: Getting Log Items

import SpssClient
SpssClient.StartClient ()

OutputDoc = SpssClient.GetDesignatedOutputDoc ()
OutputItems = OutputDoc.GetOutputItems ()

for index in range (OutputItems.Size()):
OutputItem = OutputItems.GetItemAt (index)
if OutputItem.GetType() == SpssClient.OutputItemType.LOG:
LogItem = OutputItem.GetSpecificType ()

m  Log items have an output item type of SpssClient.OutputItemType .LOG.

®  Once an output item has been identified as a log item, you get an SpssLogItem object by
calling the Get SpecificType method on the output item object. In this example, Logltem is
an SpssLogItem object.

Append Method

Appends the specified text to the contents of the associated log output item.

Syntax

SpssLogItem.Append (text)

GetTextContents Method

Returns the contents of the associated log output item. The value is returned as plain text.
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Syntax

SpssLogItem.GetTextContents ()

SetTextContents Method

Sets the contents of the associated log output item, replacing any existing content. The value

can be specified as plain text, HTML, or rich text format. For HTML, embed markup in a
<htmI></htmI> block. For rich text format, specify the string as a raw string to avoid unintentional
escape sequences. For multiple lines, use "\n" to specify line breaks.

Syntax

SpssLogIltem.SetTextContents (contents)

SpssTextitem Class

The SpssTextItem class represents a text item in an output document. You get an
SpssTextItem object from the collection of output items in an output document.

Example: Getting Text ltems

import SpssClient
SpssClient.StartClient ()

OutputDoc = SpssClient.GetDesignatedOutputDoc ()
OutputItems = OutputDoc.GetOutputItems ()

for index in range (OutputItems.Size()):
OutputItem = OutputItems.GetItemAt (index)

if OutputItem.GetType () == SpssClient.OutputItemType.TEXT:
TextItem = OutputItem.GetSpecificType ()

Text items have an output item type of SpssClient.OutputItemType . TEXT.

Once an output item has been identified as a text item, you get an SpssTextItem object by
calling the GetSpecificType method on the output item object. In this example, Textltem
is an SpssTextItem object.

GetTextContents Method

Returns the contents of the associated text output item. The value is returned as plain text.

Syntax

SpssTextItem.GetTextContents ()
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SetTextContents Method

Sets the contents of the associated text output item, replacing any existing content. The value
can be specified as plain text, HTML, or rich text format. For HTML, embed markup in a
<htmI></htmI> block. For rich text format, specify the string as a raw string to avoid unintentional
escape sequences. For multiple lines, use "\n" to specify line breaks.

Syntax

SpssTextItem.SetTextContents (contents)

SpssTitleltem Class

The SpssTitlelItem class represents a title item in an output document. You get an
SpssTitleItem object from the collection of output items in an output document.

Example: Getting Title ltems

import SpssClient
SpssClient.StartClient ()

OutputDoc = SpssClient.GetDesignatedOutputDoc ()
OutputItems = OutputDoc.GetOutputItems ()

for index in range (OutputItems.Size()):
OutputItem = OutputItems.GetItemAt (index)

if OutputItem.GetType() == SpssClient.OutputItemType.TITLE:
TitleItem = OutputItem.GetSpecificType ()

m Title items have an output item type of SpssClient.OutputItemType.TITLE.

®  Once an output item has been identified as a title item, you get an SpssTitleItem object by
calling the GetSpecificType method on the output item object. In this example, Titleltem
is an SpssTitleItem object.

GetTextContents Method

Returns the contents of the associated title output item. The value is returned as plain text.

Syntax

SpssTitleltem.GetTextContents ()

SetTextContents Method

Sets the contents of the associated title output item, replacing any existing content. The value
can be specified as plain text, HTML, or rich text format. For HTML, embed markup in a
<htmI></htmI> block. For rich text format, specify the string as a raw string to avoid unintentional
escape sequences.
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Syntax

SpssTitleItem.SetTextContents (contents)
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Menus

MenuTablelList Class

The MenuTableList class provides access to the list of available menu items for a data, output,
or syntax document. You obtain a MenuTableList object from the GetMenuTable method of
an SpssDataDoc, SpssOutputDoc, or SpssSyntaxDoc object.

A MenuTableList object is not an iterable Python object. In order to iterate over the items in the
list, use a for loop, as in:

for index in range (MenuTableList.Size()) :

For an example that uses the MenuTableList class, see the example for the SpssMenultem class.

GetltemAt Method

Returns an SpssMenuItem object representing the menu item with the specified index.

Syntax

SpssMenultem=MenuTablelList.GetItemAt (index)

Size Method

Returns the number of items in a MenuTableList object.

Syntax

MenuTablelList.Size ()

SpssMenultem Class

The SpssMenulItem class represents a menu item in a data, output, or syntax document. You get
an SpssMenultem object from the Get ItemAt method of a MenuTableList object.

Example: Getting a List of Menu Items

import SpssClient
SpssClient.StartClient ()

OutputDoc = SpssClient.GetDesignatedOutputDoc ()
MenuTableList = OutputDoc.GetMenuTable ()
strMenulItemList = []
for i in range (MenuTableList.Size()):
item = MenuTableList.GetItemAt (i)
strMenultemList.append (item.GetTextContents())

© Copyright IBM Corporation 1989, 2012. 92
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GetTextContents Method

Returns the name of the menu item (as a string) associated with an SpssMenuItem object.

Syntax

SpssMenultem.GetTextContents ()
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The scripting facility allows you to do most of the things you can do in the pivot table editor,
through use of the SpssPivotTable class. There are two general approaches for working with
pivot tables from scripting:

m  Select groups of cells (results or labels) or other elements (such as footnotes) and apply
methods that modify the entire selection. For example, you can change the foreground color

for selected cells.

B Access a subset of the pivot table, such as its data cells or row labels, and modify a particular
element in the subset. For example, you can access the data cells and call a method to set the

foreground color for a specified cell.

Generally speaking, if you want to modify a number of elements in the same manner, the first

approach is faster.

Areas of a Pivot Table

(Red labels indicate accessible objects.)

Title

Layer Labels

Corner Labels

Column Labels®

Row Lahn‘elsIJ

Data Cells

Caption

a.
b > Footnotes

Available Objects

The spssPivotTable object provides access to the following objects:

© Copyright IBM Corporation 1989, 2012.

SpssDataCells Provides access to the data cells.

SpssLabels Provides access to the row and column labels.
SpssFootnotes Provides access to all of the table’s footnotes.
SpssLayerLabels Provides access to labels in any layer dimensions.
SpssPivotMgr Provides access to row, column, and layer dimensions.

SpssDimension Provides access to the properties of a particular dimension.

94



95

Pivot Tables

Compatibility with previous releases

Legacy tables (referred to as full-featured tables in release 19) are tables that are fully compatible
with IBM® SPSS® Statistics releases prior to 20. Legacy tables may render slowly and are only
recommended if compatibility with releases prior to 20 is required. You can specify that tables
are rendered as legacy tables by calling the SpssClient.SetPreference method with the
TableRender option set to "full". For more information, see the topic SetPreference Method
in Chapter 2 on p. 21. You can also specify legacy table creation with the command syntax SET
TABLERENDER = FULL, or from the Pivot Tables tab of the Options dialog (Edit>Options) in
SPSS Statistics.

m  Tables, other than legacy tables, created in SPSS Statistics release 20 or later and lightweight
tables in output documents that are modified in release 20 or later (but created in release 19)
cannot be viewed or accessed through scripting in releases prior to 19.0.0.2. Such tables are
viewable and accessible through scripting in release 19.0.0.2, where they are rendered as
lightweight tables; however, they may not render the same as in release 20 or later.

m Lightweight tables created in SPSS Statistics release 19 automatically have full support for
pivoting and editing in release 20 or later.

SpssPivotTable Class

The SpssPivotTable class allows you to operate on the table as a whole as well as providing
access to objects for working with the footnotes, data cells, row or column labels, and layer
labels associated with the table. Pivot tables are output items and are accessed from the list of
output items associated with an output document.

Example: Getting Pivot Tables

import SpssClient
SpssClient.StartClient ()

OutputDoc = SpssClient.GetDesignatedOutputDoc ()
OutputItems = OutputDoc.GetOutputItems ()

for index in range (OutputItems.Size()):
OutputItem = OutputItems.GetItemAt (index)
if OutputItem.GetType () == SpssClient.OutputItemType.PIVOT:
PivotTable = OutputItem.GetSpecificType ()

m  Pivot tables have an output item type of SpssClient.OutputItemType.PIVOT.

®  Once an output item has been identified as a pivot table, you get an SpssPivotTable object
by calling the Get SpecificType method on the output item object. In this example,
PivotTable is an SpssPivotTable object.
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Example: Getting the First Selected Pivot Table

import SpssClient
SpssClient.StartClient ()

OutputDoc = SpssClient.GetDesignatedOutputDoc ()
OutputItems = OutputDoc.GetOutputItems ()

for index in range (OutputItems.Size()):
OutputItem = OutputItems.GetItemAt (index)
if OutputItem.GetType() == SpssClient.OutputItemType.PIVOT \
and OutputItem.IsSelected() :
PivotTable = OutputItem.GetSpecificType ()

Example: Getting the First Pivot Table Labeled “Statistics”
import SpssClient
SpssClient.StartClient ()

OutputDoc = SpssClient.GetDesignatedOutputDoc ()
OutputItems = OutputDoc.GetOutputItems ()

for index in range (OutputItems.Size()):
OutputItem = OutputItems.GetItemAt (index)
if OutputItem.GetType() == SpssClient.OutputItemType.PIVOT \

and OutputItem.GetDescription() == "Statistics":
PivotTable = OutputItem.GetSpecificType ()

Autofit Method

Recalculates the size of all cells in the entire table to accommodate label lengths or the lengths of
both labels and data values.

m  To specify how the cells are to be recalculated (labels only or labels and
data), use the SetPreference method from the SpssClient class and specify
SpssClient.PreferenceOptions.ColumnWidth as the option

Syntax

SpssPivotTable.Autofit ()

ClearSelection Method
Deselects all selected output items or pivot table elements.

m  All Select methods add the current item(s)/element(s) to what has been previously selected.
Always clear selections before you start selecting output items or table elements.

Syntax

SpssPivotTable.ClearSelection ()
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ColumnLabelArray Method

Returns an SpssLabels object representing the column labels.

Syntax

SpssLabels=SpssPivotTable.ColumnLabelArray ()

DataCellArray Method

Returns an SpssDataCells object representing the data cells of the pivot table.

Syntax

SpssDataCells=SpssPivotTable.DataCellArray ()

DisplayTableByRows Method
Specifies whether to display the table n rows at a time, where #n is set with the

SetRowsToDisplayRowCount method. The argument is Boolean—True to display the table
n rows at a time, False otherwise.

Note: This method is only available for legacy tables. For more information, see the
topic Compatibility with previous releases on p. 95.

Syntax

SpssPivotTable.DisplayTableByRows (boolean)

FootnotesArray Method

Returns an SpssFootnotes object representing the table footnotes.

Syntax

SpssFootnotes=SpssPivotTable.FootnotesArray ()

GetCaptionText Method

Returns the caption text for the current table.

Syntax

SpssPivotTable.GetCaptionText ()
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GetFootnoteMarkersPosition Method
Gets the current position—superscript or subscript—for footnote markers for the pivot table.
Syntax

SpssPivotTable.GetFootnoteMarkersPosition ()

The returned value is one of:

SpssClient.SpssFootnoteMarkerTypes.SpssFtSuperscript Superscript
SpssClient.SpssFootnoteMarkerTypes.SpssFtSubscript Subscript

GetFootnoteMarkersStyle Method
Gets the current style—alphabetic or numeric—for footnote markers for the pivot table.
Syntax

SpssPivotTable.GetFootnoteMarkersStyle ()

The returned value is one of:

SpssClient.SpssFootnoteMarkerTypes.SpssFtAlphabetic Alphabetic
SpssClient.SpssFootnoteMarkerTypes.SpssFtNumeric Numeric
GetHeight Method

Returns the height of the pivot table. The unit is the point (1/72 inch).

Syntax

SpssPivotTable.GetHeight ()

GetRotateColumnLabels Method

Indicates if category labels closest to the data (that is, categories of the column dimension with the
largest index) are rotated. The result is Boolean.

Syntax

SpssPivotTable.GetRotateColumnLabels ()
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Returns
True The column labels closest to the data are displayed
vertically
False The column labels closest to the data are displayed
horizontally

GetRotateRowlabels Method

Indicates if the labels of all but the last row dimension (that is, the row dimension with the largest

index) are rotated. The result is Boolean.

Syntax

SpssPivotTable.GetRotateRowLabels ()

Returns

True The outer row labels are displayed vertically

False The outer row labels are displayed horizontally
GetTitleText Method

Returns the text of the title for the table.

Syntax

SpssPivotTable.GetTitleText ()

GetUpdateScreen Method

Returns whether changes in the pivot table are refreshed immediately. The result is Boolean—T7rue
if changes are refreshed immediately, False otherwise.

B By default, changes are refreshed immediately. Use the SetUpdateScreen method to
specify that changes are not to be refreshed immediately.

Syntax

SpssPivotTable.GetUpdateScreen ()

GetVarNamesDisplay Method

This method returns the setting for how variable names are displayed in the pivot table: as variable

names, as variable labels, or both.
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Syntax

SpssPivotTable.GetVarNamesDisplay ()

Returns

SpssClient. VarNamesDisplay.Names Names
SpssClient. VarNamesDisplay.Labels Labels
SpssClient.VarNamesDisplay.Both Names and labels

GetVarValuesDisplay Method

This method gets the setting for how variable values are displayed in the pivot table: as values, as
value labels, or both.

Syntax

SpssPivotTable.GetVarValuesDisplay ()

Returns

SpssClient.VarValuesDisplay. Values Values
SpssClient. VarValuesDisplay.Labels Labels
SpssClient.VarValuesDisplay.Both Values and labels

GetWidowOrphanLines Method

Returns the number of allowable widow/orphan lines when pivot tables are printed.
®  Widow lines are the last few lines of a paragraph printed at the top of the next page; orphan
lines are the first few lines of a paragraph printed at the bottom of the previous page.

Syntax

SpssPivotTable.GetWidowOrphanLines ()

GetWidth Method

Returns the width of the pivot table. The unit is the point (1/72 inch).

Syntax

SpssPivotTable.GetWidth ()
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Group Method
Groups selected category labels or group labels, creates a grouping level, and inserts a grouping
label.
B The selection must be category or group labels.

m  After the execution of this method, the inserted grouping label is selected and has the default
label of Group Label.

m [f anew group level is inserted, labels on the same and lower levels are demoted one level.
(For column labels, the row index increases by one; for row labels, the column index
increases by one.)

Syntax

SpssPivotTable.Group ()

Example
This example assumes that PivotTable is an SpssPivotTable object, selects category column
labels Clerical and Custodial, and groups them under the label of Non-Managerial.
ColumnLabels = PivotTable.ColumnLabelArray ()
#Select the category column labels Clerical and Custodial:
PivotTable.ClearSelection ()
for i in range (ColumnLabels.GetNumRows ()) :

for j in range (ColumnLabels.GetNumColumns () ) :

if ColumnLabels.GetValueAt(i,j) in ["Clerical", "Custodial"]:
ColumnLabels.SelectLabelAt (i, j)

#Group the categories and assign a group label:
PivotTable.Group ()
for i in range (ColumnLabels.GetNumRows ()) :

for j in range (ColumnLabels.GetNumColumns()) :

if ColumnLabels.GetValueAt (i,j)=="Group Label":
ColumnLabels.SetValueAt (i, j, "Non-Managerial")

HideCaption Method

Hides the caption of the current table.

Syntax

SpssPivotTable.HideCaption ()

HideFootnote Method

Hides the selected footnotes or all the footnotes referenced by the selected cell.

Syntax

SpssPivotTable.HideFootnote ()
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HideTitle Method

Hides the title of a pivot table.

Syntax

SpssPivotTable.HideTitle ()

InsertFootnote Method

Inserts a footnote to the selected data or label cell.
m [f multiple data cells or labels are selected, the footnote is attached to the first selected item.

m  To set a footnote for corner text, first set the corner text with the
SpssPivotTable.SetCornerText method.

Syntax

SpssPivotTable.InsertFootnote (string)

Parameters

| string Text of the footnote

IsDisplayTableByRows Method

Indicates whether the table is being displayed a fixed number of rows at a time. The result is
Boolean—True if the table is being displayed a fixed number of rows at a time, False otherwise.
Use the DisplayTableByRows method to change the setting.

Note: The feature to display a table a fixed number of rows at a time is only available for legacy
tables. For more information, see the topic Compatibility with previous releases on p. 95.

Syntax

SpssPivotTable.IsDisplayTableByRows ()

LayerLabelArray Method

Returns an SpssLayerLabels object representing all layer labels.

Syntax

SpssLayerLabels=SpssPivotTable.LayerLabelArray ()



103

Pivot Tables

NavigateToFirstRow Method

Displays the first block of rows of the table when displaying the table a fixed number of rows at a
time. Use the DisplayTableByRows method to display the table a fixed number of rows at a time.

Note: This method is only available for legacy tables. For more information, see the
topic Compatibility with previous releases on p. 95.

Syntax

SpssPivotTable.NavigateToFirstRow ()

NavigateTolLastRow Method

Displays the last block of rows of the table when displaying the table a fixed number of rows at a
time. Use the DisplayTableByRows method to display the table a fixed number of rows at a time.

Note: This method is only available for legacy tables. For more information, see the
topic Compatibility with previous releases on p. 95.

Syntax

SpssPivotTable.NavigateToLastRow ()

NavigateToNextRows Method

Displays the next block of rows of the table when displaying the table a fixed number of rows at a
time. Use the DisplayTableByRows method to display the table a fixed number of rows at a time.

Note: This method is only available for legacy tables. For more information, see the
topic Compatibility with previous releases on p. 95.

Syntax

SpssPivotTable.NavigateToNextRows ()

NavigateToPreviousRows Method

Displays the previous block of rows of the table when displaying the table a fixed number of
rows at a time. Use the DisplayTableByRows method to display the table a fixed number of
rows at a time.

Note: This method is only available for legacy tables. For more information, see the
topic Compatibility with previous releases on p. 95.

Syntax

SpssPivotTable.NavigateToPreviousRows ()
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NumericFormat Method
Sets the display format for numeric values in the selected cells of the current table.

SpssPivotTable.NumericFormat (format,decimal)

Parameters
format The string description of the format.
decimal Number of decimal places.

For a listing of the format types, see Appendix C on p. 204.

PivotManager Method

Returns an SpssPivotMgr object, providing access to the Pivot Manager.

Syntax

SpssPivotMgr=SpssPivotTable.PivotManager ()

RowlabelArray Method

Returns an SpssLabels object representing the row labels.

Syntax

SpssLabels=SpssPivotTable.RowLabelArray ()

SelectAllFootnotes Method

Selects all footnotes in the pivot table, in addition to what has already been selected.

Syntax

SpssPivotTable.SelectAllFootnotes ()

SelectCaption Method

Selects the caption of the pivot table, in addition to all previously selected elements.

Syntax

SpssPivotTable.SelectCaption ()
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SelectCorner Method

Selects the corner of the pivot table, in addition to all previously selected elements.

Syntax

SpssPivotTable.SelectCorner ()

SelectTable Method

Selects all the elements of a pivot table for modification.

Syntax

SpssPivotTable.SelectTable ()

SelectTableBody Method

Selects the body of the pivot table (labels and data cells) for modification.

Syntax

SpssPivotTable.SelectTableBody ()

SelectTitle Method

Selects the title of the pivot table for modification.

Syntax

SpssPivotTable.SelectTitle ()

SetBackgroundColor Method

Sets the background color of the selected element(s) in the current pivot table.

Syntax

SpssPivotTable.SetBackgroundColor (color)

Parameters

| color | Integer representation of the color

For information on setting color values, see Appendix A on p. 201.
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SetBottomMargin Method

Sets the bottom margin of the selected cells in the current pivot table.

Syntax

SpssPivotTable.SetBottomMargin (margin)

Parameters
margin An integer. The unit is the point (1/72 inch). The
maximum value is 36.
SetCaptionText Method

Sets the caption text for the current table.

Syntax

SpssPivotTable.SetCaptionText (string)

Parameters

| string Caption text

SetCornerText Method

Sets the corner text.

Syntax

SpssPivotTable.SetCornerText (string)

Parameters

| string Corner text

SetDataCellWidths Method

Sets the width of all data cells of the current table.

Syntax

SpssPivotTable.SetDataCellWidths (width)



107

Parameters

Pivot Tables

| width An integer. The unit is the point (1/72 inch). |

SetFootnoteMarkers Method

Sets the style of footnote markers for the entire table.

Syntax

SpssPivotTable.SetFootnoteMarkers (type)

Parameters

Set the value of type to one of the following:

SpssClient.SpssFootnoteMarkerTypes.SpssFtSuperscript Superscript
SpssClient.SpssFootnoteMarkerTypes.SpssFtSubscript Subscript
SpssClient.SpssFootnoteMarkerTypes.SpssFtAlphabetic Alphabetic
SpssClient.SpssFootnoteMarkerTypes.SpssFtNumeric Numeric

SetForegroundColor Method

This method is deprecated in release 17.0. Use the SetTextColor method instead.

SetHAlign Method

Sets the horizontal alignment of the selected elements in the current table.

Syntax

SpssPivotTable.SetHAlign (alignment)

Parameters

Set the value of alignment to one of the following:

SpssClient.SpssHAlignTypes.SpssHAILeft Left
SpssClient.SpssHAlignTypes.SpssHAIRight Right
SpssClient.SpssHAlignTypes.SpssHAICenter Center
SpssClient.SpssHAlignTypes.SpssHAIMixed Mixed
SpssClient.SpssHAlignTypes.SpssHAIDecimal Decimal

SetHDecDigits Method

Sets the number of decimal digits for the selected cells of the pivot table.
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Syntax

SpssPivotTable.SetHDecDigits (number)

Parameters

| number Number of decimal digits

SetLeftMargin Method

Sets the left margin of the selected cells in the pivot table.

Syntax

SpssPivotTable.SetLeftMargin (margin)

Parameters

margin An integer. The unit is the point (1/72 inch). The
maximum value is 36.

SetRightMargin Method

Sets the right margin for the selected cells in the pivot table.

Syntax

SpssPivotTable.SetRightMargin (margin)

Parameters

margin An integer. The unit is the point (1/72 inch). The
maximum value is 36.

SetRotateColumnlLabels Method

Rotates the category labels closest to the data (that is, categories of the column dimension with the
largest index).

Syntax

SpssPivotTable.SetRotateColumnLabels (boolean)
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Parameters
True The column labels closest to the data are displayed
vertically
False The column labels closest to the data are displayed
horizontally

SetRotateRowlLabels Method

Rotates the labels of all but the last row dimension (that is, the row dimension with the largest
index).

Syntax

SpssPivotTable.SetRotateRowLabels (boolean)

Parameters

True The outer row labels are displayed vertically

False The outer row labels are displayed
horizontally

SetRowsToDisplayRowCount Method
Sets the number of rows to be displayed at a time for the current pivot table. Note that you must

also call the DisplayTableByRows method with an argument of True to specify that the table is to
be displayed a fixed number of rows at a time.

Note: This method is only available for legacy tables. For more information, see the
topic Compatibility with previous releases on p. 95.

Syntax

SpssPivotTable.SetRowsToDisplayRowCount (number)

Parameters

number An integer specifying the number of rows to display
at a time.

SetRowsToDisplayTolerance Method

Sets the widow/orphan tolerance to be used when displaying the table a fixed number of rows at a
time (as set by the DisplayTableByRows method). The default is 0.

m [f a break between blocks of rows leaves widow rows equal to or less than the specified
tolerance, then the break point is shifted up in the table to display those rows in the next block.
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m [f a break between blocks of rows leaves orphan rows equal to or less than the specified
tolerance, then the break point is shifted down in the table to display those rows in the
previous block.

m [f a break between blocks of rows leaves both widow and orphan rows equal to or less than
the specified tolerance, then the break point is shifted up in the table to display the widow
rows in the next block.

Note: This method is only available for legacy tables. For more information, see the
topic Compatibility with previous releases on p. 95.

Syntax

SpssPivotTable.SetRowsToDisplayTolerance (number)

Parameters

| number An integer specifying the widow/orphan tolerance.

SetTableLook Method

Applies a predefined table look.

Syntax

SpssPivotTable.SetTableLook (filename)

Parameters

| filename | Path to the TableLook (.stt) file

On Windows, it is recommended to use raw strings for file paths, or replace backslashes
with forward slashes (IBM® SPSS® Statistics accepts a forward slash for any backslash
in a file specification). Raw strings are specified by prefacing the string with r, as in
r’c:\examples\mydata.sav’. In raw mode, Python treats all backslashes in the string as the
backslash character and not as the start of an escape sequence.

SetTextColor Method

Sets the color of the text in the selected cells of the pivot table.

Syntax

SpssPivotTable.SetTextColor (color)

Parameters

| color Integer representation of the color
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For information on setting color values, see Appendix A on p. 201.

SetTextFont Method

Sets the font of the text in the selected cells of the pivot table.

Syntax

SpssPivotTable.SetTextFont (fontname)

Parameters
fontname Name of the font family, as a string. Available fonts
are accessed from Format>Table Properties in the
pivot table editor.
SetTextHidden Method

Sets the hidden effect of the text in the selected cells of the pivot table.

Syntax

SpssPivotTable.SetTextHidden (boolean)

Parameters

True Hidden

False Not hidden
SetTextSize Method

Sets the font size of the text in the selected cells of the pivot table.

Syntax

SpssPivotTable.SetTextSize (size)

Parameters

| size Size in points (integer)

SetTextStyle Method

Sets the bold or italic style of the text in the selected cells of the pivot table.
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Syntax

SpssPivotTable.SetTextStyle (style)

Parameters

Set the value of style to one of the following:

SpssClient.SpssTextStyleTypes.SpssTSRegular Regular
SpssClient.SpssTextStyleTypes.SpssTSltalic Italic
SpssClient.SpssTextStyleTypes.SpssTSBold Bold
SpssClient.SpssTextStyleTypes.SpssTSBoldltalic Bold Italic

SetTextUnderlined Method

Sets the underlined effect of the text in the selected cells of the pivot table.

Syntax

SpssPivotTable.SetTextUnderlined (boolean)

Parameters

True Underlined

False Not underlined
SetTitleText Method

Sets the text of the title for the pivot table.

Syntax

SpssPivotTable.SetTitleText (title)

Parameters

| title Text of the title

SetTopMargin Method

Sets the top margin of the selected cells in the pivot table.

Syntax

SpssPivotTable.SetTopMargin (margin)
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Parameters

margin An integer. The unit is the point (1/72 inch). The
maximum value is 36.

SetUpdateScreen Method

Sets whether changes in the pivot table are refreshed immediately. The argument is Boolean—T7True
if changes are refreshed immediately, False otherwise.

m By default, changes are refreshed immediately.

Syntax

SpssPivotTable.SetUpdateScreen (boolean)

Example

This example assumes that PivotTable is an SpssPivotTable object, and stops refreshing while
looping through the row labels and making changes.

PivotTable.SetUpdateScreen (False)
rowlabels = PivotTable.RowLabelArray ()
for i in range (rowlabels.GetNumRows ()) :
for j in range (rowlabels.GetNumColumns()) :
if rowlabels.GetValueAt (i, j)=="Female":
rowlabels.SetValueAt (i, ], "Women")
PivotTable.SetUpdateScreen (True)

Note: Setting the immediate refresh off (parameter set to False) prevents flashing when you make
changes to individual cells in a loop (in internal scripting), but it may also prevent you assessing

the results immediately. A better way is to avoid making changes cell by cell but select the cells
and change the selection using a method on the pivot table object. This is also a faster way.

SetVAlign Method

Sets the vertical alignment of the text in the selected cells of the pivot table.

Syntax

SpssPivotTable.SetVAlign (alignment)

Parameters

Set the value of alignment to one of the following:

SpssClient.SpssVAlignTypes.SpssVAlTop Top
SpssClient.SpssVAlignTypes.SpssVAlBottom Bottom
SpssClient.SpssVAlignTypes.SpssVAlCenter Center
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SetVarNamesDisplay Method

This method sets how variable names are displayed in the pivot table: as variable names, as
variable labels, or both.

Syntax

SpssPivotTable.SetVarNamesDisplay (display)

Parameters

Set the value of display to one of the following:

SpssClient. VarNamesDisplay.Names Names
SpssClient. VarNamesDisplay.Labels Labels
SpssClient.VarNamesDisplay.Both Names and labels

SetVarValuesDisplay Method

This method sets how variable values are displayed in the pivot table: as values, as value labels, or
both.

Syntax

SpssPivotTable.SetVarValuesDisplay (display)

Parameters

Set the value of display to one of the following:

SpssClient. VarValuesDisplay. Values Values
SpssClient. VarValuesDisplay.Labels Labels
SpssClient. VarValuesDisplay.Both Values and labels

SetWidowOrphanlLines Method

Sets the number of allowable widow/orphan lines when pivot tables are printed.

m  Widow lines are the last few lines of a paragraph printed at the top of the next page; orphan
lines are the first few lines of a paragraph printed at the bottom of the previous page.

Syntax

SpssPivotTable.SetWidowOrphanLines (number)



115

Pivot Tables
Parameters
| number Line limit (integer). The valid range is 1 to 100.
ShowAll Method

Shows all labels and data.

Syntax

SpssPivotTable.ShowAll ()

ShowAllFootnotes Method

Shows all footnotes associated with the pivot table.

Syntax

SpssPivotTable.ShowAllFootnotes ()

ShowCaption Method

Shows the caption of the pivot table.

Syntax

SpssPivotTable.ShowCaption ()

ShowFootnote Method

Shows the hidden footnote(s) referenced by the selected label(s), data cell(s) or title.

m Ignored if no hidden footnote is referenced.

Syntax

SpssPivotTable.ShowFootnote ()
ShowTitle Method
Shows the title of the pivot table.

Syntax

SpssPivotTable.ShowTitle ()



116

Chapter 8
Ungroup Method

Deletes selected group labels and ungroups the category or group labels in the deleted group(s).

m If all group labels on one level are removed, labels on the lower levels are promoted one
level. (For column labels, the row index increases by one; for row labels, the column index
increases by one.)

m  Selection must be group labels.

Syntax

SpssPivotTable.Ungroup ()

SpssDataCells Class

The SpssDataCells object provides access to the data cells of a pivot table. In most pivot tables,
the data cells contain the results of the statistical analysis. You need to use the SpssDataCells
object if you want to highlight significant values in the output (for example, making bold all
correlation coefficients that are greater than a specified value) or to retrieve specific statistics from
the output (for example, the means and standard deviations of each group or variable).

The SpssDataCells object represents a 2-dimensional array of the data cells you can view in
a pivot table. If there are no layer dimensions, all of the cells will be accessible; otherwise, the
table must be pivoted in order to fully access the data currently in layer dimensions.

The data cells array has the same number of rows as the row labels array and the same number
of columns as the column labels array. That is to say, row indexes for the row labels and column
indexes for the column labels respectively correspond to the row and column indexes for the
data cells.

Note: If the current table has been set to display blocks of rows—either using SET ROWSBREAK
or by checking Display the table as blocks of rows on the Pivot Tables tab of the Options

dialog box—then methods of the SpssDataCells class that access specific cells, such as
GetTextColorAt, will only have access to the first block of rows. Exceptions to this behavior
are the GetvValueAt, SetValueAt, and GetUnformattedvalueAt methods, which can access
all rows of the pivot table, regardless of whether the table is displayed in blocks of rows.

You get an SpssDataCells object from the DataCellArray method of an SpssPivotTable
object, as in:

SpssDataCells = SpssPivotTable.DataCellArray ()

Example: Modifying Specific Cells

This example assumes that PivotTable is an SpssPivotTable object, and sets the background
color to red for all data cells containing a value below 0.01.
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DataCells = PivotTable.DataCellArray ()
for i in range (DataCells.GetNumRows () ) :
for j in range (DataCells.GetNumColumns()) :
try:
val = float (DataCells.GetValueAt (i,j))
if wval < 0.01:

DataCells.SetBackgroundColorAt (i,3j,255)
except:
pass

®  The value returned from GetvalueAt is a unicode string. If the value is a representation of a
numeric value, it is converted to a float, otherwise an exception is raised and control passes

to the except clause. Since the except clause only contains a pass statement, execution
continues.

GetBackgroundColorAt Method

Returns the background color of the specified data cell.

Syntax

SpssDataCells.GetBackgroundColorAt (row, column)

Parameters
row Row index
column Column index
Returns

The color is returned as an integer. For more information, see the topic Setting Color Values
in Appendix A on p. 201.

GetBottomMarginAt Method

Returns the bottom margin of the specified data cell. The unit is the point (1/72 inch).

Syntax

SpssDataCells.GetBottomMarginAt (row, column)

Parameters
row Row index
column Column index

GetForegroundColorAt Method

This method is deprecated in release 17.0. Use the GetTextColorAt method instead.
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GetHAlignAt Method

Returns the horizontal alignment of the specified data cell.

Syntax

SpssDataCells.GetHAlignAt (row, column)

Parameters

row Row index

column Column index
Returns

SpssClient.SpssHAlignTypes.SpssHAILeft Left
SpssClient.SpssHAlignTypes.SpssHAIRight Right
SpssClient.SpssHAlignTypes.SpssHAICenter Center
SpssClient.SpssHAlignTypes.SpssHAIMixed Mixed
SpssClient.SpssHAlignTypes.SpssHAIDecimal Decimal

GetHDecDigitsAt Method

Returns the number of decimal digits allowed in decimal alignment for the specified data cell.

Syntax

SpssDataCells.GetHDecDigitsAt (row, column)

Parameters

row Row index

column Column index
GetLeftMarginAt Method

Returns the left margin of the specified data cell. The unit is the point (1/72 inch).

Syntax

SpssDataCells.GetLeftMarginAt (row, column)

Parameters
row Row index
column Column index
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GetNumColumns Method

Returns the number of columns in the SpssDataCells object.

Syntax

SpssDataCells.GetNumColumns ()

GetNumericFormatAt method
Returns the display format for the numeric value in the specified data cell.

SpssDataCells.GetNumericFormatAt (row, column)

Parameters
row Row index
column Column index

Return Value
The string description of the format. For a listing of the format types, see Appendix C on p. 204.

Note: To obtain detailed format information for custom currency formats use the
GetNumericFormatAtEx method.

GetNumericFormatAtEx method

Returns an SpssNumericFormat object from which you can obtain detailed formatting
information for a specified data cell, such as the prefix, separator, and suffix for a cell with
a custom currency format.

SpssNumericFormat=SpssDataCells.GetNumericFormatAtEx (row, column)

Parameters
row Row index
column Column index

The SpssNumericFormat object supports two methods. GetFormatListSize indicates the
number of format items available for retrieval—3 if the current cell has a custom currency format,
and 1 otherwise. GetFormatStringAt retrieves a specified format item. It takes an integer (zero
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based) that specifies the index of the format item to retrieve. The following table describes the
values retrieved by GetFormatStringAt.

GetFormatString At(0) If the list size is 3 then the returned value is the prefix of the value in
the associated data cell; otherwise the returned value is the same as
that returned from the GetNumericFormatAt method.

GetFormatStringAt(1) Returns the separator character of the format for the value in the
associated data cell. Only available when the list size is greater than 1.

GetFormatString At(2) Returns the suffix of the value in the associated data cell. Only
available when the list size is greater than 2.

GetNumRows Method

Returns the number of rows in the SpssDataCells object.

Syntax

SpssDataCells.GetNumRows ()

GetReferredFootnotesAt Method

Returns an SpssFootnotes object, which allows access to all the footnotes referred to by the
specified data cell.

m  The footnotes array is a subset of the Footnotes object you can get from the pivot table.
You can manipulate the subset using the same properties and methods, but the index of a
footnote in this array is in no way related to the index of the same footnote when accessed
from the pivot table.

Syntax

SpssFootnotes=SpssDataCells.GetReferredFootnotesAt (row, column)

Parameters

row Row index
column Column index
Example

This example gets the footnotes associated with the cell in the first row and first column of the
data cell array and sets the text color and text style of the first footnote (index value 0) to red and
bold respectively. It assumes that PivotTable is an SpssPivotTable object.

DataCells PivotTable.DataCellArray ()

Footnotes = DataCells.GetReferredFootnotesAt (0,0)
Footnotes.SetTextStyleAt (0, SpssClient.SpssTextStyleTypes.SpssTSBold)
Footnotes.SetTextColorAt (0,255)
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Returns the right margin of the specified data cell. The unit is the point (1/72 inch).

Syntax

SpssDataCells.GetRightMarginAt (row, column)

Pivot Tables

Parameters

row Row index

column Column index
GetTextColorAt Method

Returns the color of the text in the specified data cell.

Syntax

SpssDataCells.GetTextColorAt (row, column)

Parameters
row Row index
column Column index
Returns

The color is returned as an integer. For more information, see the topic Setting Color Values

in Appendix A on p. 201.

GetTextFontAt Method

Returns the font of the text in the specified data cell, as a string.

Syntax

SpssDataCells.GetTextFontAt (row, column)

Parameters
row Row index
column Column index
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GetTextHiddenAt Method
Returns the hidden effect of the text in the specified data cell. The result is Boolean.
Syntax

SpssDataCells.GetTextHiddenAt (row, column)

Parameters
row Row index
column Column index
Returns
True Hidden
False Not hidden
GetTextSizeAt Method

Returns the font size of the text in the specified data cell.

Syntax

SpssDataCells.GetTextSizeAt (row, column)

Parameters

row Row index

column Column index
GetTextStyleAt Method

Returns the bold or italic style of the text in the specified data cell.

Syntax

SpssDataCells.GetTextStyleAt (row, column)

Parameters

row Row index

column Column index
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Returns
SpssClient.SpssTextStyleTypes.SpssTSRegular Regular
SpssClient.SpssTextStyleTypes.SpssTSltalic Italic
SpssClient.SpssTextStyleTypes.SpssTSBold Bold
SpssClient.SpssTextStyleTypes.SpssTSBoldlItalic Bold Italic

GetTextUnderlinedAt Method

Returns the underlined effect of the text in the specified data cell. The result is Boolean.

Syntax

SpssDataCells.GetTextUnderlinedAt (row, column)

Parameters

row Row index

column Column index

Returns

True Underlined

False Not underlined
GetTopMarginAt Method

Returns the top margin of the specified data cell.

Syntax

The unit is the point (1/72 inch).

SpssDataCells.GetTopMarginAt (row, column)

Parameters
row Row index
column Column index

GetVAlignAt Method

Returns the vertical alignment of the specified data cell.

Syntax

SpssDataCells.GetVAlignAt (row, column)
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Parameters

row Row index

column Column index

Returns

SpssClient.SpssVAlignTypes.SpssVAlTop Top
SpssClient.SpssVAlignTypes.SpssVAlBottom Bottom
SpssClient.SpssVAlignTypes.SpssVAlCenter Center

GetUnformattedValueAt Method

Returns the unformatted value of the specified data cell, as a unicode string. This allows you to
obtain all available digits for a cell that contains a numeric value. In addition, any footnote
markers associated with the cell are removed in the returned value. To obtain the value of the cell,
formatted in the same manner as it appears in the pivot table, use the GetValueAt method.

Syntax

SpssDataCells.GetUnformattedvalueAt (row, column)

Parameters

row Row index

column Column index
GetValueAt Method

Returns the value of the specified data cell, as a unicode string, and formatted in the same
manner as it appears in the pivot table. To obtain an unformatted version of the cell, use the
GetUnformatted ValueAt method.

Syntax

SpssDataCells.GetValueAt (row, column, includeFootnotes)

Parameters

row Row index

column Column index

includeFootnotes Optional Boolean specifying whether to include
footnote markers in the returned value. The default
is True.
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HideFootnotesAt Method
Hides all footnotes referenced by the specified data cell.
Syntax
SpssDataCells.HideFootnotesAt (row, column)
Parameters
row Row index
column Column index
InsertNewFootnoteAt Method
Inserts a new footnote for the specified data cell.
Syntax
index=SpssDataCells.InsertNewFootnoteAt (row, column, string)
Parameters
row Row index
column Column index
string New footnote text
Return Value
index Integer (to be used to insert the footnote in other

cells if it is a shared footnote)

Example

This example inserts a footnote for the cell in the first row and first column of the data cell array
and inserts a shared footnote for each cell whose value is identical to this one. It assumes that
PivotTable is an SpssPivotTable object.

DataCells = PivotTable.DataCellArray ()
val = DataCells.GetUnformattedvValueAt (0,0)
index = DataCells.InsertNewFootnoteAt (0,0,"My footnote")
for 1 in range (DataCells.GetNumRows () ) :
for j in range (DataCells.GetNumColumns () ) :
if DataCells.GetUnformattedvValueAt(i,j) == val:
DataCells.InsertSharedFootnoteAt (i, j, index)



126

Chapter 8

InsertSharedFootnoteAt Method

Inserts a shared footnote (a footnote that applies to multiple data cells and/or labels) for the
specified data cell.

Syntax

SpssDataCells.InsertSharedFootnoteAt (row, column, index)

Parameters

row Row index.

column Column index

index The index (in the footnote array) of the desired
footnote.

Note: When inserting a shared footnote along with a new footnote created with

the InsertNewFootnoteAt method, you can use the index value returned by the
InsertNewFootnoteAt method. For more information, see the topic InsertNewFootnoteAt
Method on p. 125.

ReSizeColumn Method

Resets the width of the current column.

Syntax

SpssDataCells.ReSizeColumn (column, width)

Parameters

column Column index

width An integer. The unit is the point (1/72 inch).
SelectCellAt Method

Selects the specified data cell, in addition to previously selected elements.

Syntax

SpssDataCells.SelectCellAt (row, column)

Parameters

row Row index

column Column index
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SelectReferredFootnotesAt Method

Selects all the footnotes referenced by the specified data cell, in addition to previously selected
elements.

Syntax

SpssDataCells.SelectReferredFootnotesAt (row, column)

Parameters
row Row index
column Column index

Note: This method is not available for legacy tables. To modify footnotes associated with
a particular data cell in a legacy table, use the GetReferredFootnotesAt method to get an
SpssFootnotes object containing the footnotes. You can then use the methods of the
SpssFootnotes object to make the desired modifications.

SetBackgroundColorAt Method
Sets the background color of the specified data cell.
Syntax

SpssDataCells.SetBackgroundColorAt (row, column, color)

Parameters

row Row index

column Column index

color Integer representation of the color

For information on setting color values, see Appendix A on p. 201.

SetBottomMarginAt Method

Sets the bottom margin of the specified data cell.
Syntax

SpssDataCells.SetBottomMarginAt (row, column, margin)
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Parameters

row Row index

column Column index

margin An integer. The unit is the point (1/72 inch). The

maximum value is 36.

SetForegroundColorAt Method

This method is deprecated in release 17.0. Use the SetTextColorAt method instead.

SetHAlignAt Method

Sets the horizontal alignment of the specified data cell.

Syntax

SpssDataCells.SetHAlignAt (row, column, alignment)

Parameters
row Row index
column Column index

Set the value of alignment to one of the following:

SpssClient.SpssHAlignTypes.SpssHAILeft Left
SpssClient.SpssHAlignTypes.SpssHAIRight Right
SpssClient.SpssHAlignTypes.SpssHAICenter Center
SpssClient.SpssHAlignTypes.SpssHAIMixed Mixed
SpssClient.SpssHAlignTypes.SpssHAIDecimal Decimal

SetHDecDigitsAt Method

Sets the number of decimal digits for the specified data cell.

Syntax

SpssDataCells.SetHDecDigitsAt (row, column, number)

Parameters

row Row index

column Column index

number Number of decimal digits
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SetlLeftMarginAt Method
Sets the left margin of the specified data cell.
Syntax
SpssDataCells.SetLeftMarginAt (row, column, margin)
Parameters
row Row index
column Column index
margin An integer. The unit is the point (1/72 inch). The
maximum value is 36.

SetNumericFormatAt method
Sets the display format for the numeric value in the current cell.

SpssDataCells.SetNumericFormatAt (row, column, format)

Parameters

row Row index

column Column index

format The string description of the format.

For a listing of the format types, see Appendix C on p. 204.

SetNumericFormatAtWithDecimal method
Sets the display format for the numeric value in the current cell.

SpssDataCells.SetNumericFormatAtWithDecimal (row, column, format,decimal)

Parameters

row Row index

column Column index

format The string description of the format.
decimal Number of decimal places. The default is 0.

For a listing of the format types, see Appendix C on p. 204.

SetRightMarginAt Method

Sets the right margin of the specified data cell.
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Syntax

SpssDataCells.SetRightMarginAt (row, column, margin)

Parameters

row Row index

column Column index

margin An integer. The unit is the point (1/72 inch). The

maximum value is 36.

SetTextColorAt Method

Sets the color of the text in the specified data cell.

Syntax

SpssDataCells.SetTextColorAt (row, column, color)

Parameters

row Row index

column Column index

color Integer representation of the color

For information on setting color values, see Appendix A on p. 201.
SetTextFontAt Method

Sets the font of the text in the specified data cell.

Syntax

SpssDataCells.SetTextFontAt (row, column, fontname)

Parameters

row Row index

column Column index

fontname Name of the font family, as a string. Available fonts
are accessed from Format>Cell Properties in the
pivot table editor.

SetTextHiddenAt Method

Sets the hidden effect of the text in the specified data cell.
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Syntax

SpssDataCells.SetTextHiddenAt (row, column, boolean)

Parameters

row Row index

column Column index

boolean True for hidden, False for not hidden
SetTextSizeAt Method

Sets the font size of the text in the specified data cell.

Syntax

SpssDataCells.SetTextSizeAt (row, column, size)

Parameters

row Row index

column Column index

size Size in points (integer)
SetTextStyleAt Method

Sets the bold or italic style of the text in the specified data cell.

Syntax

SpssDataCells.SetTextStyleAt (row, column, style)

Parameters
row Row index
column Column index

Set the value of style to one of the following:

SpssClient.SpssTextStyleTypes.SpssTSRegular Regular
SpssClient.SpssTextStyleTypes.SpssTSltalic Italic
SpssClient.SpssTextStyleTypes.SpssTSBold Bold
SpssClient.SpssTextStyleTypes.SpssTSBoldltalic Bold Italic
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SetTextUnderlinedAt Method

Sets the underlined effect of the text in the specified data cell.

Syntax

SpssDataCells.SetTextUnderlinedAt (row, column,boolean)

Parameters

row Row index

column Column index

boolean True for underlined, False for not underlined
SetTopMarginAt Method

Sets the top margin of the specified data cell.

Syntax

SpssDataCells.SetTopMarginAt (row, column, margin)

Parameters
row Row index
column Column index
margin An integer. The unit is the point (1/72 inch). The
maximum value is 36.
SetVAlignAt Method

Sets the vertical alignment of the specified data cell.

Syntax

SpssDataCells.SetVAlignAt (row, column,alignment)

Parameters
row Row index
column Column index

Set the value of alignment to one of the following:

SpssClient.SpssVAlignTypes.SpssVAlTop Top
SpssClient.SpssVAlignTypes.SpssVAlBottom Bottom
SpssClient.SpssVAlignTypes.SpssVAlCenter Center
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Sets the value of the specified data cell.

Syntax

SpssDataCells.SetValueAt (row, column, value)
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Parameters

row Row index
column Column index
value Value as a string

ShowFootnotesAt Method

Displays all the footnotes referenced by the specified data cell.

Syntax

SpssDataCells.ShowFootnotesAt (row, column)

Parameters
row Row index
column Column index

SpssDimension Class

The SpssDimension class provides access to a pivot table’s dimensions. A pivot table can have
three types of dimensions: column dimensions, row dimensions, and layer dimensions. Using an
SpssDimension object you can obtain the name of a dimension, change the current category, or

pivot the dimension.

Table Dimensions

The following is an illustration of the three types of dimension in a pivot table. To see the pivot
table with all its labels (as shown in the figure), double-click it and select View>Show All from

the menus in the pivot table editor.
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Count 15t layer dimenzion
Employment cateqord Emplovment cateqory[Clericall—————  2nd layer dimension
Minarity classification 15t column dimension
Mo TES
Gender Gender ) )
2nd column dimension
COLLEGE Female | Male | Female | Male
COLLEGE Mo 27 B 3 4 Dimension names
Yes 38 74 10 25 Group labels
Total [h] =] 13 249 Categary labels

Cnly one row dimenzion

To display the pivot trays (if they are not on the screen), select Pivot >Pivoting Trays from the
menus.

Getting an SpssDimension Object

You get an SpssDimension object from the GetColumnDimension, GetLayerDimension, or
GetRowDimension method of an SpssPivotMgr object. The SpssPivotMgr object is obtained
from the SpssPivotTable object. For example, the following gets an SpssDimension object
for the row dimension with index 1:

SpssPivotMgr = SpssPivotTable.PivotManager ()
SpssDimension = SpssPivotMgr.GetRowDimension (1)

Example

This example assumes that PivotTable is an SpssPivotTable object and moves the
“Statistics” row dimension to the first column dimension.

PivotManager = PivotTable.PivotManager ()
# Search for the row dimension named "Statistics" and pivot it to
# the first column dimension.
for i in range (PivotManager.GetNumRowDimensions()) :
RowDim = PivotManager.GetRowDimension (i)

if RowDim.GetDimensionName () == "Statistics":
RowDim.MoveToColumn (0)
break

GetCategoryValueAt Method

Returns the label associated with the current category.

Syntax

SpssDimension.GetCategoryValueAt (index)

Parameters

index Category index within the column or row dimension
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GetCurrentCategory Method

Returns the index for the current category.

Syntax

SpssDimension.GetCurrentCategory ()

GetDimensionName Method

Returns the dimension name.

Syntax

SpssDimension.GetDimensionName ()

GetFullDimensionLabel Method

Returns the value of the label for the dimension, which is a concatenation of the dimension name,
all the group labels (if any), and the label for the current category.

Syntax

SpssDimension.GetFullDimensionLabel ()

GetNumCategories Method

Returns the number of categories in the dimension.

Syntax

SpssDimension.GetNumCategories ()
HideLabel Method

Hides the dimension label.

Syntax

SpssDimension.HideLabel ()

MoveToColumn Method

Pivots the dimension to the column, placing it before the specified column dimension.
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Syntax

SpssDimension.MoveToColumn (index)

Parameters

|index Column dimension index

MoveTolLayer Method

Pivots the dimension to the layer, placing it before the specified layer dimension.

Syntax

SpssDimension.MoveToLayer (index)

Parameters

|index Layer dimension index

MoveToRow Method
Pivots the dimension to the row, placing it before the specified row dimension.

Syntax

SpssDimension.MoveToRow (index)

Parameters

|index Row dimension index

SetCurrentCategory Method

Sets the specified category as current.

Syntax

SpssDimension.SetCurrentCategory (index)

Parameters

index Category index
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SetDimensionName Method

Sets the dimension name.

Syntax

SpssDimension.SetDimensionName (name)

SpssFootnotes Class

The SpssFootnotes class provides access to all of the footnotes contained in a pivot table. The
index of a footnote does not correspond to the footnote marker but to the order of their references
in the table. The index is returned when you insert a new footnote.

You get an SpssFootnotes object from the FootnotesArray method of an SpssPivotTable
object, as in:

SpssFootnotes = SpssPivotTable.FootnotesArray ()

An SpssFootnotes object is also returned by the GetReferredFootnotesAt method of an
SpssDataCells or SpssLabels object. The footnote collection thus returned contains only the
footnotes referred to by the specified data cell or label. The indexes for the returned collection
are in the ordinal order of the references in the referring cell. IBM® SPSS® Statistics does not
provide a method to go from a footnote referred to by a cell to the same footnote contained in the
footnote array of the table.

Example

This example assumes that PivotTable is an SpssPivotTable object and sets the background
color to yellow for all data cells that have footnotes.

Footnotes = PivotTable.FootnotesArray ()

PivotTable.ClearSelection()

for i in range (Footnotes.GetCount ()) :
Footnotes.SelectCellAt (i)

PivotTable.SetBackgroundColor (65535)

ChangeMarkerToRegular Method
Changes the marker of the current footnote to the regular marker. The marker is either alphabetic

or numeric. The footnote marker type is set from the Set FootnoteMarkers method in the
SpssPivotTable class.

Syntax

SpssFootnotes.ChangeMarkerToRegular (index)
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Parameters

| index | Index of the footnote

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

ChangeMarkerToSpecial Method

Changes the marker of the current footnote to the special marker.

Syntax

SpssFootnotes.ChangeMarkerToSpecial (index, newmarker)

Parameters

index Index of the footnote

newmarker Special marker for the footnote. The value is a
string with a maximum length of two characters.

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

GetBackgroundColorAt Method

Returns the background color of the specified footnote.

Syntax

SpssFootnotes.GetBackgroundColorAt (index)

Parameters

| index | Index of the footnote

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

Returns

The color is returned as an integer. For more information, see the topic Setting Color Values
in Appendix A on p. 201.

Note: This method is not available for legacy tables.
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GetBottomMarginAt Method

Returns the bottom margin of the specified footnote. The unit is the point (1/72 inch).

Syntax

SpssFootnotes.GetBottomMarginAt (index)

Parameters

| index | Index of the footnote

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

Note: This method is not available for legacy tables.

GetCount Method
Returns the number of footnotes associated with the current pivot table.
Syntax

SpssFootnotes.GetCount ()

GetForegroundColorAt Method

This method is deprecated in release 17.0 and obsolete for legacy tables in release 20 and higher.
Use the GetTextColorAt method instead.

GetHAlignAt Method

Returns the horizontal alignment of the specified footnote.

Syntax

SpssFootnotes.GetHAlignAt (index)

Parameters

| index | Index of the footnote

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.
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Returns
SpssClient.SpssHAlignTypes.SpssHAILeft Left
SpssClient.SpssHAlignTypes.SpssHAIRight Right
SpssClient.SpssHAlignTypes.SpssHAICenter Center
SpssClient.SpssHAlignTypes.SpssHAIMixed Mixed
SpssClient.SpssHAlignTypes.SpssHAIDecimal Decimal
Note: This method is not available for legacy tables.
GetleftMarginAt Method

Returns the left margin for the specified footnote. The unit is the point (1/72 inch).

Syntax

SpssFootnotes.GetLeftMarginAt (index)

Parameters

| index | Index of the footnote. |

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

Note: This method is not available for legacy tables.

GetRightMarginAt Method

Returns the right margin of the specified footnote. The unit is the point (1/72 inch).

Syntax

SpssFootnotes.GetRightMarginAt (index)

Parameters

| index | Index of the footnote

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

Note: This method is not available for legacy tables.

GetTextColorAt Method

Returns the color of the text of the specified footnote.
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Syntax

SpssFootnotes.GetTextColorAt (index)

Parameters

| index | Index of the footnote |

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

Returns

The color is returned as an integer. For more information, see the topic Setting Color Values
in Appendix A on p. 201.

GetTextFontAt Method

Returns the font of the text in the specified footnote, as a string.

Syntax

SpssFootnotes.GetTextFontAt (index)

Parameters

| index | Index of the footnote |

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

GetTextHiddenAt Method

Returns the hidden effect of the specified footnote. The result is a Boolean.

Syntax

SpssFootnotes.GetTextHiddenAt (index)

Parameters

| index | Index of the footnote |

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.
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Returns

True Hidden

False Not hidden

GetTextSizeAt Method

Returns the font size of the specified footnote.

Syntax

SpssFootnotes.GetTextSizeAt (index)

Parameters

| index | Index of the footnote

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

GetTextStyleAt Method

Returns the bold or italic style of the text for specified footnote.

Syntax

SpssFootnotes.GetTextStyleAt (index)

Parameters

| index | Index of the footnote

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

Returns
SpssClient.SpssTextStyleTypes.SpssTSRegular Regular
SpssClient.SpssTextStyleTypes.SpssTSltalic Italic
SpssClient.SpssTextStyleTypes.SpssTSBold Bold
SpssClient.SpssTextStyleTypes.SpssTSBoldltalic Bold Italic

GetTextUnderlinedAt Method

Returns the underlined effect of the specified footnote. The result is a Boolean.
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Syntax

SpssFootnotes.GetTextUnderlinedAt (index)

Parameters

| index | Index of the footnote

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

Returns
True Underlined
False Not underlined

Note: This method is not available for legacy tables.

GetTopMarginAt Method

Returns the top margin of the specified footnote. The unit is the point (1/72 inch).

Syntax

SpssFootnotes.GetTopMarginAt (index)

Parameters

| index | Index of the footnote |

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

Note: This method is not available for legacy tables.

GetVAlignAt Method

Returns the vertical alignment of the specified footnote.

Syntax

SpssFootnotes.GetVAlignAt (index)

Parameters

| index Index of the footnote
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The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.
Returns
SpssClient.SpssVAlignTypes.SpssVAlTop Top
SpssClient.SpssVAlignTypes.SpssVAlBottom Bottom
SpssClient.SpssVAlignTypes.SpssVAlCenter Center
Note: This method is not available for legacy tables.
GetValueAt Method

Returns the value associated with the specified footnote, as a unicode string.

Syntax

SpssFootnotes.GetValueAt (index)

Parameters

| index | Index of the footnote

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

RenumberFootnotes Method

Renumbers all footnotes.

Syntax

SpssFootnotes.RenumberFootnotes ()

SelectCellAt Method

Selects the data or label cell associated with the specified footnote, in addition to previously
selected elements.

Syntax

SpssFootnotes.SelectCellAt (index)

Parameters

index Index of the footnote
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The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

SetBackgroundColorAt Method
Sets the background color of the specified footnote.

Syntax

SpssFootnotes. SetBackgroundColorAt (index, color)

Parameters
index Index of the footnote
color Integer representation of the color

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

For information on setting color values, see Appendix A on p. 201.
Note: This method is not available for legacy tables. You can set the background color of all

footnotes in a legacy table by selecting all footnotes with the SpssPivotTable.SelectAllFootnotes
method and then calling the SpssPivotTable.SetBackgroundColor method.

SetBottomMarginAt Method

Sets the bottom margin of the specified footnote.

Syntax

SpssFootnotes.SetBottomMarginAt (index, margin)

Parameters

index Index of the footnote

margin An integer. The unit is the point (1/72 inch). The
maximum value is 36.

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

Note: This method is not available for legacy tables. You can set the bottom margin of the footnote
area in a legacy table by selecting all footnotes with the SpssPivotTable.SelectAllFootnotes
method and then calling the SpssPivotTable.SetBottomMargin method.
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SetForegroundColorAt Method

This method is deprecated in release 17.0 and obsolete for legacy tables in release 20 and higher.
Use the SetTextColorAt method instead.

SetHAlignAt Method

Sets the horizontal alignment of the specified footnote.

Syntax

SpssFootnotes.SetHAlignAt (index, alignment)

Parameters

| index | Index of the footnote |

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

Set the value of alignment to one of the following:

SpssClient.SpssHAlignTypes.SpssHAILeft Left
SpssClient.SpssHAlignTypes.SpssHAIRight Right
SpssClient.SpssHAlignTypes.SpssHAICenter Center
SpssClient.SpssHAlignTypes.SpssHAIMixed Mixed
SpssClient.SpssHAlignTypes.SpssHAIDecimal Decimal

Note: This method is not available for legacy tables. You can set the horizontal alignment of all
footnotes in a legacy table by selecting all footnotes with the SpssPivotTable.SelectAllFootnotes
method and then calling the SpssPivotTable.SetHAlign method.

SetlLeftMarginAt Method

Sets the left margin for the specified footnote.

Syntax

SpssFootnotes.SetLeftMarginAt (index, margin)

Parameters

index Index of the footnote.

margin An integer. The unit is the point (1/72 inch). The
maximum value is 36.
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The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

Note: This method is not available for legacy tables. You can set the left margin of the footnote

area in a legacy table by selecting all footnotes with the SpssPivotTable.SelectAllFootnotes
method and then calling the SpssPivotTable.SetLeftMargin method.

SetRightMarginAt Method

Sets the right margin of specified footnote.

Syntax

SpssFootnotes.SetRightMarginAt (index, margin)

Parameters

index Index of the footnote

margin An integer. The unit is the point (1/72 inch). The
maximum value is 36.

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

Note: This method is not available for legacy tables. You can set the right margin of the footnote
area in a legacy table by selecting all footnotes with the SpssPivotTable.SelectAllFootnotes
method and then calling the SpssPivotTable.SetRightMargin method.

SetTextColorAt Method

Sets the color of the text of the specified footnote.

Syntax

SpssFootnotes.SetTextColorAt (index, color)

Parameters
index Index of the footnote
color Integer representation of the color

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

For information on setting color values, see Appendix A on p. 201.
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SetTextFontAt Method

Sets the font of the text in the specified footnote.

Syntax

SpssFootnotes.SetTextFontAt (index, fontname)

Parameters
index Index of the footnote
fontname Name of the font family, as a string. Available fonts

are accessed from Format>Cell Properties in the
pivot table editor.

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

SetTextHiddenAt Method

Sets the hidden effect of the specified footnote.

Syntax

SpssFootnotes.SetTextHiddenAt (index,boolean)

Parameters
index Index of the footnote
boolean True for hidden, False for not hidden

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

SetTextSizeAt Method

Sets the font size of the specified footnote.

Syntax

SpssFootnotes.SetTextSizeAt (index, size)

Parameters

index Index of the footnote

size Size in points (integer)
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The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

SetTextStyleAt Method

Sets the bold or italic style of the text for the specified footnote.

Syntax

SpssFootnotes.SetTextStyleAt (index, style)

Parameters

| index | Index of the footnote |

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

Set the value of style to one of the following:

SpssClient.SpssTextStyleTypes.SpssTSRegular Regular
SpssClient.SpssTextStyleTypes.SpssTSltalic Italic
SpssClient.SpssTextStyleTypes.SpssTSBold Bold
SpssClient.SpssTextStyleTypes.SpssTSBoldltalic Bold Italic

SetTextUnderlinedAt Method

Sets the underlined effect of the specified footnote.

Syntax

SpssFootnotes.SetTextUnderlinedAt (index, boolean)

Parameters
index Index of the footnote
boolean True for underlined, False for not underlined

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

Note: This method is not available for legacy tables. You can set the underlined effect of all
footnotes in a legacy table by selecting all footnotes with the SpssPivotTable.SelectAllFootnotes
method and then calling the SpssPivotTable.SetTextUnderlined method.
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SetTopMarginAt Method

Sets the top margin of the specified footnote.

Syntax

SpssFootnotes.SetTopMarginAt (index, margin)

Parameters

index Index of the footnote

margin An integer. The unit is the point (1/72 inch). The
maximum value is 36.

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

Note: This method is not available for legacy tables. You can set the top margin of the footnote
area in a legacy table by selecting all footnotes with the SpssPivotTable.SelectAllFootnotes
method and then calling the SpssPivotTable.SetTopMargin method.

SetVAlignAt Method

Sets the vertical alignment of the specified footnote.

Syntax

SpssFootnotes.SetVAlignAt (index, alignment)

Parameters

| index | Index of the footnote

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

Set the value of alignment to one of the following:

SpssClient.SpssVAlignTypes.SpssVAlTop Top
SpssClient.SpssVAlignTypes.SpssVAlBottom Bottom
SpssClient.SpssVAlignTypes.SpssVAlCenter Center

Note: This method is not available for legacy tables. You can set the vertical alignment of all
footnotes in a legacy table by selecting all footnotes with the SpssPivotTable.SelectAllFootnotes
method and then calling the SpssPivotTable.SetVAlign method.
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SetValueAt Method

Sets the value associated with the specified footnote.

Syntax

SpssFootnotes.SetValueAt (index, value)

Parameters
index Index of the footnote
value String

The index of a footnote does not correspond to the footnote marker but to the order of their
references in the table.

Spsslabels Class

The SpssLabels class provides access to the row labels and column labels contained in a pivot
table. You need to use this object to format column or row labels (for example, making all “Total”
labels bold) or to change labels (for example, changing the “Column %”, “Row %" or “Total %”
label). Generally speaking, you need to get the specified column or row label in order to locate
specific statistics in an SpssDataCells object.

The row and column labels are represented as 2-dimensional arrays, referred to as the row
labels array and column labels array. The arrays contain all row and column labels for the pivot
table, including hidden labels. The row labels array has the same number of rows as the data cells
array and the column labels array has the same number of columns as the data cells array. Row
indexes for the row labels and column indexes for the column labels respectively correspond to
the row and column indexes for the data cells.

Column Labels Array

The following diagrams illustrate how the column labels array is indexed. Note that where you
see only one label (such as the dimension name Statistics) in the pivot table, the label can be
accessed in all cells corresponding to the categories under it. In the case of Statistics, you can
access it using (0,0), (0,1), (0,2), (0,3), (0,4) or (0,5) and any change you make to one cell is
reflected in all these cells.
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Figure 8-1
Column labels (after Showing All)
Calurmn Dirmerzion ]| 4—— Statistics
Categories +———— Count % within Gender
Column Dimengsion 2 4+——— Gender Gender
Groups ——1— Gender Gender
Categories Female | Male Total | Female | Male Total
Corner Labels
Row Labels Data Cells
Figure 8-2
Column labels array indexing
Caolumn Statistics | Statistics | Statistics | Statistics | Statistics | Statistics
dimension 1 {0,0) (0,1} {0,2) (0,3) 0,4 (0,5)
. Count Count Count % wWithin | % Within | % ¥Within
Categories | (1,09 1,1 1,2) G ender G ender Gendar
{1,3) {1.4) {1,5)
Column G ender Gender G ender G ender G ender G ender
dimensian 2 {2,0) 2,1} {2,2) 2.3 24 (2,9)
G ender Gender G ender G ender
G
R eo EX) 32) 33) 34 3,5)
Categories | Fermale Male Total Female i ale Total
Correr Lakels 4,0} 4,1 4,2) 4.3 4.4 (4,5)
Rl abels DaacCels

Each column dimension in the column labels array is represented by a set of levels. The first level
is the dimension label, the last level contains the category labels, and all the levels in between (if
any) contain group labels.

Row Labels Array

The following diagrams illustrate how the row labels array is indexed. Note that where you
see only one label (such as the dimension name Statistics) in the pivot table, the label can be
accessed in all cells corresponding to the categories under it. In the case of Statistics, you can
access it using (0,0), (1,0), (2,0), (3,0), (4,0) and (5,0) and any change you make to one cell is
reflected in all these cells.

Figure 8-3
Row labels (after showing all)
Flow Fiow
dimension 1 Categories dimension 2 Groups  Categories Calumn
| ‘ | | Labels
Statistics Count Gender Gender Female Data
Male Cells
Total
% within Gender Gender Gender Female
Male
Total
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Figure 8-4
Row labels array indexing
Row P
dirnensian 1 Categories  dimension 2 Groups Categories Caumn
Labelz
Statictics Count Gender Gender Female DetaCells
(0,0} 0,1} 0,2} (0,3} 0.4}
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Each row dimension in the row labels array is represented by a set of levels. The first level is
the dimension label, the last level contains the category labels, and all the levels in between (if
any) contain group labels.

Notes

m  To see all row and column labels in a pivot table, double-click on it and select View>Show All
in the pivot table editor.

m  Blank cells in the row label or column label arrays indicate that some categories (or subgroups)
are not grouped.

Getting an SpssLabels Object

You get an SpssLabels object from the RowLabelArray or ColumnLabelArray method of
an SpssPivotTable object, as in:

SpssLabels = SpssPivotTable.RowLabelArray ()

Examples

This example assumes that PivotTable is an SpssPivotTable object, selects all row labels
and bolds the text.

RowLabels = PivotTable.RowLabelArray ()
for i in range (RowLabels.GetNumRows () ) :
for j in range(1l,RowLabels.GetNumColumns () ) :
RowLabels.SetTextStyleAt (i, 7,
SpssClient.SpssTextStyleTypes.SpssTSBold)

This example assumes that PivotTable is an SpssPivotTable object, selects all column
labels and bolds the text.
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ColLabels = PivotTable.ColumnLabelArray ()
for i in range(l,ColLabels.GetNumRows ()) :
for j in range (ColLabels.GetNumColumns()) :

ColLabels.SetTextStyleAt (1,7,

SpssClient.SpssTextStyleTypes.SpssTSBold)

BreakHere Method

Sets the break location for printing large pivot tables. The break occurs after a specified row or
column label and only applies to the innermost row or column labels. Breaks are specified for a
particular row or column label and do not apply to any repeated versions of the specified label.

Syntax

SpsslLabels.BreakHere (index)

Parameters

index

For row labels, the index of the row (to break on) in
the row labels array. For column labels, the index of
the column (to break on) in the column labels array.

GetBackgroundColorAt Method

Returns the background color of the specified row/column label.

Syntax

SpssLabels.GetBackgroundColorAt (row, column)

Parameters

row Row index in the label array
column Column index in the label array
Returns

The color is returned as an integer. For more information, see the topic Setting Color Values

in Appendix A on p. 201.

GetBottomMarginAt Method

Returns the bottom margin of the specified row/column label. The unit is the point (1/72 inch).

Syntax

SpssLabels.GetBottomMarginAt (row, column)
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Parameters
row Row index in the label array
column Column index in the label array

GetColumnLabelWidthAt Method

Returns the width of the column labels for the level containing the current label. The unit is
the point (1/72 inch).

Syntax

SpsslLabels.GetColumnLabelWidthAt (row, column)

Parameters
row Row index in the label array
column Column index in the label array

GetForegroundColorAt Method

This method is deprecated in release 17.0. Use the GetTextColorAt method instead.

GetHAlignAt Method

Returns the horizontal alignment of the specified row/column label.

Syntax

SpssLabels.GetHAlignAt (row, column)

Parameters

row Row index in the label array
column Column index in the label array
Returns

SpssClient.SpssHAlignTypes.SpssHAILeft Left
SpssClient.SpssHAlignTypes.SpssHAIRight Right
SpssClient.SpssHAlignTypes.SpssHAICenter Center
SpssClient.SpssHAlignTypes.SpssHAIMixed Mixed
SpssClient.SpssHAlignTypes.SpssHAIDecimal Decimal
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GetLeftMarginAt Method
Returns the left margin of the specified row/column label. The unit is the point (1/72 inch).

Syntax

SpssLabels.GetLeftMarginAt (row, column)

Parameters

row Row index in the label array

column Column index in the label array
GetNumColumns Method

Returns the number of columns in the row/column labels object.

Syntax

SpssLabels.GetNumColumns ()

GetNumRows Method
Returns the number of rows in the row/column labels object.

Syntax

SpssLabels.GetNumRows ()

GetReferredFootnotesAt Method

Returns an SpssFootnotes object, which allows access to all the footnotes referred to by the
specified label cell.

®  The returned footnotes array is a subset of the array returned by the FootnotesArray
method of the SpssPivotTable class. You can manipulate the subset using the same
properties and methods, but the index of a footnote in this array is in no way related to the
index of the same footnote when accessed from the pivot table.

Syntax

SpssFootnotes=SpssLabels.GetReferredFootnotesAt (row, column)

Parameters

row Row index in the label array

column Column index in the label array
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Example
This example gets the footnotes for the column label with row index 1 and column index 1 (in the

column label array) and sets the text color and text style of the first footnote (index value 0) to red
and bold respectively. It assumes that PivotTable is an SpssPivotTable object.

Labels = PivotTable.ColumnLabelArray ()
Footnotes = Labels.GetReferredFootnotesAt (1,1)

Footnotes.SetTextStyleAt (0, SpssClient.SpssTextStyleTypes.SpssTSBold)
Footnotes.SetTextColorAt (0,255)

GetRightMarginAt Method
Returns the right margin of the specified row/column label. The unit is the point (1/72 inch).

Syntax

SpssLabels.GetRightMarginAt (row, column)

Parameters
row Row index in the label array
column Column index in the label array

GetRowlLabelWidthAt Method

Returns the width of the row labels for the level containing the current label. The unit is the
point (1/72 inch).

Syntax

SpsslLabels.GetRowLabelWidthAt (row, column)

Parameters

row Row index in the label array

column Column index in the label array
GetTextColorAt Method

Returns the color of the text in the specified row/column label.

Syntax

SpsslLabels.GetTextColorAt (row, column)
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Parameters

row Row index in the label array

column Column index in the label array

Returns

The color is returned as an integer. For more information, see the topic Setting Color Values
in Appendix A on p. 201.

GetTextFontAt Method

Returns the font of the text in the specified row/column label, as a string.

Syntax

SpssLabels.GetTextFontAt (row, column)

Parameters
row Row index in the label array
column Column index in the label array

GetTextHiddenAt Method

Returns the hidden effect of the text for the specified row/column label. The result is a Boolean.

Syntax

SpssLabels.GetTextHiddenAt (row, column)

Parameters
row Row index in the label array
column Column index in the label array
Returns
True Hidden
False Not hidden
GetTextSizeAt Method

Returns the font size of the text for the specified row/column label.
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SpssLabels.GetTextSizeAt (row, column)
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Parameters

row Row index in the label array

column Column index in the label array
GetTextStyleAt Method

Returns the bold or italic style of the text in the specified row/column label.

Syntax

SpsslLabels.GetTextStyleAt (row, column)

Parameters

row Row index in the label array
column Column index in the label array
Returns

SpssClient.SpssTextStyleTypes.SpssTSRegular Regular
SpssClient.SpssTextStyleTypes.SpssTSltalic Italic
SpssClient.SpssTextStyleTypes.SpssTSBold Bold
SpssClient.SpssTextStyleTypes.SpssTSBoldltalic Bold Italic

GetTextUnderlinedAt Method

Returns the underlined effect of the text in the specified row/column label. The result is a Boolean.

Syntax

SpssLabels.GetTextUnderlinedAt (row, column)

Parameters

row Row index in the label array
column Column index in the label array
Returns

True Underlined

False Not underlined
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GetTextWidthAt Method

Returns the width of the text in the indexed row/column label, as if the text were unwrapped. The
unit is the point (1/72 inch).

Syntax

SpssLabels.GetTextWidthAt (row, column)

Parameters

row Row index in the label array

column Column index in the label array
GetTopMarginAt Method

Returns the top margin of the specified row/column label. The unit is the point (1/72 inch).

Syntax

SpsslLabels.GetTopMarginAt (row, column)

Parameters

row Row index in the label array

column Column index in the label array
GetVAlignAt Method

Returns the vertical alignment of the specified row/column label.

Syntax

SpssLabels.GetVAlignAt (row, column)

Parameters

row Row index in the label array
column Column index in the label array
Returns

SpssClient.SpssVAlignTypes.SpssVAlTop Top
SpssClient.SpssVAlignTypes.SpssVAlBottom Bottom
SpssClient.SpssVAlignTypes.SpssVAlCenter Center
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Returns the value of the specified row/column label, as a unicode string.

Syntax

SpssLabels.GetValueAt (row, column, includeFootnotes)

Parameters

row Row index in the label array

column Column index in the label array
includeFootnotes Optional Boolean specifying whether to include

footnote markers in the returned value. The default
is True.

HideAllLabelsIinDimensionAt Method

Hides all labels in the same dimension as the specified label.

Syntax

SpsslLabels.HideAllLabelsInDimensionAt (row, column)

Parameters
row Row index in the label array
column Column index in the label array

HideFootnotesAt Method

Hides all footnotes referenced by the specified row/column label.

Syntax

SpssLabels.HideFootnotesAt (row, column)

Parameters
row Row index in the label array
column Column index in the label array

HidelLabelsinDimensionAt Method

Hides all instances of the specified label within the dimension containing the label.
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Syntax

SpsslLabels.HideLabelsInDimensionAt (row, column)

Parameters
row Row index in the label array
column Column index in the label array

HidelLabelsWithDataAt Method

Hides all instances of the specified label and all data associated with those instances. Only applies
to the innermost labels.

Syntax

SpsslLabels.HidelLabelsWithDataAt (row, column)

Parameters

row Row index in the label array

column Column index in the label array
InsertBefore Method

Moves the selected column(s) or rows before a specified column or row. (The data are moved
together with the labels.)

m  The selected and specified labels must be in the same dimension and must be either category
or group labels. (That is, they cannot be dimension names.)

m If no labels in the same dimension are selected, the method is ignored.

Syntax

SpssLabels.InsertBefore (row,column)

Parameters

row Row index in the label array

column Column index in the label array
InsertNewAfter Method

Inserts a new row or column, after the specified row or column, in the pivot table. To insert a new
row, use this method with the row labels array. To insert a new column, use this method with the
column labels array. The particular row or column is specified by providing the indexes of its
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associated label in the labels array. For example, to insert a column after the column whose label
is “Mean”, you provide the indexes of the label “Mean” in the column labels array.

B A plus sign “+” is inserted in the first cell of the new row or column to prevent the row or
column from being automatically hidden because it is empty.

B In a table with nested or layered dimensions, a column or row is inserted at every
corresponding dimension level.
Syntax

SpssLabels.InsertNewAfter (row, column, label=None)

Parameters

row Row index in the label array

column Column index in the label array

label An optional label for the new row or column. If
omitted, a plus sign “+” is used for the label.

InsertNewBefore Method

Inserts a new row or column, before the specified row or column, in the pivot table. To insert a
new row, use this method with the row labels array. To insert a new column, use this method with
the column labels array. The particular row or column is specified by providing the indexes of its
associated label in the labels array. For example, to insert a column before the column whose label
is “Mean”, you provide the indexes of the label “Mean” in the column labels array.

B A plus sign “+” is inserted in the first cell of the new row or column to prevent the row or
column from being automatically hidden because it is empty.

® In a table with nested or layered dimensions, a column or row is inserted at every
corresponding dimension level.

Syntax

SpssLabels.InsertNewBefore (row, column, label=None)

Parameters

row Row index in the label array

column Column index in the label array

label An optional label for the new row or column. If
omitted, a plus sign “+” is used for the label.

InsertNewFootnoteAt Method

Inserts a new footnote for the specified row/column label.
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Syntax

index=SpssLabels.InsertNewFootnoteAt (row, column, string)

Parameters

row Row index in the label array
column Column index in the label array
string New footnote text

Return Value

index Integer (to be used to insert the footnote in other
cells if it is a shared footnote)

Example
This example inserts a footnote for the column label with row index 1 and column index 1 (in the

column label array), and it also inserts a shared footnote for the column label with row index 1 and
column index 2. It assumes that PivotTable is an SpssPivotTable object.

Labels = PivotTable.ColumnLabelArray ()
index = Labels.InsertNewFootnoteAt (1,1, "My footnote")
Labels.InsertSharedFootnoteAt (1,2, index)

InsertSharedFootnoteAt Method

Inserts a shared footnote (a footnote that applies to multiple labels and/or data cells) for the
specified row/column label.

Syntax

SpsslLabels.InsertSharedFootnoteAt (row, column, index)

Parameters

row Row index in the label array.

column Column index in the label array

index The index (in the footnote array) of the desired
footnote.

Note: When inserting a shared footnote along with a new footnote created with

the InsertNewFootnoteAt method, you can use the index value returned by the
InsertNewFootnoteAt method. For more information, see the topic InsertNewFootnoteAt
Method on p. 163.
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Prevents a page break from occurring within the specified range when printing large pivot tables.

Syntax

SpssLabels.KeepTogether (from, to)

Parameters

from For row labels, the index of the starting row in the
row labels array. For column labels, the index of the
starting column in the column labels array.

to For row labels, the index of the ending row in the
row labels array. For column labels, the index of the
ending column in the column labels array.

RemoveBreakHere Method

Clears a previously set break location.

Syntax

SpssLabels.RemoveBreakHere (index)

Parameters

index

For row labels, the index of the row (in the row
labels array) for which the break was set. For
column labels, the index of the column (in the
column labels array) for which the break was set.

RemoveKeepTogether Method

Negates the effects of a previous call to KeepTogether.

Syntax

SpssLabels.RemoveKeepTogether (from, to)

Parameters

from For row labels, the index of the starting row in the
row labels array. For column labels, the index of the
starting column in the column labels array.

to For row labels, the index of the ending row in the
row labels array. For column labels, the index of the
ending column in the column labels array.
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SelectDataUnderLabelAt Method

Selects the data under the indexed label (but not the label), in addition to whatever has been
selected previously.

Syntax

SpssLabels.SelectDataUnderLabelAt (row, column)

Parameters

row Row index in the label array

column Column index in the label array
SelectLabelAt Method

Selects the indexed label, in addition to previously selected elements.

Syntax

SpssLabels.SelectLabelAt (row, column)

Parameters
row Row index in the label array
column Column index in the label array

SelectLabelDataAt Method

Selects the indexed label and all corresponding data in the category, in addition to whatever
has been selected previously.

Syntax

SpssLabels.SelectLabelDataAt (row, column)

Parameters
row Row index in the label array
column Column index in the label array

SelectReferredFootnotesAt Method

Selects all the footnotes referenced by the specified label cell, in addition to previously selected
elements.
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Syntax

SpssLabels.SelectReferredFootnotesAt (row, column)

Parameters
row Row index in the label array
column Column index in the label array

Note: This method is not available for legacy tables. To modify footnotes associated
with a particular label in a legacy table, use the GetReferredFootnotesAt method to get an

SpssFootnotes object containing the footnotes. You can then use the methods of the
SpssFootnotes object to make the desired modifications.

SetBackgroundColorAt Method
Sets the background color of the specified row/column label.

Syntax

SpssLabels.SetBackgroundColorAt (row, column, color)

Parameters

row Row index in the label array
column Column index in the label array
color Integer representation of the color

For information on setting color values, see Appendix A on p. 201.

SetBottomMarginAt Method

Sets the bottom margin of the specified row/column label.

Syntax

SpssLabels.SetBottomMarginAt (row, column, margin)

Parameters

row Row index in the label array

column Column index in the label array

margin An integer. The unit is the point (1/72 inch). The
maximum value is 36.
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SetColumnLabelWidthAt Method

Sets the width of the specified column label. This property will also set the widths of all column
labels and data cells that are in the same column of the table as the specified label. To set column
widths independently, use the ReSizeColumn method in the SpssDataCells class.

Syntax

SpssLabels.SetColumnLabelWidthAt (row, column, width)

Parameters

row Row index in the label array

column Column index in the label array

width An integer. The unit is the point (1/72 inch).

SetForegroundColorAt Method

This method is deprecated in release 17.0. Use the SetTextColorAt method instead.

SetHAlignAt Method

Sets the horizontal alignment of the specified row/column label.

Syntax

SpssLabels.SetHAlignAt (row, column, alignment)

Parameters
row Row index in the label array
column Column index in the label array

Set the value of alignment to one of the following:

SpssClient.SpssHAlignTypes.SpssHAILeft Left
SpssClient.SpssHAlignTypes.SpssHAIRight Right
SpssClient.SpssHAlignTypes.SpssHAICenter Center
SpssClient.SpssHAlignTypes.SpssHAIMixed Mixed
SpssClient.SpssHAlignTypes.SpssHAIDecimal Decimal

SetlLeftMarginAt Method

Sets the left margin of the specified row/column label.
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Syntax

SpssLabels.SetLeftMarginAt (row, column, margin)

Parameters

row Row index in the label array

column Column index in the label array

margin An integer. The unit is the point (1/72 inch). The
maximum value is 36.

SetRightMarginAt Method

Sets the right margin of the specified row/column label.

Syntax

SpssLabels.SetRightMarginAt (row, column, margin)

Parameters

row Row index in the label array

column Column index in the label array

margin An integer. The unit is the point (1/72 inch). The
maximum value is 36.

SetRowlabelWidthAt Method

Sets the width of the specified row label. This method will also set the widths of all row labels that
are in the same column of the row label array as the specified label.

Syntax

SpssLabels.SetRowLabelWidthAt (row, column,width)

Parameters

row Row index in the label array

column Column index in the label array

width An integer. The unit is the point (1/72 inch).
SetTextColorAt Method

Sets the color of the text in the specified row/column label.
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Syntax
SpssLabels.SetTextColorAt (row, column, color)
Parameters
row Row index in the label array
column Column index in the label array
color Integer representation of the color
For information on setting color values, see Appendix A on p. 201.
SetTextFontAt Method

Sets the font of the text in the specified row/column label.

Syntax

SpssLabels.SetTextFontAt (row, column, fontname)

Parameters

row Row index in the label array

column Column index in the label array

fontname Name of the font family, as a string. Available fonts

are accessed from Format>Cell Properties in the
pivot table editor.

SetTextHiddenAt Method

Sets the hidden effect of the text for the specified row/column label.

Syntax

SpssLabels.SetTextHiddenAt (row, column, boolean)

Parameters
row Row index in the label array
column Column index in the label array
boolean True for hidden, False for not hidden. True hides
the cell associated with the label.
SetTextSizeAt Method

Sets the font size of the text for the specified row/column label.




171

Pivot Tables

Syntax

SpssLabels.SetTextSizeAt (row,column, size)

Parameters

row Row index in the label array

column Column index in the label array

size Size in points (integer)
SetTextStyleAt Method

Sets the bold or italic style of the text in the specified row/column label.

Syntax

SpssLabels.SetTextStyleAt (row, column, style)

Parameters
row Row index in the label array
column Column index in the label array

Set the value of style to one of the following:

SpssClient.SpssTextStyleTypes.SpssTSRegular Regular
SpssClient.SpssTextStyleTypes.SpssTSltalic Italic
SpssClient.SpssTextStyleTypes.SpssTSBold Bold
SpssClient.SpssTextStyleTypes.SpssTSBoldltalic Bold Italic

SetTextUnderlinedAt Method

Sets the underlined effect of the text in the specified row/column label.

Syntax

SpssLabels.SetTextUnderlinedAt (row, column, boolean)

Parameters

row Row index in the label array

column Column index in the label array

boolean True for underlined, False for not underlined.
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SetTopMarginAt Method

Sets the top margin of the specified row/column label.

Syntax

SpssLabels.SetTopMarginAt (row, column, margin)

Parameters
row Row index in the label array
column Column index in the label array
margin An integer. The unit is the point (1/72 inch). The
maximum value is 36.
SetVAlignAt Method

Sets the vertical alignment of the specified row/column label.

Syntax

SpssLabels.SetVAlignAt (row, column, alignment)

Parameters
row Row index in the label array
column Column index in the label array

Set the value of alignment to one of the following:

SpssClient.SpssVAlignTypes.SpssVAlTop Top
SpssClient.SpssVAlignTypes.SpssVAIBottom Bottom
SpssClient.SpssVAlignTypes.SpssVAlCenter Center

SetValueAt Method

Sets the value of the specified row/column label.

Syntax

SpssLabels.SetValueAt (row, column, value)

Parameters

row Row index in the label array
column Column index in the label array
value String
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ShowAllLabelsAndDatalnDimensionAt Method

Shows all labels and data in the dimension that contains the specified label.

Syntax

SpssLabels.ShowAllLabelsAndDataInDimensionAt (row, column)

Parameters
row Row index in the label array
column Column index in the label array

ShowAllLabelsInDimensionAt Method

Shows all labels in the dimension that contains the specified label.

Syntax

SpsslLabels.ShowAllLabelsInDimensionAt (row, column)

Parameters
row Row index in the label array
column Column index in the label array

ShowFootnotesAt Method

Displays all the footnotes referenced by the specified row/column label.

Syntax

SpssLabels.ShowFootnotesAt (row, column)

Parameters
row Row index in the label array
column Column index in the label array

ShowHiddenDimensionLabelAt Method

Shows the hidden dimension label for the dimension that contains the specified label.

Syntax

SpssLabels.ShowHiddenDimensionLabelAt (row, column)
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Parameters
row Row index in the label array
column Column index in the label array
Swap Method

Swaps the selected column(s) or rows with a specified column or row. The data are swapped
together with the labels.

m  The selected and specified labels must be in the same dimension and must be either category
or group labels. (That is, they cannot be dimension names.)

m [fno labels in the same dimenison are selected, the method is ignored.

Syntax

SpssLabels.Swap (row, column)

Parameters
row Row index in the label array
column Column index in the label array

SpssLayerLabels Class

The SpssLayerLabels class provides access to the layer labels contained in a pivot table. You
need to use this object to format or change layer labels.

Layer Labels Array

The layer labels are represented as a 2-dimensional array, referred to as the layer labels array.
Each row corresponds to the current category of one layer dimension. The first column is a
concatenation of all the labels in the row, the second column is the dimension name, and the last
column is the category label. Any columns between the second and last are group labels. You
access other categories of the dimension from the SpssDimension object.

Figure 8-5
Layer labels displayed in a pivot table

Minority classification: Yes
Gender: Total
Employiment category: Employment category Clerical
Educational level {years)
o 12 14 [ 15 |16 [ 17 | 18
Statistics Count 7 a5 1|25 [ p 1
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Figure 8-6
Layer labels array indexing
Mincrity classificstion Yes Mincrity Ve
(0,0} l sgif cation {0,2) (0,3}
0,1
Gencer. Tadal Gender Tatal

(1,0) (1,1 (1,2} (13)

Employment categoryEmplovment category Employment Employment Clerics
2,0 category category 2,3}
2,1} 2.2)

Dizplayed layer label Dirmenizion name Group Current category

Each layer dimension in the layer labels array is represented by a set of levels. The first level is
the dimension name, the last level contains the current category label, and all the levels in between
(if any) contain group labels. Blank cells in the layer labels array indicate that there are different
numbers of levels in different layer dimensions.

Getting an SpsslLayerLabels Object

You get an SpssLayerLabels object from the LayerLabel Array method of an SpssPivotTable
object, as in:

SpssLayerLabels = SpssPivotTable.LayerLabelArray ()

Example

This example assumes that PivotTable is an SpssPivotTable object and sets the background
color of the label for the first layer dimension to yellow.

LayerLabels = PivotTable.LayerLabelArray ()
LayerLabels.SetBackgroundColorAt (0, 65535)

GetBackgroundColorAt Method

Returns the background color of the specified layer label.

Syntax

SpssLayerLabels.GetBackgroundColorAt (index)

Parameters

index Index of the layer dimension

Returns

The color is returned as an integer. For more information, see the topic Setting Color Values
in Appendix A on p. 201.
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GetBottomMarginAt Method

Returns the bottom margin of the specified layer label. The unit is the point (1/72 inch).

Syntax

SpssLayerLabels.GetBottomMarginAt (index)

Parameters

| index Index of the layer dimension

GetForegroundColorAt Method

This method is deprecated in release 17.0. Use the GetTextColorAt method instead.

GetHAlignAt Method

Returns the horizontal alignment of the specified layer label.

Syntax

SpssLayerLabels.GetHAlignAt (index)

Parameters
index Index of the layer dimension
Returns
SpssClient.SpssHAlignTypes.SpssHAILeft Left
SpssClient.SpssHAlignTypes.SpssHAIRight Right
SpssClient.SpssHAlignTypes.SpssHAICenter Center
SpssClient.SpssHAlignTypes.SpssHAIMixed Mixed
SpssClient.SpssHAlignTypes.SpssHAIDecimal Decimal
GetLeftMarginAt Method
Returns the left margin of the label for the specified layer dimension. The unit is the point (1/72
inch).
Syntax

SpssLayerLabels.GetLeftMarginAt (index)
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Parameters

|index Index of the layer dimension

GetNumDimensions Method

Returns the number of labels in the Layers (equal to the number of dimensions in the layers).

Syntax

SpssLayerLabels.GetNumDimensions ()

GetNumlLabelsWide Method

Returns the width (number of columns) of the Layer Labels array. The width equals the maximum
depth of layer dimensions plus one.

Syntax

SpssLayerLabels.GetNumLabelsWide ()

GetRightMarginAt Method

Returns the right margin of the label for the specified layer dimension. The unit is the point
(1/72 inch).

Syntax

SpssLayerLabels.GetRightMarginAt (index)

Parameters

| index Index of the layer dimension

GetTextColorAt Method

Returns the color of the text in the label of the specified layer dimension.

Syntax

SpssLayerLabels.GetTextColorAt (index)

Parameters

| index Index of the layer dimension
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Returns

The color is returned as an integer. For more information, see the topic Setting Color Values
in Appendix A on p. 201.

GetTextFontAt Method
Returns the font of the text in the specified layer dimension, as a string.
Syntax

SpssLayerLabels.GetTextFontAt (index)

Parameters

|index Index of the layer dimension

GetTextHiddenAt Method
Returns the hidden effect of the specified layer dimension. The result is a Boolean.
Syntax

SpssLayerLabels.GetTextHiddenAt (index)

Parameters
index Index of the layer dimension
Returns
True Hidden
False Not hidden
GetTextSizeAt Method

Returns the font size of the label for the specified layer dimension.
Syntax

SpssLayerLabels.GetTextSizeAt (index)

Parameters

| index Index of the layer dimension
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GetTextStyleAt Method

Returns the bold or italic style of the text for the specified layer dimension.

Syntax

SpssLayerLabels.GetTextStyleAt (index)

Parameters

index Index of the layer dimension
Returns

SpssClient.SpssTextStyleTypes.SpssTSRegular Regular
SpssClient.SpssTextStyleTypes.SpssTSltalic Italic
SpssClient.SpssTextStyleTypes.SpssTSBold Bold
SpssClient.SpssTextStyleTypes.SpssTSBoldltalic Bold Italic

GetTextUnderlinedAt Method

Returns the underlined effect of the specified layer dimension. The result is a Boolean.
Syntax

SpssLayerLabels.GetTextUnderlinedAt (index)

Parameters

index Index of the layer dimension

Returns

True Underlined

False Not underlined
GetTopMarginAt Method

Returns the top margin of the label for the specified layer dimension. The unit is the point (1/72
inch).

Syntax

SpssLayerLabels.GetTopMarginAt (index)
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Parameters
| index Index of the layer dimension

GetVAlignAt Method
Returns the vertical alignment of the label for the specified layer dimension.
Syntax
SpssLayerLabels.GetVAlignAt (index)
Parameters
| index Index of the layer dimension
Returns
SpssClient.SpssVAlignTypes.SpssVAlTop Top
SpssClient.SpssVAlignTypes.SpssVAlBottom Bottom
SpssClient.SpssVAlignTypes.SpssVAlCenter Center

GetValueAt Method

Returns the value associated with the specified layer and column from the layer labels array,
as a unicode string.

Syntax

SpssLayerLabels.GetValueAt (index, column)

Parameters
index Index of the layer dimension
column Column index of the cell in the layer labels array

HideFootnotesAt Method

Hides all footnotes referenced by the specified layer label.
Syntax

SpsslLayerLabels.HideFootnotesAt (index)
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Parameters

| index Index of the layer dimension
InsertNewFootnoteAt Method

Inserts a new footnote for the specified layer dimension.

Syntax

index=SpssLayerLabels.InsertNewFootnoteAt (index, string)

Parameters

index Index of the layer dimension

string New footnote text

Return Value

index Integer (to be used to insert the footnote in other

cells if it is a shared footnote)

Example

This example inserts a footnote for the layer dimension with index 0 (in the layer label array), and
then inserts a shared footnote for the layer dimension with index 1. It assumes that PivotTable
is an SpssPivotTable object.

Labels = PivotTable.LayerLabelArray ()
index = Labels.InsertNewFootnoteAt (0, "My footnote")
Labels.InsertSharedFootnoteAt (1, index)

InsertSharedFootnoteAt Method

Inserts a shared footnote (a footnote that applies to multiple labels and/or data cells) for the
specified layer dimension.

Syntax

SpsslLayerLabels.InsertSharedFootnoteAt (dim, index)

Parameters

dim Index of the layer dimension

index The index (in the footnote array) of the desired
footnote.
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Note: When inserting a shared footnote along with a new footnote created with

the InsertNewFootnoteAt method, you can use the index value returned by the
InsertNewFootnoteAt method. For more information, see the topic InsertNewFootnoteAt
Method on p. 181.

SelectLabelAt Method

Selects the specified label, in addition to previously selected elements.

Syntax

SpssLayerLabels.SelectLabelAt (index)

Parameters

|index Index of the layer dimension

SelectReferredFootnotesAt Method

Selects all the footnotes referenced by the current layer label, in addition to previously selected
elements.

Syntax

SpssLayerLabels.SelectReferredFootnotesAt (index)

Parameters

index |Indexcﬁ%helayerdhnenﬁon

Note: This method is not available for legacy tables.

SetBackgroundColorAt Method

Sets the background color of the specified layer label.

Syntax

SpsslLayerLabels.SetBackgroundColorAt (index, color)

Parameters
index Index of the layer dimension
color Integer representation of the color

For information on setting color values, see Appendix A on p. 201.
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SetBottomMarginAt Method
Sets the bottom margin of the specified layer label.
Syntax
SpssLayerLabels.SetBottomMarginAt (index, margin)
Parameters
index Index of the layer dimension
margin An integer. The unit is the point (1/72 inch). The
maximum value is 36.

SetForegroundColorAt Method

This method is deprecated in release 17.0. Use the SetTextColorAt method instead.

SetHAlignAt Method

Sets the horizontal alignment of the specified layer label.

Syntax

SpssLayerLabels.SetHAlignAt (index,alignment)

Parameters

| index | Index of the layer dimension

Set the value of alignment to one of the following:

SpssClient.SpssHAlignTypes.SpssHAILeft Left

SpssClient.SpssHAlignTypes.SpssHAIRight Right

SpssClient.SpssHAlignTypes.SpssHAICenter Center

SpssClient.SpssHAlignTypes.SpssHAIMixed Mixed

SpssClient.SpssHAlignTypes.SpssHAIDecimal Decimal
SetlLeftMarginAt Method

Sets the left margin of the label for the specified layer dimension.

Syntax

SpssLayerLabels.SetLeftMarginAt (index, margin)
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Parameters
index Index of the layer dimension
margin An integer. The unit is the point (1/72 inch). The
maximum value is 36.

SetRightMarginAt Method

Sets the right margin of the label for the specified layer dimension.

Syntax

SpsslLayerLabels.SetRightMarginAt (index, margin)

Parameters
index Index of the layer dimension
margin An integer. The unit is the point (1/72 inch). The
maximum value is 36.
SetTextColorAt Method

Sets the color of the text in the label of the specified layer dimension.

Syntax

SpssLayerLabels.SetTextColorAt (index, color)

Parameters
index Index of the layer dimension
color Integer representation of the color

For information on setting color values, see Appendix A on p. 201.

SetTextFontAt Method

Sets the font of the text in the specified layer dimension.

Syntax

SpssLayerLabels.SetTextFontAt (index, fontname)
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Parameters
index Index of the layer dimension
fontname Name of the font family, as a string. Available fonts

are accessed from Format>Cell Properties in the
pivot table editor.

SetTextHiddenAt Method

Sets the hidden effect of the label for the specified layer dimension.

Syntax

SpssLayerLabels.SetTextHiddenAt (index, boolean)

Parameters

index Index of the layer dimension

boolean True for hidden, False for not hidden
SetTextSizeAt Method

Sets the font size of the label of the specified layer dimension.

Syntax

SpssLayerLabels.SetTextSizeAt (index, size)

Parameters

index Index of the layer dimension

size Size in points (integer)
SetTextStyleAt Method

Sets the bold or italic style of the text for the specified layer dimension.

Syntax

SpssLayerLabels.SetTextStyleAt (index, style)

Parameters

index Index of the layer dimension
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Set the value of style to one of the following:

SpssClient.SpssTextStyleTypes.SpssTSRegular Regular
SpssClient.SpssTextStyleTypes.SpssTSltalic Italic
SpssClient.SpssTextStyleTypes.SpssTSBold Bold
SpssClient.SpssTextStyleTypes.SpssTSBoldlItalic Bold Italic

SetTextUnderlinedAt Method

Sets the underlined effect of the label for the specified layer dimension.

Syntax

SpssLayerLabels.SetTextUnderlinedAt (index,boolean)

Parameters
index Index of the layer dimension
boolean True for underlined, False for not underlined.

SetTopMarginAt Method

Sets the top margin of the label for the specified layer dimension.

Syntax

SpssLayerLabels.SetTopMarginAt (index, margin)

Parameters
index Index of the layer dimension
margin An integer. The unit is the point (1/72 inch). The
maximum value is 36.
SetVAlignAt Method

Sets the vertical alignment of the label for the specified layer dimension.

Syntax

SpssLayerLabels.SetVAlignAt (index,alignment)

Parameters

index Index of the layer dimension
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Set the value of alignment to one of the following:

SpssClient.SpssVAlignTypes.SpssVAlTop Top
SpssClient.SpssVAlignTypes.SpssVAlBottom Bottom
SpssClient.SpssVAlignTypes.SpssVAlCenter Center

ShowFootnotesAt Method

Displays all the footnotes referenced by the label of the specified layer dimension.

Syntax

SpssLayerLabels.ShowFootnotesAt (index)

Parameters

| index Index of the layer dimension

SpssPivotMgr Class

The SpssPivotMgr class provides access to the row, column, and layer dimensions contained in
a pivot table. By pivoting row dimensions to column dimensions, or column dimensions to layer
dimensions, you can find the best way to present the results of the statistical analyses.

You get an SpssPivotMgr object from the PivotManager method of an SpssPivotTable
object, as in:

SpssPivotMgr = SpssPivotTable.PivotManager ()

For an example of using the SpssPivotMgr class, see SpssDimension Class.

GetColumnDimension Method

Returns an SpssDimension object for the specified column dimension.

Syntax

SpssDimension=SpssPivotMgr.GetColumnDimension (index)

Parameters

index Index of the column dimension, where the value 0
refers to the innermost column dimension.

GetLayerDimension Method

Returns an SpssDimension object for the specified layer dimension.
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Syntax

SpssDimension=SpssPivotMgr.LayerDimension (index)

Parameters

|index

Index of the layer dimension

GetNumColumnDimensions Method

Returns the number of column dimensions.

Syntax

SpssPivotMgr.GetNumColumnDimensions ()

GetNumLayerDimensions Method

Returns the number of layer dimensions.

Syntax

SpssPivotMgr.GetNumLayerDimensions ()

GetNumRowDimensions Method

Returns the number of row dimensions.

Syntax

SpssPivotMgr.GetNumRowDimensions ()

GetRowDimension Method

Returns an SpssDimension object for the specified row dimension.

Syntax

SpssDimension=SpssPivotMgr.GetRowDimension (index)

Parameters

index

Index of the row dimension, where the value 0
refers to the innermost row dimension.
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MovelayersToColumns Method

Moves all dimensions in layers to the outermost columns.

Syntax

SpssPivotMgr.MovelLayersToColumns ()

MovelLayersToRows Method

Moves all dimensions in layers to the outermost rows.

Syntax

SpssPivotMgr.MoveLayersToRows ()

TransposeRowsWithColumns Method

Moves all dimensions in the rows to the columns and moves all dimensions in the columns to
the rows.

Syntax

SpssPivotMgr.TransposeRowsWithColumns ()
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SpssServerConf Class

The SpssServerConft class represents the configuration information for a server machine (may
be an instance of IBM® SPSS® Statistics Server or the local computer). From the SpssClient
object you can get an SpssServerConf object for the current server, the default server, the local
computer, or you can get a list of SpssServerConf objects for all configured servers (includes
the local computer).

Example: Connecting to a Server

import SpssClient

SpssClient.StartClient ()

SpssServerConf = SpssClient.CreateNewServer ("myservername",3016,"")
SpssServerConf.Connect ("", "myuserID", "mypassword")
SpssClient.StopClient ()

B The CreateNewServer method from the SpssClient class creates a new server
configuration object for a server with a specified name (or IP address) on a specified port. It
returns an SpssServerConf object.

B The Connect method of an SpssServerConf object establishes a connection to the server
using the specified domain, user ID, and password.

Example: Configuring a New Server and Saving the Configuration

import SpssClient

SpssClient.StartClient ()

ServerConflList = SpssClient.GetConfiguredServers ()

SpssServerConf = SpssClient.CreateNewServer ("myservername",3016,"")
ServerConfList.Add (SpssServerConf)

SpssServerConf = ServerConflist.GetItemAt (ServerConflList.Size()-1)
SpssServerConf.SetUserId ("myuserID")

SpssServerConf .SetPassword ("mypassword")

SpssServerConf .SetUserDomain ("mydomain")

SpssServerConf .SetPasswordSaved (True)

SpssClient.SaveServers ()

SpssClient.StopClient ()

B SpssClient.GetConfiguredServers () gets an SpssServerConfList object that
allows you to manage the list of configured servers.

B The CreateNewServer method from the SpssClient class creates a new server
configuration object. The variable SpssServerConfis an SpssServerConf object.

m  To add a new server configuration to the list, you use the Add method of the
SpssServerConfList object.

®  The user ID, password, and domain are set using the SetUserId, SetPassword, and
SetUserDomain methods of the SpssServerConf object. The SetPasswordSaved
method specifies that the password is to be saved for future use.
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B The SaveServers method from the SpssClient class saves all server configurations
so that they are available in future sessions.

Example: Connecting to a Server Using a Saved Configuration

import SpssClient
SpssClient.StartClient ()
ServerConfList = SpssClient.GetConfiguredServers()
for 1 in range(ServerConflList.Size()):

server = ServerConfList.GetItemAt (i)

if server.GetServerName () =="myservername" :

server.ConnectWithSavedPassword ()

SpssClient.StopClient ()

B SpssClient.GetConfiguredServers () gets an SpssServerConfList object that
provides access to the list of configured servers.

B The GetItemAt method of an SpssServerConfList object returns the SpssServerCont
object at the specified index. Index values start from 0 and represent the order in which
the servers were added to the list.

B The ConnectWithSavedPassword method uses the connection information (domain, user
ID, and password) to connect to the server.

Connect Method

Attempts to connect to the associated instance of IBM® SPSS® Statistics Server using the
provided domain, user ID, and password. Any existing connection to an instance of SPSS
Statistics Server is terminated.

Note: This method is not available when called from a Python program in distributed mode
(Python programs make use of the interface exposed by the Python spss module).

Syntax

SpssServerConf.Connect (domain, userID, password)

Parameters

domain A string specifying the domain of the user ID. Enter
a blank string if the domain is not required.

userID A string specifying the user ID.

password A string specifying the password.

ConnectWithSavedPassword Method

Attempts to connect to the associated instance of IBM® SPSS® Statistics Server using the stored
user domain, user ID, and password.

Note: This method is not available when called from a Python program in distributed mode
(Python programs make use of the interface exposed by the Python spss module).
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Syntax

SpssServerConf.ConnectWithSavedPassword ()

Disconnect Method

Disconnects from the associated instance of IBM® SPSS® Statistics Server.
B The method has no effect when called on the local server.

B After calling the Disconnect method, you must connect to another server before calling
other methods in the SpssClient module.

m [t is not necessary to disconnect before connecting to a new server.

Note: This method is not available when called from a Python program in distributed mode
(Python programs make use of the interface exposed by the Python spss module).

Syntax

SpssServerConf.Disconnect ()

GetDescription Method

Returns the description text for the associated server.

Syntax

SpssServerConf.GetDescription ()

GetServerName Method

Returns the machine name or IP address for the associated instance of IBM® SPSS® Statistics
Server.

Syntax

SpssServerConf.GetServerName ()

GetServerPort Method

Returns the port number for the associated instance of IBM® SPSS® Statistics Server.

Syntax

SpssServerConf.GetServerPort ()
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GetUserDomain Method
Returns the domain for the current user ID.
Syntax

SpssServerConf.GetUserDomain ()

GetUserld Method
Returns the user ID if it is saved as part of the associated server configuration.
Syntax

SpssServerConf.GetUserId ()

GetUseSSL Method
Indicates if SSL (Secure Sockets Layer) is in use for the associated instance of IBM® SPSS®
Statistics Server. SSL is a commonly used protocol for managing the security of message

transmission on the Internet. The result is Boolean—7rue if SSL is in use, False otherwise.

Syntax

SpssServerConf.GetUseSSL()

IsDefaultServer Method

Indicates whether the associated instance of IBM® SPSS® Statistics Server is set as the default
server. The result is Boolean—True if this is the default server, False otherwise.

Syntax

SpssServerConf.IsDefaultServer ()

IsEqualTo Method

Indicates if this server configuration object is the same object as a specified server configuration
object. The result is Boolean—True if the two objects are identical, False otherwise.

Syntax

SpssServerConf.IsEqualTo (serverConf)
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Parameters

| serverConf An SpssServerConf object

IsLocalServer Method

Indicates whether the associated instance of IBM® SPSS® Statistics Server represents the local
server. The result is Boolean—True if this server is the local server, False otherwise.

Syntax

SpssServerConf.IsLocalServer ()

IsPasswordSaved Method

Indicates whether the password is saved in the server configuration. The result is Boolean—7rue
if the password is saved, False otherwise.

Syntax

SpssServerConf .IsPasswordSaved ()

SetDefaultServer Method

Specifies whether the associated instance of IBM® SPSS® Statistics Server is set as the default
server.

Syntax

SpssServerConf.SetDefaultServer (defaultServerFlag)

Parameters

| defaultServerFlag True to set as the default server, False otherwise.

SetDescription Method

Sets the description text for the associated server configuration.

Syntax

SpssServerConf.SetDescription (description)
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SetPassword Method

Sets the password to be used by this server configuration.

Syntax

SpssServerConf . SetPassword (password)

SetPasswordSaved Method

Specifies whether the password is saved in the server configuration.

Syntax

SpssServerConf.SetPasswordSaved (savePassword)

Parameters
savePassword True if the password is to be saved for future use,
False otherwise.
SetServerName Method

Sets the machine name or IP address for the associated instance of IBM® SPSS® Statistics Server.

Syntax

SpssServerConf.SetServerName (serverName)

SetServerPort Method

Sets the port number for the associated instance of IBM® SPSS® Statistics Server.

Syntax

SpssServerConf.SetServerPort (port)

Parameters

| port An integer

SetUserDomain Method

Sets the domain for the current user ID.
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Syntax

SpssServerConf.SetUserDomain (domain)

| domain A string

SetUserld Method

Sets the user ID for the associated server configuration.

Syntax

SpssServerConf.SetUserId (userId)

SetUseSSL Method

Specifies the setting for using SSL (Secure Sockets Layer) with the associated instance of IBM®
SPSS® Statistics Server. SSL is a commonly used protocol for managing the security of message
transmission on the Internet.

Syntax

SpssServerConf.SetUseSSL (useSSL)

Parameters

| useSSL True to use SSL, False otherwise.

SpssServerConflist Class

The SpssServerConfList class allows you to manage the list of configured servers,
which includes the local computer. You obtain an SpssServerConfList object from the
GetConfiguredServers method of the SpssClient class.

An SpssServerConfList object is not an iterable Python object. In order to iterate over the
items in the list, use a £or loop, as in:

for index in range (SpssServerConflList.Size()):

For an example that uses the SpssServerConfList class, see the example for the
SpssServerConf class.

Add Method

Adds a server configuration to the list of available servers.
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Syntax

SpssServerConflist.Add (serverConf)

Parameters

| serverConf An SpssServerConf object.

Server configuration objects are created with the CreateNewServer method in the SpssClient
class.

Clear Method

Clears the list of server configurations, including the local computer.

Syntax

SpssServerConflList.Clear ()

Contains Method

Indicates if the specified server configuration is a member of the list of available server
configurations. The result is a Boolean—T7rue if the specified server configuration object is equal
to a member of the list of available server configuration objects, False otherwise.

Syntax

SpssServerConflList.Contains (serverConf)

Parameters

|smvm(bnf An SpssServerConf object

GetltemAt Method

Returns an SpssServerConf object corresponding to the server configuration with the specified
index. The index corresponds to the order in which the server configurations were created.

Syntax

SpssServerConf=SpssServerConflList.GetItemAt (index)
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Remove Method

Removes the first occurrence of the specified server configuration from the list of available server
configurations. There is no effect if the list does not contain the specified server configuration
object.

Syntax

SpssServerConflist.Remove (serverConf)

Parameters

| serverConf An SpssServerConf object

RemoveltemAt Method

Removes the server configuration with the specified index from the list of available server
configurations. The index corresponds to the order in which the server configurations were created.

Syntax

SpssServerConflList.RemoveItemAt (index)

Size Method

Returns the number of configured servers, including the local computer.

Syntax

SpssServerConflList.Size ()
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SpssScriptContext Class

The SpssScriptContext class provides access to the object that triggers an autoscript as
well as the associated output document object. Autoscripts are scripts that run automatically
when triggered by the creation of specific pieces of output from selected procedures. Scripts are
specified as autoscripts and associated with output items (that trigger them) from the Scripts
tab of the Options dialog.

SpssScriptContext objects are only for use when writing a script that will be used as an
autoscript. They have a value of None if referenced by a script that is not being run as an autoscript.

You get an SpssScriptContext object from the GetScriptContext method of the SpssClient
object.

Example: Get the Output Item that Triggered an Autoscript

import SpssClient

SpssClient.StartClient ()

SpssScriptContext = SpssClient.GetScriptContext ()
SpssOutputItem = SpssScriptContext.GetOutputItem()

The GetOutputItem method of the SpssScriptContext object returns the output item
(SpssOutputItem object) that triggered the current autoscript.

GetOutputDoc Method

Returns an SpssOutputDoc object representing the output document associated with the current
autoscript.

Syntax

SpssOutputDoc=SpssScriptContext.GetOutputDoc ()

GetOutputitem Method

Returns an SpssoOutputItem object representing the output item that triggered the current
autoscript.

Syntax
SpssOutputItem=SpssScriptContext.GetOutputItem()

Note: To obtain an object of a specific output type, such as a pivot table or header item, from an
SpssOutputItem object, call the GetSpecificType method of the SpssOutputItem object.
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GetOutputitemindex Method

Returns the index, in the associated output document, of the output item that triggered the current
autoscript. The index corresponds to the order of the items in the output document, starting
with O for the root item.

Syntax

SpssScriptContext.GetOutputItemIndex ()
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Appendix

A

Color values are expressed as integers. If you’re accustomed to specifying colors in RGB format,
you can convert to the associated integer using the following:

integer color value = R + G¥*(256) + B*(256/2)

where R, G, and B are the RGB values. For reference, following are some of the most common

colors and their integer values:

Color Integer Value
Black 0

Blue 16711680
Cyan 16776960
Green 65280
Magenta 16711935
Red 255

White 16777215
Yellow 65535
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Export options are retrieved from the GetExportOption method of the SpssClient class

and set from the SetExportOption method of that class. The option identifiers have the form
SpssClient.ExportOptions.<options, where the available option values are listed
below—for example, SpssClient .ExportOptions.GraphExportType. All of the settings

are strings.

Option Valid Settings

ObjectsToExport “all”, “visible”, “selected”

DocExportType “excel”, “html”, “pdf”, “plain”, “utf8”, “utf16”,
“word_rtf”, “none” (graphics only)

DocFilePath Export document file path

GraphExportType “bmp”, “emf”, “eps”, “jpg”, “png”, “tiff”

GraphFilePath Export graph file path

XLSLayers “all”, “honor” (honors print layer setting), “visible”

XLSFootnotes “No”, “Yes”

HTMLayers “all”, “honor” (honors print layer setting), “visible”

HTMFootnotes “No”, “Yes”

WordRTFLayers “all”, “honor” (honors print layer setting), “visible”

WordRTFFootnotes “No”, “Yes”

TXTPlainTabsOrSpaces “tabs”, “spaces”

TXTPlainColumnWidthType “autofit”, “custom”

TXTPlainNoOfChars Character representation of integer

TXTPlainRowBorderChar

Row border character

TXTPlainColBorderChar

Column border character

TxtPlainLayersInPivotTable

“all”, “honor” (honors print layer setting), “visible”

TXTPlainFootnoteCaption

“NO”, “YeS”

TXTPlainInsertPageBreak

“NO”, “YeS”

TXTUTF8TabsOrSpaces “tabs”, “spaces”
TXTUTF8ColumnWidthType “autofit”, “custom”
TXTUTF8NoOfChars Character representation of integer
TXTUTF8RowBorderChar Row border character
TXTUTF8ColBorderChar Column border character

TxtUTF8LayersInPivotTable

“all”, “honor” (honors print layer setting), “visible”

TXTUTF8FootnoteCaption

“NO”, “Yesu

TXTUTF8InsertPageBreak

“NO”, “Yesu

TXTUTF16TabsOrSpaces “tabs”, “spaces”
TXTUTF16ColumnWidthType “autofit”, “custom”
TXTUTF16NoOfChars Character representation of integer

TXTUTF16RowBorderChar

Row border character

TXTUTF16ColBorderChar

Column border character

TxtUTF16LayersInPivotTable

“all”, “honor” (honors print layer setting), “visible”
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TXTUTF16FootnoteCaption “No”, “Yes”

TXTUTF16InsertPageBreak “No”, “Yes”

PDFOptimize “No”, “Yes”

PDFEmbedBookmarks “No”, “Yes”

PDFEmbedFonts “No”, “Yes”

PDFLayers “all”, “honor” (honors print layer setting), “visible”

JPEGSize Character representation of image size in percent

JPEGGreyScale “No”, “Yes”

BMPSize Character representation of image size in percent

BMPCompressImage “no”, “yes”

PNGSize Character representation of image size in percent

PNGColorDepth “current” (current screen depth), “bw” (black and
white), “256gray”, “l16color”, “256¢color”, “24bit”
(true color), “32bit” (true color)

TIFSize Character representation of image size in percent

EPSSize “physical_size” (same aspect ratio), “current_size”

EPSPercent Character representation of image size in percent.
Applies to “current_size”.

EPSWidthPoints Character representation of image width in points.
Applies to “physical size”.

EPSPreviewImage “no”, “yes”

EPSFont “replace _font”, “use_font ref”
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String Description of Numeric Formats

If you are using a localized version of IBM® SPSS® Statistics, use the strings displayed in the
Format list box on the Format Value tab (accessed from Format>Cell Properties in the pivot

table editor).

String Example / Description

##t 1234.567

#.#:# HHE-H# 1234.567(scientific notation if the cell is not wide
enough)

# 1,234.567

# A 1.234,567

HAHHE 1.23E+03

HHH% 56.7%

dd.mmm.yy 28-0OCT-94

dd-mmm-yyyy 28-0OCT-199%4

mm/dd/yy 10/28/94

mm/dd/yyyy 10/28/1994

dd.mm.yy 28.10.94

dd.mm.yyyy 28.10.1994

yy/mm/dd 94/10/28

yyyy/mm/dd 1994/10/28

yyddd 94301 (Julian date)

yyyyddd 1994301 (Julian date)

qQyy 4Q9%4

q Q yyyy 4Q 1994

mmm yy OCT %4

mmm yyyy OCT 1994

ww WK yy 43 WK 94

ww WK yyyy 43 WK 1994

dd-mmm-yyyy hh:mm 28-0OCT-1994 08:03

dd-mmm-yyyy hh:mm:ss 28-OCT-1994 08:03:00

ddd.hh.mm 301 20:03

ddd.hh/mm.ss. ## 301 20:03:00.04

Monday, Tuesday... Friday

January, February... October

hh:mm 08:03

hh:mm:ss.## 08:03:00.04

S# i H## $1,234.56

You can create up to five custom currency display formats that can include special prefix and suffix
characters and special treatment for negative values. The five custom currency format names are
CCA, CCB, CCC, CCD, and CCE. The string can be used to specify the currency formats.
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Preference options are retrieved from the GetPreference method of the SpssClient class
and set from the SetPreference method of that class. The option identifiers have the form
SpssClient.PreferenceOptions.<options>, where the available option values are listed
below—for example, SpssClient .PreferenceOptions.VariableListDisplay. All

of the settings are strings.

General Options

Option Valid Settings

VariableListDisplay “labels”, “names”

VariableListSort “alphabetical”, “file”, “measurement”

MeasurementSystem “points”, “inches”, “centimeters”

Language “Russian”, “French”, “German”, “English”,
“Italian”, “Japanese”, “Korean”, “Polish”,
“SChinese”, “Spanish”, “TChinese”,

AutoRaise “true”, “false”

OutputScroll “true”, “false”

OutputSound “system_beep”, “none”, “sound”

OutputSoundFile Path to a custom sound file

ScientificNotation “true”, “false”

DigitGrouping Option associated with SET/SHOW
DIGITGROUPING. Settings are “true” or
“false”.

OpenSyntaxAtStartup “true”, “false”

OnlyOneDataset “true”, “false”

OXMLVersion Option associated with SET/SHOW XVERSION.
Settings are “default” or the Output XML schema
version.

OutputAttributes Option associated with SET/SHOW OATTRS.

CLINT3

Settings are “olang”, “eng”, or “both”.

Viewer Options

Option Valid Settings

TitleFont Font name, e.g. “Serif”

TitleFontSize Character representation of integer
TitleFontBold “true”, “false”

TitleFontltalic “true”, “false”

TitleFontUnderline “true”, “false”

TitleFontColor Character representation of integer color
PageTitleFont Font name, e.g. “Serif”
PageTitleFontSize Character representation of integer
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PageTitleFontBold “true”, “false”

PageTitleFontltalic “true”, “false”

PageTitleFontUnderline “true”, “false”

PageTitleFontColor Character representation of integer color
TextOutputFont Font name, e.g. “Serif”
TextOutputFontSize Character representation of integer
TextOutputFontBold “true”, “false”

TextOutputFontltalic “true”, “false”

TextOutputFontUnderline “true”, “false”

TextOutputFontColor Character representation of integer color
DisplayCommandsLog “Oft”, “On”

LogContents “hidden”, “shown”

WarningsContents “hidden”, “shown”

WarningsJustification “align_left”, “align_center”, “align_right”
NotesContents “hidden”, “shown”

NotesJustification “align_left”, “align_center”, “align_right”
TitleContents “hidden”, “shown”

TitleJustification “align_left”, “align_center”, “align_right”
PageTitleContents “hidden”, “shown”

PageTitleJustification “align_left”, “align_center”, “align_right”
PivotTableContents “hidden”, “shown”
PivotTableJustification “align_left”, “align_center”, “align_right”
ChartContents “hidden”, “shown”

ChartJustification “align_left”, “align_center”, “align_right”
TextOutputContents “hidden”, “shown”

TreeModelContents “hidden”, “shown”

Genericlustification “align_left”, “align_center”, “align_right”

Data Options

Option

Valid Settings

TransformationMergeOptions

“calculate_before_used”, “calculate_immediately”

RandomNumberGenerator

“MC” (compatible with SPSS 12 and earlier), “MT”
(Mersenne Twister)

DisplayFormatWidth Character representation of integer between 1 and 40.
DisplayFormatDecimal Character representation of integer between 0and 15.
ReadingExternalData Character representation of integer between 1 and 40.
CenturyRangeValue “Automatic”, “custom”

CenturyRangeBeginYear Character representation of integer between 1582 and 9900.

File Locations

Option Valid Settings
RecordSyntax “false”, “true”
RecordMode “append”, “overwrite”
SessionJournalFile Path to journal file
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TempDir Path to temp directory

RecentFiles Recently used file list. Character representation of
integer between 0 and 9.

DataFiles Path to startup folder for data files on Open and
Save dialogs

OtherFiles Path to startup folder for other files on Open and
Save dialogs

SpecifiedAndLastFolder “true” (last folder used), “false” (specified folder)

Currency Options

Option Valid Settings
CustomOutputFormat “CCA”, “CCB”, “CCC”, “CCD”, “CCE”
AllValuesPrefix All values prefix
AllValuesSuffix All values suffix
NegativeValuesPrefix Negative values prefix
NegativeValuesSuffix Negative values suffix
DecimalSeparator “comma”, “period”

Output Options

Option Valid Settings
OutlineVariables “Names”, “Labels”, “Both”
OutlineVariableValues “Values”, “Labels”, “Both”
PivotTableVariables “Names”, “Labels”, “Both”
PivotTableVariableValues “Values”, “Labels”, “Both”
OutputDisplay “ModelViewer”, “Tables”
Chart Options

Option Valid Settings
ChartTemplate “On”, “Off”
ChartTemplateFile Path to chart template file
ChartAspectRatio Chart aspect ratio
ChartFont Font name, e.g. “Arial”
ChartFramelnner “true”, “false”
ChartFrameOuter “true”, “false”
GridLineScale “true”, “false”
GridLineCategory “true”, “false”
StyleCyclePref “ColorsOnly”, “PatternsOnly”

Pivot Table Options

Option

Valid Settings

ColumnWidth

“Labels”, “Both” (labels and data)
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RT3

EditingMode “all_tables”, “large_tables”, “open_tables window”

TableRender “full”, “fast”, “light” (alias for “fast”)

Note: For the TableRender option, "1light" is deprecated for release 20 and higher, and has
the same effect as "fast".
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Notices

This information was developed for products and services offered worldwide.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently
available in your area. Any reference to an IBM product, program, or service is not intended to
state or imply that only that IBM product, program, or service may be used. Any functionally
equivalent product, program, or service that does not infringe any IBM intellectual property right
may be used instead. However, it is the user’s responsibility to evaluate and verify the operation
of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents.
You can send license inquiries, in writing, to:

IBM Director of Licensing, IBM Corporation, North Castle Drive, Armonk, NY 10504-1785,
US.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing, Legal and Intellectual Property Law, IBM Japan Ltd., 1623-14,
Shimotsuruma, Yamato-shi, Kanagawa 242-8502 Japan.

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES
PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND,
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties
in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are
periodically made to the information herein; these changes will be incorporated in new editions
of the publication. IBM may make improvements and/or changes in the product(s) and/or the
program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and
do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites
are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate
without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including
this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Software Group, Attention: Licensing, 233 S. Wacker Dr., Chicago, IL 60606, USA.
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Such information may be available, subject to appropriate terms and conditions, including in
some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are
provided by IBM under terms of the IBM Customer Agreement, IBM International Program
License Agreement or any equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of those products,
their published announcements or other publicly available sources. IBM has not tested those
products and cannot confirm the accuracy of performance, compatibility or any other claims
related to non-IBM products. Questions on the capabilities of non-IBM products should be
addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations.

To illustrate them as completely as possible, the examples include the names of individuals,
companies, brands, and products. All of these names are fictitious and any similarity to the names
and addresses used by an actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not
appear.
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many jurisdictions worldwide. A current list of IBM trademarks is available on the Web at
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Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or
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Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel
Corporation or its subsidiaries in the United States and other countries.

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

This product uses WinWrap Basic, Copyright 1993-2007, Polar Engineering and Consulting,
http://www.winwrap.com.

Other product and service names might be trademarks of IBM or other companies.
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Add method
SpssServerConfList class, 196
alignment, 107, 113, 118, 123, 128, 132, 139, 143, 146,
150, 155, 160, 168, 172, 176, 180, 183, 186
cells, 107, 118, 128, 155, 168
decimal, 107, 118, 128
foonotes, 139, 146, 176, 183
labels, 118, 128, 139, 146, 155, 168, 176, 183
vertical, 113, 123, 132, 143, 150, 160, 172, 180, 186
Append method
SpssLogltem class, 88
areas, 105
background color, 105
Autofit method
SpssPivotTable class, 96
autoscripts
Python, 5

BreakHere method
SpssLabels class, 154

ChangeMarkerToRegular method
SpssFootnotes class, 137
ChangeMarkerToSpecial method
SpssFootnotes class, 138
Clear method
SpssServerConfList class, 197
ClearSelection method
SpssOutputDoc class, 36
SpssPivotTable class, 96
CloseDocument method
SpssDataDoc class, 24
SpssOutputDoc class, 36
SpssSyntaxDoc class, 63
colors, 201
setting color values, 201
ColumnLabelArray method
SpssPivotTable class, 97
Connect method
SpssServerConf class, 191
ConnectWithSavedPassword method
SpssServerConf class, 191
Contains method
SpssServerConfList class, 197
Copy method
SpssOutputDoc class, 36
CopySpecial method
SpssOutputDoc class, 36
CreateHeaderItem method
SpssOutputDoc class, 37
CreateImageChartltem method
SpssOutputDoc class, 38
CreateNewServer method
SpssClient class, 9

© Copyright IBM Corporation 1989, 2012.

CreateTextItem method
SpssOutputDoc class, 38

CreateTitleltem method
SpssOutputDoc class, 39

Cut method
SpssOutputDoc class, 39

data regions, 98, 100
height and width, 98, 100
DataCellArray method
SpssPivotTable class, 97
DataCellWidths method
SpssPivotTable class, 106
DataDocsList class, 28
GetltemAt method, 28
Size method, 29
Delete method
SpssOutputDoc class, 39
Demote method
SpssOutputDoc class, 39
Dimension class
LayerDimension method, 187
Disconnect method
SpssServerConf class, 192
DisplayTableByRows method
SpssPivotTable class, 97

Exit method
SpssClient class, 10
ExportAllViews method
SpssModelltem class, 84
ExportCharts method
SpssOutputDoc class, 40
ExportDocument method
SpssOutputDoc class, 41
ExportToDocument method
SpssOutputltem class, 73
ExportTolmage method
SpssOutputltem class, 74

FootnotesArray method
SpssPivotTable class, 97
frames, 105
background color, 105

GetActiveDataDoc method
SpssClient class, 10

GetAlignment method
SpssOutputltem class, 74

GetBackgroundColorAt method
SpssDataCells class, 117
SpssFootnotes class, 138
SpssLabels class, 154
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SpssLayerLabels class, 175
GetBottomMarginAt method
SpssDataCells class, 117
SpssFootnotes class, 139

SpssLabels class, 154
SpssLayerLabels class, 176
GetCaptionText method
SpssPivotTable class, 97
GetCaseCount method
SpssDataDoc class, 24
GetCategory ValueAt method
SpssDimension class, 134
GetChildCount method
SpssHeaderltem class, 85
GetChildItem method
SpssHeaderlItem class, 86
GetColumnDimension method
SpssPivotMgr class, 187
GetColumnLabelWidthAt method
SpssLabels class, 155
GetConfiguredServers method
SpssClient class, 10
GetCount method
SpssFootnotes class, 139
GetCurrentCategory method
SpssDimension class, 135
GetCurrentDirectory method
SpssClient class, 10
GetCurrentltem method
SpssOutputDoc class, 42
GetCurrentServer method
SpssClient class, 10
GetDataDocuments method
SpssClient class, 11
GetDatasetName method
SpssDataDoc class, 25
GetDataUI method
SpssDataDoc class, 25
GetDefaultJCVersion method
SpssClient class, 11
GetDefaultServer method
SpssClient class, 11
GetDescription method
SpssOutputltem class, 75
SpssServerConf class, 192
GetDesignatedOutputDoc method
SpssClient class, 11
GetDesignatedSyntaxDoc method
SpssClient class, 12
GetDimensionName method
SpssDimension class, 135
GetDocumentPath method
SpssDataDoc class, 25
SpssOutputDoc class, 42
SpssSyntaxDoc class, 64
GetExportOption method
SpssClient class, 12

Index

GetFooterText method
SpssOutputDoc class, 42
GetFootnoteMarkersPosition method
SpssPivotTable class, 98
GetFootnoteMarkersStyle method
SpssPivotTable class, 98
GetForegroundColorAt method
SpssDataCells class, 117
SpssFootnotes class, 139
SpssLabels class, 155
SpssLayerLabels class, 176
GetFullDimensionLabel method
SpssDimension class, 135
GetHAlignAt method
SpssDataCells class, 118
SpssFootnotes class, 139
SpssLabels class, 155
SpssLayerLabels class, 176
GetHDecDigitsAt method
SpssDataCells class, 118
GetHeaderText method
SpssOutputDoc class, 42
GetHeight method
SpssDataUI class, 29
SpssOutputltem class, 75
SpssOutputUI class, 57
SpssPivotTable class, 98
SpssSyntaxUI class, 68
GetltemAt method
DataDocsList class, 28
MenuTableList class, 92
OutputDocsList class, 56
OutputltemList class, 57
SpssServerConfList class, 197
SyntaxDocsList class, 67
GetLeft method
SpssDataUI class, 29
SpssOutputUI class, 57
SpssSyntaxUI class, 68
GetLeftMarginAt method
SpssDataCells class, 118
SpssFootnotes class, 140
SpssLabels class, 156
SpssLayerLabels class, 176
GetLocale method
SpssClient class, 12
GetLocalServer method
SpssClient class, 12
GetMenuTable method
SpssDataDoc class, 25
SpssOutputDoc class, 42
SpssSyntaxDoc class, 64
GetNumCategories method
SpssDimension class, 135
GetNumColumnDimensions method
SpssPivotMgr class, 188
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GetNumColumns method
SpssDataCells class, 119
SpssLabels class, 156

GetNumDimensions method
SpssLayerLabels class, 177

GetNumericFormatAt method
SpssDataCells class, 119

GetNumericFormatAtEx method
SpssDataCells class, 119

GetNumLabelsWide method
SpssLayerLabels class, 177

GetNumLayerDimensions method
SpssPivotMgr class, 188

GetNumRowDimensions method
SpssPivotMgr class, 188

GetNumRows method
SpssDataCells class, 120
SpssLabels class, 156

GetOutputDoc method
SpssScriptContext class, 199

GetOutputDocuments method
SpssClient class, 12

GetOutputltem method
SpssScriptContext class, 199

GetOutputltemIndex method
SpssScriptContext class, 200

GetOutputltems method
SpssOutputDoc class, 43

GetOutputOptions method
SpssOutputDoc class, 43

GetOutputUI method
SpssOutputDoc class, 45

GetPageBreak method
SpssOutputltem class, 75

GetParentItem method
SpssOutputltem class, 75

GetPreference method
SpssClient class, 13

GetPrintOptions method
SpssOutputDoc class, 45

GetProcedureName method
SpssOutputltem class, 76

GetReferredFootnotesAt method
SpssDataCells class, 120
SpssLabels class, 156

GetRightMarginAt method
SpssDataCells class, 121
SpssFootnotes class, 140
SpssLabels class, 157
SpssLayerLabels class, 177

GetRotateColumnLabels method
SpssPivotTable class, 98

GetRotateRowLabels method
SpssPivotTable class, 99

GetRowDimension method
SpssPivotMgr class, 188

GetRowLabelWidthAt method
SpssLabels class, 157
GetScriptContext method
SpssClient class, 13
GetServerName method
SpssServerConf class, 192
GetServerPort method
SpssServerConf class, 192
GetShowGridLines method
SpssDataUI class, 29
GetShowValueLabels method
SpssDataUI class, 30
GetSpecificType method
SpssOutputltem class, 76
GetSplitterPosition method
SpssOutputUI class, 58
GetSPSSOptions method
SpssClient class, 13
GetSPSSPath method
SpssClient class, 14
GetSPSSVersion method
SpssClient class, 14
GetSubType method
SpssOutputltem class, 76
GetSyntax method
SpssSyntaxDoc class, 64
GetSyntaxDocuments method
SpssClient class, 14
GetSyntaxUI method
SpssSyntaxDoc class, 64
GetTextColorAt method
SpssDataCells class, 121
SpssFootnotes class, 140
SpssLabels class, 157
SpssLayerLabels class, 177
GetTextContents method
SpssLogltem class, 88
SpssMenultem class, 93
SpssTextltem class, 89
SpssTitleltem class, 90
GetTextFontAt method
SpssDataCells class, 121
SpssFootnotes class, 141
SpssLabels class, 158
SpssLayerLabels class, 178
GetTextHiddenAt method
SpssDataCells class, 122
SpssFootnotes class, 141
SpssLabels class, 158
SpssLayerLabels class, 178
GetTextSizeAt method
SpssDataCells class, 122
SpssFootnotes class, 142
SpssLabels class, 158
SpssLayerLabels class, 178
GetTextStyleAt method
SpssDataCells class, 122
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SpssFootnotes class, 142
SpssLabels class, 159
SpssLayerLabels class, 179
GetTextUnderlinedAt method
SpssDataCells class, 123
SpssFootnotes class, 142
SpssLabels class, 159
SpssLayerLabels class, 179
GetTextWidthAt method
SpssLabels class, 160
GetTitleText method
SpssDataUI class, 30
SpssOutputUI class, 58
SpssPivotTable class, 99
SpssSyntaxUI class, 68
GetTop method
SpssDataUI class, 30
SpssOutputUI class, 58
SpssSyntaxUI class, 69
GetTopMarginAt method
SpssDataCells class, 123
SpssFootnotes class, 143
SpssLabels class, 160
SpssLayerLabels class, 179
GetTreeLevel method
SpssOutputltem class, 76
GetType method
SpssOutputltem class, 77
GetTypeString method
SpssOutputltem class, 78
GetUIAlerts method
SpssClient class, 14
GetUnformatted ValueAt method
SpssDataCells class, 124
GetUpdateScreen method
SpssPivotTable class, 99
GetUserDomain method
SpssServerConf class, 193
GetUserld method
SpssServerConf class, 193
GetUseSSL method
SpssServerConf class, 193
GetVAlignAt method
SpssDataCells class, 123
SpssFootnotes class, 143
SpssLabels class, 160
SpssLayerLabels class, 180
GetValueAt method
SpssDataCells class, 124
SpssFootnotes class, 144
SpssLabels class, 161
SpssLayerLabels class, 180
GetVariableCount method
SpssDataDoc class, 25
GetVarNamesDisplay method
SpssPivotTable class, 99

Index

GetVarValuesDisplay method
SpssPivotTable class, 100
GetVisible method
SpssDataUI class, 30
SpssOutputUI class, 58
SpssSyntaxUI class, 69
GetWidoworphanLines method
SpssPivotTable class, 100
GetWidth method
SpssDataUI class, 30
SpssOutputltem class, 78
SpssOutputUI class, 58
SpssPivotTable class, 100
SpssSyntaxUI class, 69
GetWindowState method
SpssDataUI class, 30
SpssOutputUI class, 59
SpssSyntaxUI class, 69
GetXML method
SpssOutputltem class, 78
graphboard chart, 49, 77-78, 83
Group method
SpssPivotTable class, 101

HideAllLabelsInDimensionAt method
SpssLabels class, 161
HideCaption method
SpssPivotTable class, 101
HideFootnote method
SpssPivotTable class, 101
HideFootnotesAt method
SpssDataCells class, 125
SpssLabels class, 161
SpssLayerLabels class, 180
HideLabel method
SpssDimension class, 135
HideLabelsInDimensionAt method
SpssLabels class, 161
HideLabelsWithDataAt method
SpssLabels class, 162
HideTitle method
SpssPivotTable class, 102

InsertBefore method
SpssLabels class, 162
InsertChildItem method
SpssHeaderltem class, 86
InsertFootnote method
SpssPivotTable class, 102
InsertNewA fter method
SpssLabels class, 162
InsertNewBefore method
SpssLabels class, 163
InsertNewFootnote At method
SpssDataCells class, 125
SpssLabels class, 163
SpssLayerLabels class, 181
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InsertSharedFootnote At method
SpssDataCells class, 126
SpssLabels class, 164
SpssLayerLabels class, 181

InsertTable method
SpssOutputDoc class, 45

InvokeDialog method
SpssDataUI class, 31
SpssOutputUI class, 59
SpssSyntaxUI class, 69

IsActiveDataDoc method
SpssDataDoc class, 26

IsCurrentltem method
SpssOutputltem class, 79

IsDataDocInUse method
SpssClient class, 15

IsDefaultServer method
SpssServerConf class, 193

IsDesignatedOutputDoc method
SpssOutputDoc class, 46

IsDesignatedSyntaxDoc method
SpssSyntaxDoc class, 64

IsDisplayTableByRows method
SpssPivotTable class, 102

IsDistributedMode method
SpssClient class, 15

IsEditable method
SpssOutputltem class, 79

IsEqualTo method
SpssDataDoc class, 26
SpssOutputDoc class, 46
SpssOutputltem class, 79
SpssServerConf class, 193
SpssSyntaxDoc class, 65

IsExpanded method
SpssHeaderltem class, 87

IsLocalServer method
SpssServerConf class, 194

IsModified method
SpssDataDoc class, 26
SpssOutputDoc class, 47
SpssSyntaxDoc class, 65

IsOptionAvailable method
SpssClient class, 15

IsPasswordSaved method
SpssServerConf class, 194

IsPromptToSave method
SpssDataDoc class, 26
SpssOutputDoc class, 47
SpssSyntaxDoc class, 65

IsSelected method
SpssOutputltem class, 79

IsVisible method
SpssOutputltem class, 80

KeepTogether method
SpssLabels class, 165

LayerDimension method
Dimension class, 187

LayerLabelArray method
SpssPivotTable class, 102

legacy tables, 95

legal notices, 209

LogToViewer method
SpssClient class, 16

MenuTableList class, 92
GetltemAt method, 92
Size method, 92
Model Viewer item, 49, 77-78
MoveLayersToColumns method
SpssPivotMgr class, 189
MoveLayersToRows method
SpssPivotMgr class, 189
MoveToColumn method
SpssDimension class, 135
MoveToLayer method
SpssDimension class, 136
MoveToRow method
SpssDimension class, 136

NavigateToFirstRow method
SpssPivotTable class, 103
NavigateToLastRow method
SpssPivotTable class, 103
NavigateToNextRows method
SpssPivotTable class, 103
NavigateToPreviousRows method
SpssPivotTable class, 103
NewDataDoc method
SpssClient class, 16
NewOutputDoc method
SpssClient class, 16
NewSyntaxDoc method
SpssClient class, 17
NumericFormat method
SpssPivotTable class, 104

OpenDataDoc method
SpssClient class, 17
OpenOutputDoc method
SpssClient class, 17
OpenSyntaxDoc method
SpssClient class, 18
OutputDocsList class, 56
GetltemAt method, 56
Size method, 56

OutputltemList class, 56
GetltemAt method, 57
Size method, 57

Paste method
SpssOutputDoc class, 47
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PasteBefore method
SpssOutputDoc class, 47
pivot tables
legacy tables, 95
PivotManager method
SpssPivotTable class, 104
PrintDataDoc method
SpssDataUI class, 31
PrintOutputDoc method
SpssOutputUI class, 59
PrintRange method
SpssOutputDoc class, 47
PrintSyntaxDoc method
SpssSyntaxUI class, 70
Promote method
SpssOutputDoc class, 48
Python
autoscripts, 5
debugging, 22

R graphics, 49, 77-78, 83
Remove method
SpssServerConfList class, 198
RemoveBreakHere method
SpssLabels class, 165
RemoveChildItem method
SpssHeaderltem class, 87
RemoveltemAt method
SpssServerConfList class, 198
RemoveKeepTogether method
SpssLabels class, 165
RenumberFootnotes method
SpssFootnotes class, 144
reordering labels, 174
ReSizeColumn method
SpssDataCells class, 126
RowLabelArray method
SpssPivotTable class, 104
RunSyntax method
SpssClient class, 18
SpssSyntaxDoc class, 65

SaveAs method
SpssDataDoc class, 26
SpssOutputDoc class, 48
SpssSyntaxDoc class, 66

SaveServers method
SpssClient class, 19

ScriptParameter method
SpssClient class, 20

SelectAll method
SpssOutputDoc class, 49

SelectAllCharts method
SpssOutputDoc class, 49

SelectAllFootnotes method
SpssPivotTable class, 104

Index

SelectAllLogs method
SpssOutputDoc class, 49
SelectAllModels method
SpssOutputDoc class, 49
SelectAllNotes method
SpssOutputDoc class, 49
SelectAllOther method
SpssOutputDoc class, 50
SelectAllTables method
SpssOutputDoc class, 50
SelectAllText method
SpssOutputDoc class, 50
SelectAllTitles method
SpssOutputDoc class, 51
SelectAllWarnings method
SpssOutputDoc class, 51
SelectCaption method
SpssPivotTable class, 104
SelectCellAt method
SpssDataCells class, 126
SpssFootnotes class, 144
SelectCorner method
SpssPivotTable class, 105
SelectDataUnderLabel At method
SpssLabels class, 166
SelectLabel At method
SpssLabels class, 166
SpssLayerLabels class, 182
SelectLabelDataAt method
SpssLabels, 166
SelectLastOutput method
SpssOutputDoc class, 51
SelectReferredFootnotesAt method
SpssDataCells class, 127
SpssLabels class, 166
SpssLayerLabels class, 182
SelectTable method
SpssPivotTable class, 105
SelectTableBody method
SpssPivotTable class, 105
SelectTitle method
SpssPivotTable class, 105
SetAlignment method
SpssOutputltem class, 80
SetAsActiveDataDoc method
SpssDataDoc class, 27
SetAsDesignatedOutputDoc method
SpssOutputDoc class, 51
SetAsDesignatedSyntaxDoc method
SpssSyntaxDoc class, 66
SetBackgroundColor method
SpssPivotTable class, 105
SetBackgroundColorAt method
SpssDataCells class, 127
SpssFootnotes class, 145
SpssLabels class, 167
SpssLayerLabels class, 182
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SetBottomMargin method
SpssPivotTable class, 106
SetBottomMarginAt method
SpssDataCells class, 127
SpssFootnotes class, 145
SpssLabels class, 167
SpssLayerLabels class, 183
SetCaptionText method
SpssPivotTable class, 106
SetColumnLabelWidthAt method
SpssLabels class, 168
SetCornerText method
SpssPivotTable class, 106
SetCurrentCategory method
SpssDimension class, 136
SetCurrentDirectory method
SpssClient class, 20
SetCurrentltem method
SpssOutputltem class, 80
SetDatasetName method
SpssDataDoc class, 27
SetDefaultJCVersion method
SpssClient class, 20
SetDefaultServer method
SpssServerConf class, 194
SetDescription method
SpssOutputltem class, 80
SpssServerConf class, 194
SetDimensionName method
SpssDimension class, 137
SetExpanded method
SpssHeaderltem class, 88
SetExportOption method
SpssClient class, 21
SetFooterText method
SpssOutputDoc class, 52
SetFootnoteMarkers method
SpssPivotTable class, 107
SetForegroundColor method
SpssPivotTable class, 107
SetForegroundColorAt method
SpssDataCells class, 128
SpssFootnotes class, 146
SpssLabels class, 168
SpssLayerLabels class, 183
SetHAlign method
SpssPivotTable class, 107
SetHAlignAt method
SpssDataCells class, 128
SpssFootnotes class, 146
SpssLabels class, 168
SpssLayerLabels class, 183
SetHDecDigits method
SpssPivotTable class, 107
SetHDecDigitsAt method
SpssDataCells class, 128

SetHeaderText method
SpssOutputDoc class, 52
SetHeight method
SpssDataUI class, 32
SpssOutputltem class, 81
SpssOutputUI class, 60
SpssSyntaxUI class, 70
SetLeft method
SpssDataUI class, 32
SpssOutputUI class, 60
SpssSyntaxUI class, 71
SetLeftMargin method
SpssPivotTable class, 108
SetLeftMarginAt method
SpssDataCells class, 129
SpssFootnotes class, 146
SpssLabels class, 168
SpssLayerLabels class, 183
SetModified method
SpssDataDoc class, 28
SpssOutputDoc class, 52
SpssSyntaxDoc class, 66
SetNumericFormatAt method
SpssDataCells class, 129

SetNumericFormatAtWithDecimal method

SpssDataCells class, 129
SetOutputOptions method
SpssOutputDoc class, 52
SetPageBreak method
SpssOutputltem class, 81
SetPassword method
SpssServerConf class, 195
SetPasswordSaved method
SpssServerConf class, 195
SetPreference method
SpssClient class, 21
SetPrintOptions method
SpssOutputDoc class, 55
SetProcedureName method
SpssOutputltem class, 81
SetPromptToSave method
SpssDataDoc class, 28
SpssOutputDoc class, 55
SpssSyntaxDoc class, 66
SetRightMargin method
SpssPivotTable class, 108
SetRightMarginAt method
SpssDataCells class, 129
SpssFootnotes class, 147
SpssLabels class, 169
SpssLayerLabels class, 184
SetRotateColumnLabels method
SpssPivotTable class, 108
SetRotateRowLabels method
SpssPivotTable class, 109
SetRowLabelWidthAt method
SpssLabels class, 169
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SetRowsToDisplayRowCount method
SpssPivotTable class, 109
SetRowsToDisplayTolerance method
SpssPivotTable class, 109
SetSelected method
SpssOutputltem class, 81
SetServerName method
SpssServerConf class, 195
SetServerPort method
SpssServerConf class, 195
SetShowGridLines method
SpssDataUI class, 32
SetShow ValueLabels method
SpssDataUI class, 32
SetSplitterPosition method
SpssOutputUI class, 60
SetSubType method
SpssOutputltem class, 82
SetSyntax method
SpssSyntaxDoc class, 66
SetTableLook method
SpssPivotTable class, 110
SetTextColor method
SpssPivotTable class, 110
SetTextColorAt method
SpssDataCells class, 130
SpssFootnotes class, 147
SpssLabels class, 169
SpssLayerLabels class, 184
SetTextContents method
SpssLogltem class, 89
SpssTextltem class, 90
SpssTitleltem class, 90
SetTextFont method
SpssPivotTable class, 111
SetTextFontAt method
SpssDataCells class, 130
SpssFootnotes class, 148
SpssLabels class, 170
SpssLayerLabels class, 184
SetTextHidden method
SpssPivotTable class, 111
SetTextHiddenAt method
SpssDataCells class, 130
SpssFootnotes class, 148
SpssLabels class, 170
SpssLayerLabels class, 185
SetTextSize method
SpssPivotTable class, 111
SetTextSizeAt method
SpssDataCells class, 131
SpssFootnotes class, 148
SpssLabels class, 170
SpssLayerLabels class, 185
SetTextStyle method
SpssPivotTable class, 111

Index

SetTextStyleAt method
SpssDataCells class, 131
SpssFootnotes class, 149
SpssLabels class, 171
SpssLayerLabels class, 185

SetTextUnderlined method
SpssPivotTable class, 112

SetTextUnderlined At method
SpssDataCells class, 132
SpssFootnotes class, 149
SpssLabels class, 171
SpssLayerLabels class, 186

SetTitleText method
SpssPivotTable class, 112

SetTop method
SpssDataUI class, 33
SpssOutputUI class, 61
SpssSyntaxUI class, 71

SetTopMargin method
SpssPivotTable class, 112

SetTopMarginAt method
SpssDataCells class, 132
SpssFootnotes class, 150
SpssLabels class, 172
SpssLayerLabels class, 186

SetTreeLevel method
SpssOutputltem class, 82

SetUIAlerts method
SpssClient class, 21

SetUpdateScreen method
SpssPivotTable class, 113

SetUserDomain method
SpssServerConf class, 195

SetUserld method
SpssServerConf class, 196

SetUseSSL method
SpssServerConf class, 196

SetVAlign method
SpssPivotTable class, 113

SetVAlignAt method
SpssDataCells class, 132
SpssFootnotes class, 150
SpssLabels class, 172
SpssLayerLabels class, 186

SetValueAt method
SpssDataCells class, 133
SpssFootnotes class, 151
SpssLabels class, 172

SetVarNamesDisplay method
SpssPivotTable class, 114

SetVarValuesDisplay method
SpssPivotTable class, 114

SetVisible method
SpssDataUT class, 33
SpssOutputltem class, 82
SpssOutputUI class, 61
SpssSyntax Ul class, 71
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SetWidoworphanLines method
SpssPivotTable class, 114
SetWidth method
SpssDataUI class, 33
SpssOutputltem class, 82
SpssOutputUI class, 61
SpssSyntaxUI class, 71
SetWindowState method
SpssDataUI class, 33
SpssOutputUI class, 61
SpssSyntaxUI class, 72
SetXML method
SpssChartltem class, 83
SpssModelltem class, 85
ShowAll method
SpssPivotTable class, 115
ShowAllFootnote method
SpssPivotTable class, 115

ShowAllLabelsAndDatalnDimensionAt method

SpssLabels class, 173
ShowAllLabelsInDimensionAt method
SpssLabels class, 173
ShowCaption method
SpssPivotTable class, 115
ShowFootnote method
SpssPivotTable class, 115
ShowFootnotesAt method
SpssDataCells class, 133
SpssLabels class, 173
SpssLayerLabels class, 187
ShowHiddenDimensionLabel At method
SpssLabels class, 173
ShowTitle method
SpssPivotTable class, 115
Size method
DataDocsList class, 29
MenuTableList class, 92
OutputDocsList class, 56
OutputltemList class, 57
SpssServerConfList class, 198
SyntaxDocsList class, 67
SpssChartltem class, 83
SetXML method, 83
SPSSSubtype method, 83
SpssClient class, 9
CreateNewServer method, 9
Exit method, 10
GetActiveDataDoc method, 10
GetConfiguredServers method, 10
GetCurrentDirectory method, 10
GetCurrentServer method, 10
GetDataDocuments method, 11
GetDefaultJCVersion method, 11
GetDefaultServer method, 11
GetDesignatedOutputDoc method, 11
GetDesignatedSyntaxDoc method, 12
GetExportOption method, 12

GetLocale method, 12
GetLocalServer method, 12
GetOutputDocuments method, 12
GetPreference method, 13
GetScriptContext method, 13
GetSPSSOptions method, 13
GetSPSSPath method, 14
GetSPSSVersion method, 14
GetSyntaxDocuments method, 14
GetUIAlerts method, 14
_heartBeat method, 22
IsDataDocInUse method, 15
IsDistributedMode method, 15
IsOptionAvailable method, 15
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